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Preface

1. About Mandrakelinux

Mandrakelinux is a GNU/Linux distribution supported by Mandrakesoft S.A. which was born on the Internet in
1998. Its main goal was and still is to provide an easy-to-use and friendly GNU/Linux system. Mandrakesoft’s
two pillars are open source and collaborative work.

1.1. Contacting the Mandrakelinux Community

The following are various Internet links pointing you to various Mandrakelinux-related sources. If you wish
to know more about the Mandrakesoft company, connect to our web site (http://www.mandrakesoft.com/).
You can also check out the Mandrakelinux distribution web site (http://www.mandrakelinux.com/) and all its
derivatives.

Mandrakeexpert (http://www.mandrakeexpert.com/) is Mandrakesoft’s help platform. It offers a new expe-
rience based on trust and the pleasure of rewarding others for their contributions.

We also invite you to subscribe to the various mailing lists (http://www.mandrakelinux.com/en/flists.
php3), where the Mandrakelinux community demonstrates its vivacity and keenness.

Please also remember to connect to Mandrakesecure (http://www.mandrakesecure.net/). It gathers all
security-related material about Mandrakelinux distributions. You will find security and bug advisories, as well
as security and privacy-related articles. A must for any server administrator or user concerned about security.

1.2. Join the Club

Mandrakesoft offer a wide range of advantages though its Mandrakelinux Users Club (http://www.
mandrakelinux.com/en/club/):

• download commercial software normally only available in retail packs, such as special hardware drivers,
commercial applications, freeware, and demo versions;

• vote and propose new software through a volunteer-run RPM voting system;

• access more than 50,000 RPM packages for all Mandrakelinux distributions;

• obtain discounts for products and services on Mandrakestore (http://www.mandrakestore.com);

• access a better mirror list, exclusive to Club members;

• read multilingual forums and articles.

By financing Mandrakesoft through the Mandrakeclub you will directly enhance the Mandrakelinux distribution
and help us provide the best possible GNU/Linux desktop to our users.

1.3. Purchasing Mandrakesoft Products

Mandrakelinux users may purchase products on-line through the Mandrakestore (http://www.mandrakestore.
com/). You will not only find Mandrakelinux software, operating systems and “live” boot CDs (such as Man-
drakemove), but also special subscription offers, support, third-party software and licenses, documentation,
GNU/Linux-related books, as well as other Mandrakesoft goodies.

1.4. Contribute to Mandrakelinux

The skills of the many talented folks who use Mandrakelinux can be very useful in the making of the Mandrake-
linux system:

• Packaging. A GNU/Linux system is mainly made of programs picked up on the Internet. They have to be
packaged in order to work together.
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• Programming. There are many, many projects directly supported by Mandrakesoft: find the one which most
appeals to you and offer your help to the main developer(s).

• Internationalization. You can help us in the translation of web pages, programs and their respective docu-
mentation.

• Documentation. Last but not least, the manual you are currently reading requires a lot of work to stay
up-to-date in regards to the rapid evolution of the system.

Consult the development projects (http://www.mandrakesoft.com/labs/) page to learn more about how you
can contribute to the evolution of Mandrakelinux.

2. About this User Guide

This book is divided into 5 parts. We start off with Installing Mandrakelinux, where you will learn what you
need to know before you actually install Mandrakelinux onto your system (see “Installation Warning”, page 5,
and “Before Installation”, page 7); and how to correctly install and configure your Mandrakelinux distribution
(“Installation with DrakX”, page 11) by describing the preparation, installation and post-installation procedu-
res.

The next part (Discover) is an introduction to Linux basics. We discuss the Linux paradigm by comparing it to
other OSes in “Migrating to Linux from Windows®/Mac OS X®”, page 33. In order to help new users, we wrote
“Linux for Beginners”, page 37. In it we describe the first steps a new user must master and we explain concepts
such as “logging in and out”, security tips, and more.

The following chapter (“Where to Get Documentation”, page 47) will guide you through a fairly exhaustive list
of documentation sources which you can consult in order to attain a better Linux knowledge. A Mandrakelinux-
specific section points to numerous in-house resources which you can find on the Net. We close this part by
speaking about the popular KDE graphical environment (see “Using KDE”, page 51).

In the next part (Using the Internet) we show you how to use two popular applications: the Mozilla browser
(“Surfing with Mozilla”, page 57) and the KMail mail client (“Writing E-mails with KMail”, page 63).

The next part of this manual (Use) deals with everyday applications such as the Kontact groupware client
(“The Kontact Client”, page 71). Amongst other components, it includes a mail client, a calendar, a news utility,
and it is possible to synchronize it with a groupware server such as Kolab. We also discuss the OpenOffice.org
suite (see Word Processor, page 81, and Spreadsheet, page 82), file managers (Managing your Files, page 86) and
printers (Printing and Faxing from Applications, page 89). We then tackle the world of multimedia by reviewing
audio and movie applications (see Audio Applications, page 95, and Movie Applications, page 101), as well as CD
burning (CD Burning, page 103).

Finally we go through more technical aspects of the Mandrakelinux system (Advanced Uses):

• the Mandrakelinux Control Center (What is in DrakConf , page 113), which is your main graphical configuration
tool;

• package management with the Mandrakelinux Software Manager (“Rpmdrake: Package Management”, page
173) which allows you to install or remove software packages;

• as well as an often needed troubleshooting(“Troubleshooting”, page 181) chapter where you will find tips and
tricks if something goes wrong: needless to say, this chapter cannot be exhaustive.

3. Note from the Editor

In the open-source philosophy, contributors are always welcome! You could provide help to this documenta-
tion project in many different ways. If you have a lot of time, you can write a whole chapter. If you speak a
foreign language, you can help us translate our manuals. If you have ideas on how to improve the content, let
us know. You can event alert us if you find typos!

For any information about the Mandrakelinux documentation project, please contact the documentation ad-
ministrator (mailto:documentation@mandrakesoft.com) or visit the Mandrakelinux Documentation Project
(http://linux-mandrake.com/en/doc/project/) web page.
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4. Conventions Used in this Book

4.1. Typing Conventions

In order to clearly differentiate special words from the text flow, we use different renderings. The following
table shows examples of each special word or group of words with its actual rendering, as well as its signifi-
cation.

Formatted Example Meaning

inode Used to emphasize a technical term.

ls -lta Used for commands and their arguments. Also used for options and file names (see
Commands Synopsis, page 3).

ls(1) Reference to a man page. To read the page in a shell (or command line), simply type
man 1 ls.

$ ls *.pid Formatting used for text snapshots of what you may see on your screen including
computer interactions, program listings, etc.

localhost Literal data which does not generally fit in any of the previously defined categories.
For example, a key word taken from a configuration file.

Apache Defines application names. The example used (“Apache”) is not a command name.
However, in some contexts, the application and command name may be the same but
formatted differently.

Files Indicates menu entries or graphical interface labels. The underlined letter informs you
of a keyboard shortcut, if applicable.

SCSI-Bus Denotes a computer part or a computer itself.

Le petit chaperon
rouge

Identifies foreign language words.

Warning! Reserved for special warnings in order to emphasize the importance of words. Read
out loud :-)

Highlights a note. Generally, it gives additional information about
a specific context.

Represents a tip. It can be general advice on how to perform a
particular action, or about nice feature which could make your life
easier.

Be very careful when you see this icon. It always means that very
important information about a specific subject will be dealt with.

4.2. General Conventions

4.2.1. Commands Synopsis

The example below shows the symbols you will see when the writer describes the arguments of a command:

command <non literal argument> [--option={arg1,arg2,arg3}]

[optional arg. ...]

These conventions are standard and you may find them elsewhere such as in the man pages.
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The “<” (less than) and “>” (greater than) symbols denote a mandatory argument not to be copied verbatim,
which should be replaced according to your needs. For example, <filename> refers to the actual name of a
file. If this name is foo.txt, you should type foo.txt, not <foo.txt> or <filename>.

The square brackets (“[ ]”) denote optional arguments, which you may or may not include in the command.

The ellipsis (“...”) means an arbitrary number of items can be included.

The curly brackets (“{ }”) contain the arguments authorized at this specific place. One of them is to be placed
here.

4.2.2. Special Notations

From time to time, you will be asked to press, for example, the keys Ctrl-R, which means you need to press
and hold the Ctrl key and tap the R character as well. The same applies for the Alt and Shift keys.

Also, regarding menus, going to menu item File→Reload user config (Ctrl-R) means: click on the File text dis-
played on the menu (generally located in the upper-left of the window). Then in the pull-down menu, click
on the Reload user config item. Furthermore you are informed that you can use the Ctrl-R key combination (as
described above) to get the same result.

4.2.3. System-Generic Users

Whenever possible, we use two generic users in our examples:

Queen Pingusa This user is created at installation time.

Peter Pingus This user is created afterwards by the system administrator.

4



Chapter 1. Installation Warning

This installation guide only covers the most common steps of the installation process. If you plan on using
Windows as well as GNU/Linux in dual-boot (meaning being able to access either OS on the same computer),
please note that it is easier to install Windows before GNU/Linux. If Windows is already set up on your system,
and you’ve never installed GNU/Linux before, DrakX –– Mandrakelinux’s installation program –– will have to
resize your Windows partition. This operation can be harmful to your data. Therefore, you must perform the
following steps before proceeding:

• you must run scandisk on your Windows computer. The resizing program can detect some obvious errors,
but scandisk is better suited for this task;

Before using scandisk (or defrag) make sure your screen saver and
any other program that might write to the hard disk is turned off.
To obtain even better results, run scandisk in Windows’s “Safe
Mode”.

• For maximum data security, you should also run defrag on your partition. This further reduces the risk of
data loss. This isn’t mandatory, but it’s highly recommended. Doing so will make the resizing process much
faster and easier.

• The ultimate insurance against problems is to always back up your data! Of course, you should back up
your data on another computer, upload your back-ups on the web, on a friend’s computer, etc. Do not back
it up onto the computer on which you want to install GNU/Linux.

If neither scandisk nor defrag are installed within Windows, please refer to the Windows documentation for
instructions on installing them.

NTFS Partitions. Windows 2000, NT or XP users should be ca-
reful: even though it’s possible to resize NTFS partitions with
GNU/Linux, it’s highly recommended that you back up your da-
ta before starting the installation. Use partition resizing at your
own risk.
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Chapter 2. Before Installation

This chapter covers issues which should be addressed before you start your new Mandrakelinux installation.
Make sure you read it completely since it will save you a lot of time. Also back up your data (on a different
disk to the one you will install the system into) and plug in and turn on all your external devices (keyboard,
mouse, printer, scanner, etc.).

2.1. Configuring your BIOS

The BIOS (Basic Input/Output System) is used to find the device on which the operating system is located and
starts it up. It’s also used for the initial hardware configuration and hardware low-level access.

The appearance of plug’n’play devices and their widespread use means that all modern BIOSes can initialize
these devices. In order for Linux to recognize plug’n’play devices, your BIOS must be configured to initialize
them.

Changing your BIOS’ settings is usually performed by holding down the Del key (some BIOSes use the F2, F10
or Esc keys instead) right after the computer is switched on. Unfortunately, there are many types of BIOSes.
Therefore you will have to look for the appropriate option yourself. It’s often called PNP OS installed (or
Plug’n’Play OS installed). Set this option to No and the BIOS will then initialize any plug’n’play devices, which
helps Linux recognize them.

All recent systems can boot from a CD-ROM. Look for Boot sequence in the BIOS’ features setup, and set the
CD-ROM as the first boot device. If your system can’t boot from a CD-ROM you will have to use a floppy.

If you want to use a parallel printer connected locally to your machi-
ne, make sure the parallel port mode is set to ECP+EPP (or at least
to one of ECP or EPP) and not to SPP, unless you have a really
old printer. If the parallel port is not set this way you might still be
able to print, but your printer will not be detected automatically
and you will have to configure it by hand. Also make sure the printer
is properly connected to your machine and powered on beforehand.

2.2. Creating a Floppy Boot Disk

If your system cannot boot from the CD-ROM you will need to create a floppy boot disk. The CD-ROM
contains all of the image files and utility programs needed to do so.

The floppy boot disk images are in the CD-ROM’s images/ directory.

The following is a list of different images and their respective installation methods:

cdrom.img

To install from a local IDE or SCSI CD-ROM drive.

network.img and network_drivers.img

To install from an NFS, FTP, HTTP repository on your local LAN or via a PPPoE (DSL line) network
connection. The network configuration of the machine on which you wish to install may be manual or
automatic. Please make sure you make both floppies.

pcmcia.img

Use this image if the installation medium is reached through a PCMCIA card (network, CD-ROM, etc.).

Some PCMCIA devices now use common network drivers. If the
PCMCIA device does not work, try again with network.img and
network_drivers.img.

7



Chapter 2. Before Installation

hd_grub.img

Use this image if you want to perform the installation from a hard disk. You need to copy the contents of
the CD onto the hard drive (either on a FAT, ext2FS, ext3FS or ReiserFS partition).

The images/alternatives/* directory provides more or less the same boot images, but with a different (older)
kernel. Actually it provides a 2.4 kernel (Mandrakelinux 10.0 onwards uses kernel 2.6) which might help you to
get started on older systems.

2.2.1. Creating a Boot Disk With Windows

In order to do so, you need to use the rawwrite program. You will find it in the CD-ROM’s dosutils/ direc-
tory.

You may have noticed that there is a DOS version of the same program called rawrite. In fact, it is the original
version of the program. rawwrite is a graphical front-end to it.

Start the program, as shown in figure 2-1.

Figure 2-1. The Rawwrite Program

Select the boot image to be copied and the target device. In almost every case, the target device is the A: drive
(that is, the first floppy disk drive).

Then if you have not already done so, insert an empty disk into your chosen floppy drive and click on the Write
button. When completed click on the Exit button: now you have a floppy boot disk to install your Mandrakelinux
distribution.

2.2.2. Creating a Floppy Boot Disk From GNU/Linux

If you already have GNU/Linux installed (another version, or on another machine, etc.), then carry out the
following steps:

1. Mount the CD-ROM. Let us suppose that the mount point is /mnt/cdrom.

2. Log in as root (to do so, open a terminal window, run the su command and enter root’s password).

3. Insert an empty diskette into the floppy drive and type:
$ dd if=/mnt/cdrom/images/cdrom.img of=/dev/fd0 bs=512

When this operation is completed, your floppy boot disk will be ready for use.
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Replace /dev/fd0 with /dev/fd1 if you are using the second floppy
drive and, of course, the name of the image with the one you want.

2.3. Supported Hardware

Mandrakelinux can handle a large number of hardware devices, and the list is far too long to be quoted in
its entirety. Nevertheless some of the steps we will describe will help you to find out if your hardware is
compatible. It will also guide you in configuring some problematic devices.

You may also consult an up-to-date list of supported hardware on the Mandrakelinux Hardware Database
(http://www.mandrakelinux.com/en/hardware.php3) web site.

USB devices: support for USB 1.0 and USB 2.0 is now extensive. Most peripherals are fully supported. You
can obtain the list of supported hardware on the Linux-USB device overview (http://www.qbik.ch/usb/
devices/) site.

Legal disclaimer: the Mandrakelinux Hardware Database contains
information about hardware devices that have been tested and/or
have been reported to function properly with Mandrakelinux. Due
to the wide variety of system configurations, Mandrakesoft cannot
guarantee that a specific device will work properly on your system.

2.3.1. What Is Not Supported

Some types of hardware cannot be handled by GNU/Linux at present, either because the support is still at an
experimental stage; nobody has written a driver for the device in question; or because it has been decided, for
valid reasons, that they cannot be supported. For example:

• winmodems, also called controller-less modems or software modems. Support for these peripherals is cu-
rrently very sparse. Drivers do exist, but are in binary form and available only for a limited range of kernel
versions.

If you have a PCI modem, look at the output of cat /proc/pci run as the root user. This will tell you the
I/O port and the IRQ of the device. Then use the setserial command (for our example, the I/O address is
0xb400, the IRQ is 10 and the modem will be the 4th serial device) as follows:
setserial /dev/ttyS3 port 0xb400 irq 10 UART 16550A

Then try to query your modem using minicom or kppp. If it does not work, you may have a software modem.
If it does work, create the /etc/rc.d/rc.setserial file and place the appropriate setserial command line
in it.

A recent project is trying to make software modems work under GNU/Linux. If you happen to have this type
of hardware in your machine, you might take a look at the linmodems (http://linmodems.org/) and the
Winmodems are not modems; Linux information page (http://start.at/modem) web sites.

9

http://www.mandrakelinux.com/en/hardware.php3
http://www.qbik.ch/usb/devices/
http://www.qbik.ch/usb/devices/
http://linmodems.org/
http://start.at/modem


Chapter 2. Before Installation

10



Chapter 3. Installation with DrakX

3.1. The Mandrakelinux Installer

With DrakX –– Mandrakelinux’s installation program –– it doesn’t matter whether you’re a newbie or a Mandra-
kelinux guru. DrakX’s job is to provide you with a smooth installation and an easy transition into Mandrakeli-
nux’s latest version.

DrakX will work best if all of your hardware is connected to the
computer and powered on during the installation. Printers, modems,
scanners and joysticks are just a few examples of peripherals which
DrakX can automatically detect and configure as Mandrakelinux is
being installed.

Figure 3-1. Very First Installation Welcome Screen

The first screen you see will present you with some information and installation options (figure 3-1). Allowing
the installation to continue will simply begin the installation in normal or “linux” mode. Next we’ll go over
some options and parameters which you can pass to the installation program if you run into problems.

Pressing F1 will open a help screen (figure 3-2). Here are some useful options to choose from:
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Figure 3-2. Available Installation Options

• vgalo: if you have tried a default installation and didn’t see the graphical interface (figure 3-3) you can
try to run the installation in low resolution mode. This happens with certain types of video cards. With
Mandrakelinux we give you a number of options to work around problems related to older hardware. To try
the installation in low resolution mode, type vgalo at the prompt.

• text: if your video card is very old and the graphical installation doesn’t work at all, you can always choose
to install in text mode. Since all video cards can display text, this is the “last resort” kind of installation.
However don’t worry: it’s unlikely that you’ll need this option.

• noauto: in some rare cases, your PC may appear to freeze or lock up during the hardware detection phase. If
that happens, adding the word noauto as a parameter will tell the installation program to bypass hardware
detection. With that option DrakX won’t scan for hardware. Hence you’ll need to manually specify hardware
parameters later in the installation process. The noauto parameter can be added to the previous modes,
hence depending on your hardware you may have to specify:
boot: vgalo noauto

to perform a low resolution graphical installation without DrakX performing a hardware scan.

• kernel options: most machines don’t require specific kernel options. Due to bugs in the design or in the
BIOS, there have been a few cases of motherboards incorrectly reporting the amount of memory installed.
If you need to manually specify the amount of DRAM installed in your PC, use the mem= xxxM parameter.
For example, to start the installation in normal mode with a computer containing 256 MB of memory, your
command line would look like this:
boot: linux mem=256M

Now let’s move on to the actual installation process. When the installer starts, you’ll see a nice graphical
interface (figure 3-3). On the left will be the various installation steps. You’ll notice that the installation will
occur in two phases: installation, then configuration. The list on the left displays all the steps. The current step
is marked by a highlighted bullet.

Each step may present various screens. Surfing between those screens is made possible through the Next and
Previous buttons. Additionally an Advanced button may be available to show more advanced configuration
options. Note that most of the latter should only be handled by expert users. But there’s no harm in looking at
them!

For each step, the Help button will show explanations concerning
the current step.

12



Chapter 3. Installation with DrakX

3.2. Choosing your Language

The first step is to choose your preferred language.

Figure 3-3. Choosing the Default Language

Your choice of preferred language will affect the installer, the documentation, and the system in general. First
select the region you’re located in, then the language you speak.

Clicking on the Advanced button will allow you to select other languages to be installed on your workstation,
thereby installing the language-specific files for system documentation and applications. For example, if Spa-
nish users are to use your machine, select English as the default language in the tree view and Español in the
Advanced section.

About UTF-8 (unicode) support: Unicode is a new character en-
coding meant to cover all existing languages. However full support
for it in GNU/Linux is still under development. For that reason,
Mandrakelinux’s use of UTF-8 will depend on the user’s choices:

1. If you choose a language with a strong legacy encoding
(latin1 languages, Russian, Japanese, Chinese, Korean,
Thäı, Greek, Turkish, most iso-8859-2 languages), the
legacy encoding will be used by default;

2. Other languages will use unicode by default;

3. If two or more languages are required, and those langua-
ges are not using the same encoding, then unicode will
be used for the whole system;

4. Finally, unicode can also be forced for use throughout the
system at a user’s request by selecting the Use Unicode
by default option independently of which languages were
been chosen.

Note that you’re not limited to choosing a single additional language. You may choose several, or even install
them all by selecting the All languages box. Selecting support for a language means translations, fonts, spell
checkers, etc. will also be installed for that language.
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To switch between the various languages installed on your system,
you can launch the localedrake command as root to change
the language used by the entire system. Running the command
as a regular user will only change the language settings for that
particular user.

3.3. License Terms of the Distribution

Before continuing, you should carefully read the terms of the license. It covers the entire Mandrakelinux distri-
bution. If you agree with all the terms it contains, check the Accept box. If not, clicking on the Quit button will
reboot your computer.

3.4. Configuring your Mouse

This step is generally ignored for Recommended mode.
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Usually, DrakX has no problems detecting the number of buttons on your mouse. If it does, it assumes you
have a two-button mouse and will configure it for third-button emulation. The third-button mouse button of
a two-button mouse can be obtained by simultaneously clicking the left and right mouse buttons. DrakX will
automatically know whether your mouse uses a PS/2, serial or USB interface.

If you have a 3-button mouse without a wheel, you can choose
a with Wheel emulation mouse. DrakX will then configure your
mouse so that you can simulate the wheel with it: to do so, press
the middle button and move your mouse pointer up and down.

If for some reason you wish to specify a different type of mouse, select it from the list provided.

You can select the Universal | Any PS/2 & USB mice entry to chose
a“generic”mouse type which will work with nearly all mice.

If you choose a mouse other than the default one, a test screen will be displayed. Use the buttons and wheel to
verify that the settings are correct and that the mouse is working correctly. If the mouse is not working well,
press the space bar or Return key to cancel the test and you will be returned to the mouse list.

Occasionally wheel mice are not detected automatically, so you will
need to select your mouse from a list. Be sure to select the one
corresponding to the port that your mouse is attached to. After
selecting a mouse and pressing the Next button, a mouse image
will be displayed on-screen. Scroll the mouse wheel to ensure that
it is activating correctly. As you scroll your mouse wheel, you will
see the on-screen scroll wheel moving. Test the buttons and check
that the mouse pointer moves on-screen as you move your mouse
about.

3.5. Installation Class

This step is activated only if an existing GNU/Linux partition has been found on your machine.
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DrakX now needs to know if you want to perform a new installation or an upgrade of an existing Mandrakelinux
system:

• Install. For the most part, this completely wipes out the old system. However, depending on your partitio-
ning scheme, you can prevent some of your existing data (notably home directories) from being over-written.
If you wish to change how your hard drives are partitioned, or to change the file system, you should use
this option.

• Upgrade. This installation class allows you to update the packages currently installed on your Mandrakelinux
system. Your current partitioning scheme and user data won’t be altered. Most of the other configuration
steps remain available and are similar to a standard installation.

Using the“Upgrade”option should work fine on Mandrakelinux sys-
tems running version 8.1 or later. Performing an upgrade on ver-
sions prior to Mandrakelinux version 8.1 is not recommended.

3.6. Configuring the Keyboard

This step is generally ignored for Recommended mode.
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Depending on the language you chose (Choosing your Language, page 12), DrakX will automatically select a
particular type of keyboard configuration. Check that the selection suits you or choose another keyboard
layout.

Also, you may not have a keyboard which corresponds exactly to your language: for example, if you are an
English-speaking Swiss native, you may have a Swiss keyboard. Or if you speak English and are located in
Québec, you may find yourself in the same situation where your native language and country-set keyboard
don’t match. In either case, this installation step will allow you to select an appropriate keyboard from a list.

Click on the More button to be shown a list of supported keyboards.

If you choose a keyboard layout based on a non-Latin alphabet, the next dialog will allow you to choose the
key binding which will switch the keyboard between the Latin and non-Latin layouts.

3.7. Security Level

At this point, DrakX will allow you to choose the security level you desire for your machine. As a rule of
thumb, the security level should be set higher if the machine is to contain crucial data, or if it’s to be directly
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exposed to the Internet. The trade-off that a higher security level is generally obtained at the expense of ease
of use.

If you don’t know what to choose, keep the default option. You’ll be able to change it later with the draksec
tool, which is part of Mandrakelinux Control Center.

Fill the Security Administrator field with the e-mail address of the person responsible for security. Security
messages will be sent to that address.

3.8. Selecting the Mount Points

You now need to decide where you want to install the Mandrakelinux operating system on your hard drive. If
your hard drive is empty or if an existing operating system is using all the available space you will have to
partition the drive. Basically, partitioning a hard drive means to logically divide it to create the space needed
to install your new Mandrakelinux system.

Because the process of partitioning a hard drive is usually irreversible and can lead to data losses, partitioning
can be intimidating and stressful for the inexperienced user. Fortunately, DrakX includes a wizard which sim-
plifies this process. Before continuing with this step, read through the rest of this section and above all, take
your time.

Depending on the configuration of your hard drive, several options are available:

• Use free space. This option will perform an automatic partitioning of your blank drive(s). If you use this
option there will be no further prompts.

• Use existing partition. The wizard has detected one or more existing Linux partitions on your hard drive. If
you want to use them, choose this option. You will then be asked to choose the mount points associated with
each of the partitions. The legacy mount points are selected by default, and for the most part it’s a good idea
to keep them.

• Use the free space on the Windows partition. If Microsoft Windows is installed on your hard drive and takes
all the space available on it, you will have to create free space for GNU/Linux. To do so, you can delete your
Microsoft Windows partition and data (see “Erase entire disk” solution) or resize your Microsoft Windows FAT
or NTFS partition. Resizing can be performed without the loss of any data, provided you’ve previously
defragmented the Windows partition. Backing up your data is strongly recommended. Using this option
is recommended if you want to use both Mandrakelinux and Microsoft Windows on the same computer.

Before choosing this option, please understand that after this procedure, the size of your Microsoft Windows
partition will be smaller than when you started. You’ll have less free space under Microsoft Windows to store
your data or to install new software.
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• Erase entire disk. If you want to delete all data and all partitions present on your hard drive and replace them
with your new Mandrakelinux system, choose this option. Be careful, because you won’t be able to undo this
operation after you confirm.

If you choose this option, all data on your disk will be deleted.

• Remove Windows. This option appears when the hard drive is entirely taken by Microsoft Windows. Choosing
this option will simply erase everything on the drive and begin fresh, partitioning everything from scratch.

If you choose this option, all data on your disk will be lost.

• Custom disk partitioning. Choose this option if you want to manually partition your hard drive. Be careful ––
it is a powerful but dangerous choice and you can very easily lose all your data. That’s why this option is
really only recommended if you have done something like this before and have some experience. For more
instructions on how to use the DiskDrake utility, refer to the Managing Your Partitions section in the Starter
Guide.

3.9. Choose Partitions to Be Formatted

This step is generally ignored for Recommended mode.

If you chose to reuse some legacy GNU/Linux partitions, you may wish to reformat some of them and erase
any data they contain. To do so, please select those partitions as well.

Please note that it’s not necessary to reformat all pre-existing partitions. You must reformat the partitions
containing the operating system (such as /, /usr or /var) but you don’t have to reformat partitions containing
data that you wish to keep (typically /home).
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Please be careful when selecting partitions. After the formatting is completed, all data on the selected partitions
will be deleted and you won’t be able to recover it.

Click on Next when you’re ready to format the partitions.

Click on Previous if you want to choose another partition for your new Mandrakelinux operating system insta-
llation.

Click on Advanced if you wish to select partitions which will be checked for bad blocks on the disk.

3.10. Choose Packages to Install

3.10.1. Choose Package Groups to Install

It’s now time to specify which programs you wish to install on your system. There are thousands of packages
available for Mandrakelinux, and to make it simpler to manage, they have been placed into groups of similar
applications.

Mandrakelinux sorts package groups in four categories. You can mix and match applications from the various
categories, so a “Workstation” installation can still have applications from the “Server” category installed.

1. Workstation: if you plan to use your machine as a workstation, select one or more of the groups in the
workstation category.

2. Development: if you plan on using your machine for programming, select the appropriate groups from
that category. The special LSB group will configure your system so that it complies as much as possible
with the Linux Standard Base (http://www.linuxbase.org/) specifications.

Selecting the LSB group will also install the 2.4 kernel series, instead
of the default 2.6 one. This is to ensure 100%-LSB compliance of
the system. However, if you do not select the LSB group you will
still have a system which is nearly 100% LSB-compliant.

3. Server: if your machine is intended to be a server, select which of the more common services you wish to
install on your machine.

4. Graphical Environment: this is where you will choose your preferred graphical environment. At least one
must be selected if you want to have a graphical interface available.
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Moving the mouse cursor over a group name will display a short
explanatory text about that group.

You can check the Individual package selection box, which is useful if you’re familiar with the packages being
offered or if you want to have total control over what will be installed.

If you start the installation in Upgrade mode, you can deselect all groups and prevent the installation of any
new packages. This is useful for repairing or updating an existing system.

3.10.1.1. Minimal Installation

If you deselect all groups when performing a regular installation (as opposed to an upgrade), a dialog will
pop up suggesting different options for a minimal installation:

• With X: install the minimum number of packages possible to have a working graphical desktop.

• With basic documentation: installs the base system plus basic utilities and their documentation. This installa-
tion is suitable for setting up a server.

• Truly minimal install: will install the absolute minimum number of packages necessary to get a working Linux
system. With this installation you will only have a command-line interface. The total size of this installation
is about 65 megabytes.

3.10.2. Choose Individual Packages to Install

If you choose to install packages individually, the installer will present a tree containing all packages classified
by groups and subgroups. While browsing the tree, you can select entire groups, subgroups, or individual
packages.

Whenever you select a package on the tree, a description will appear on the right to let you know the purpose
of that package.
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If a server package has been selected, either because you specifically
chose the individual package or because it was part of a group of
packages, you’ll be asked to confirm that you really want those
servers to be installed. By default Mandrakelinux will automatically
start any installed services at boot time. Even if they are safe and
have no known issues at the time the distribution was shipped, it
is entirely possible that security holes were discovered after this
version of Mandrakelinux was finalized. If you don’t know what a
particular service is supposed to do or why it’s being installed, then
click No. Clicking Yes will install the listed services and they will be
started automatically at boot time.

The Automatic dependencies option is used to disable the warning
dialog which appears whenever the installer automatically selects a
package to resolve a dependency issue. Some packages depend on
others and the installation of one particular package may require
the installation of another package. The installer can determine
which packages are required to satisfy a dependency to successfully
complete the installation.

The tiny floppy disk icon at the bottom of the list allows you to
load a package list created during a previous installation. This is
useful if you have a number of machines that you wish to configure
identically. Clicking on this icon will ask you to insert the floppy
disk created at the end of another installation. See the second tip
of the last step on how to create such a floppy.

3.11. Multiple CD-ROM Installation

The Mandrakelinux installation is distributed on several CD-ROMs. If a selected package is located on another
CD-ROM, DrakX will eject the current CD and ask you to insert the required one. If you do not have the
requested CD at hand, just click on Cancel, the corresponding packages will not be installed.
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3.12. Root Password

This is the most crucial decision point for the security of your GNU/Linux system: you must enter the root
password. Root is the system administrator and is the only user authorized to make updates, add users,
change the overall system configuration, and so on. In short, root can do everything! That’s why you must
choose a password which is difficult to guess: DrakX will tell you if the password you chose is too simple.
As you can see, you’re not forced to enter a password, but we strongly advise against this. GNU/Linux is
just as prone to operator error as any other operating system. Since root can overcome all limitations and
unintentionally erase all data on partitions by carelessly accessing the partitions themselves, it is important
that it be difficult to become root.

The password should be a mixture of alphanumeric characters and at least 8 characters long. Never write
down the root password –– it makes it far too easy to compromise your system.

One caveat: don’t make the password too long or too complicated because you must be able to remember it!

The password won’t be displayed on screen as you type it. To reduce the chance of a blind typing error you’ll
need to enter the password twice. If you do happen to make the same typing error twice, you’ll have to use
this “incorrect” password the first time you’ll try to connect as root.

If you want an authentication server to control access to your computer, click on the Advanced button.

If your network uses either LDAP, NIS, or PDC Windows Domain authentication services, select the appro-
priate one for authentication. If you don’t know which one to use, you should ask your network administrator.

If you happen to have problems with remembering passwords, or
if your computer will never be connected to the Internet and you
absolutely trust everybody who uses your computer, you can choose
to have No password.
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3.13. Adding a User

GNU/Linux is a multi-user system which means each user can have his or her own preferences, own files and
so on. But unlike root, who is the system administrator, the users you add at this point won’t be authorized to
change anything except their own files and their own configurations, protecting the system from unintentional
or malicious changes which could impact on the system as a whole. You’ll have to create at least one regular
user for yourself –– this is the account which you should use for routine, day-to-day usage. Although it’s very
easy to log in as root to do anything and everything, it may also be very dangerous! A very simple mistake
could mean that your system won’t work any more. If you make a serious mistake as a regular user, the worst
that can happen is that you’ll lose some information, but you won’t affect the entire system.

The first field asks you for a real name. Of course, this is not mandatory –– you can actually enter whatever
you like. DrakX will use the first word you type in this field and copy it to the User name one, which is the name
this user will enter to log onto the system. If you like, you may override the default and change the user name.
The next step is to enter a password. From a security point of view, a non-privileged (regular) user password
is not as crucial as the root password, but that’s no reason to neglect it by making it blank or too simple: after
all, your files could be the ones at risk.

Once you click on Accept user, you can add other users. Add a user for each one of your friends, your father,
your sister, etc. Click Next when you’re finished adding users.

Clicking the Advanced button allows you to change the default
shell for that user (bash by default).
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When you’re finished adding users, you’ll be asked to choose a user who will be automatically logged into
the system when the computer boots up. If you’re interested in that feature (and don’t care much about local
security), choose the desired user and window manager, then click on Next. If you’re not interested in this
feature, uncheck the Do you want to use this feature? box.

3.14. Installing a Boot Loader

This step is generally ignored for Recommended mode.

A boot loader is a little program which is started by the computer at boot time. It’s responsible for starting up
the whole system. Normally, the boot loader installation is totally automated. DrakX will analyze the disk boot
sector and act according to what it finds there:
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• if a Windows boot sector is found, it will replace it with a GRUB/LILO boot sector. This way you’ll be able to
load either GNU/Linux or any other OS installed on your machine.

• if a GRUB or LILO boot sector is found, it’ll replace it with a new one.

If DrakX can’t determine where to place the boot sector, it’ll ask you where it should place it. Generally, the
First sector of drive (MBR) is the safest place. Choosing Skip won’t install any boot loader. Use this option only
if you know what you’re doing.

3.15. Check Miscellaneous Parameters

3.15.1. Summary

As a review, DrakX will present a summary of information it has gathered about your system. Depending on
the hardware installed on your machine, you may have some or all of the following entries. Each entry is made
up of the hardware item to be configured, followed by a quick summary of the current configuration. Click on
the corresponding Configure button to make the change.

• Keyboard: check the current keyboard map configuration and change it if necessary.

• Country / Region: check the current country selection. If you’re not in this country, click on the Configure but-
ton and choose another. If your country isn’t in the list shown, click on the More button to get the complete
country list.

• Timezone: by default, DrakX deduces your time zone based on the country you have chosen. You can click
on the Configure button here if this is not correct.

• Mouse: verify the current mouse configuration and click on the button to change it if necessary.

• Printer: clicking on the Configure button will open the printer configuration wizard. Consult the corres-
ponding chapter of the Starter Guide for more information on how to set up a new printer. The interface
presented in our manual is similar to the one used during installation.

• Sound card: if a sound card is detected on your system, it’ll be displayed here. If you notice the sound card
isn’t the one actually present on your system, you can click on the button and choose a different driver.

• TV card: if you have a TV card, this is where information about its configuration will be displayed. If you
have a TV card and it isn’t detected, click on Configure to try to configure it manually.

• ISDN card: you can click on Configure to change the parameters associated with the card if you feel the
configuration is wrong.
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• Graphical Interface: by default, DrakX configures your graphical interface in 800x600 or 1024x768 resolution.
If that doesn’t suit you, click on Configure to reconfigure your graphical interface.

• Network: if you wish to configure your Internet or local network access, you can do so now. Refer to the
printed documentation or use the Mandrakelinux Control Center after the installation has finished to benefit
from full in-line help.

• Proxies: allows to configure HTTP and FTP proxy addresses if the machine you’re installing on is to be
located behind a proxy server.

• Security Level: this entry allows you to redefine the security level as set in a previous step (Security Level,
page 17).

• Firewall: if you plan to connect your machine to the Internet, it’s a good idea to protect yourself from
intrusions by setting up a firewall. Consult the corresponding section of the Starter Guide for details about
firewall settings.

• Bootloader: if you wish to change your bootloader configuration, click this button. This should be reserved
to advanced users. Refer to the printed documentation or the in-line help about bootloader configuration in
the Mandrakelinux Control Center.

• Services: through this entry you can fine tune which services will be run on your machine. If you plan to use
this machine as a server it’s a good idea to review this setup.

3.15.2. Time Zone Options

This dialog appears after selecting a new time zone in the time zones list. After you’ve chosen the location
nearest to your time zone, two more options are shown.

GNU/Linux manages time in GMT (Greenwich Mean Time) and translates it to local time according to the time
zone you selected. If the clock on your motherboard is set to local time, you may deactivate this by unselecting
Hardware clock set to GMT, which will let GNU/Linux know that the system clock and the hardware clock are
in the same time zone. This is useful when the machine also hosts another operating system.

The Automatic time synchronization option will automatically regulate the system clock by connecting to a
remote time server on the Internet. For this feature to work, you must have a working Internet connection. We
recommend that you choose a time server located near you. This option actually installs a time server which
can be used by other machines on your local network as well.
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3.15.3. Configuring X, the Graphical Server

X (for X Window System) is the heart of the GNU/Linux graphical interface on which all the graphical environ-
ments (KDE, GNOME, AfterStep, WindowMaker, etc.) bundled with Mandrakelinux rely upon.

You’ll see a list of different parameters to change to get an optimal graphical display.

Graphic Card

The installer will normally automatically detect and configure the graphic card installed on your machine.
If this is not correct, you can choose from this list the card you actually have installed.

In the situation where different servers are available for your card, with or without 3D acceleration, you’re
asked to choose the server which best suits your needs.

Monitor

Normally the installer will automatically detect and configure the monitor connected to your machine. If
it is not correct, you can choose from this list the monitor which is connected to your computer.

Resolution

Here you can choose the resolutions and color depths available for your graphics hardware. Choose the
one which best suits your needs (you will be able to make changes after the installation). A sample of the
chosen configuration is shown in the monitor picture.

Test

Depending on your hardware, this entry might not appear.

The system will try to open a graphical screen at the desired resolution. If you see the test message during
the test and answer Yes, then DrakX will proceed to the next step. If you do not see it, then it means that
some part of the auto-detected configuration was incorrect and the test will automatically end after 12
seconds and return you to the menu. Change settings until you get a correct graphical display.
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Options

This steps allows you to choose whether you want your machine to automatically switch to a graphical
interface at boot. Obviously, you may want to check No if your machine is to act as a server, or if you were
not successful in getting the display configured.

3.15.4. Selecting Available Services at Boot Time

This step is generally ignored for Recommended mode.

This dialog is used to select which services you wish to start at boot time.

DrakX will list all services available on the current installation. Review each one of them carefully and uncheck
those which aren’t needed at boot time.

A short explanatory text will be displayed about a service when it
is selected. However, if you’re not sure whether a service is useful
or not, it is safer to leave the default behavior.

At this stage, be very careful if you intend to use your machine as
a server: you probably don’t want to start any services which you
don’t need. Please remember that some services can be dangerous
if they’re enabled on a server. In general, select only those services
you really need.
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3.16. Installing Updates from the Internet

By the time you install Mandrakelinux, it’s likely that some packages will have been updated since the initial
release. Bugs may have been fixed, security issues resolved. To allow you to benefit from these updates, you’re
now able to download them from the Internet. Check Yes if you have a working Internet connection, or No if
you prefer to install updated packages later.

Choosing Yes will display a list of web locations from which updates can be retrieved. You should choose one
near to you. A package-selection tree will appear: review the selection, and press Install to retrieve and install
the selected package(s), or Cancel to abort.

3.17. It’s Finished!

There you are. Installation is now complete and your GNU/Linux system is ready to be used. Just click on
Reboot to reboot the system. Don’t forget to remove the installation media (CD-ROM or floppy). The first thing
you should see after your computer has finished doing its hardware tests is the boot-loader menu, giving you
the choice of which operating system to start.
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3.17.1. Advanced Options

The Advanced button shows two more buttons to:

1. Generate auto-install floppy: enables you to create an installation floppy disk which will automatically per-
form a whole installation without the help of an operator, similar to the installation you’ve just configured.

Note that two different options are available after clicking on that button:

• Replay. This is a partially automated installation. The partitioning step is the only interactive procedure.

• Automated. Fully automated installation: the hard disk is completely rewritten, all data is lost.

This feature is very handy when installing on a number of similar machines. See the Auto install (http:
//www.mandrakelinux.com/drakx/auto_inst.html) section on our web site for more information.

2. Save packages selection1: saves a list of the packages selected in this installation. To use this selection with
another installation, insert the floppy and start the installation. At the prompt, press the F1 key, type linux
defcfg="floppy" and press the Enter key.

3.18. How to Uninstall Linux

Operating systems generally do not offer the capability to uninstall themselves. If for any reason you want to
uninstall Mandrakelinux, you can do so.

The process of uninstalling Mandrakelinux is done in two steps:

Removing partitions on your hard drive will inevitably result in a
loss of any data stored on those partitions. Please make sure you’ve
backed up all of the data you want to keep before proceeding with
this step.

1. Delete all partitions related to Mandrakelinux on your hard drive (usually partitions hosting ext3 file sys-
tems and the Swap partition) and –– optionally –– replace them by a single FAT partition using DiskDra-
ke (DiskDrake: Managing your Hard Drive Partitions, page 135).

2. Remove the boot loader, LILO in this example, from the Master Boot Record (MBR). To do so, execute lilo
-U in a console, as root.

If you have another boot loader, please refer to its documentation to determine how to regenerate the
master boot record.

1. You need a FAT-formatted floppy. To create one under GNU/Linux, type mformat a:, or fdformat /dev/fd0 followed
by mkfs.vfat /dev/fd0.
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Chapter 4. Migrating to Linux from Windows®/Mac OS X®

This chapter is aimed at users migrating from Windows or MacOS X. Instead of presenting the various appli-
cations in depth, it tries to answer most common questions and/or issues former Windows or MacOS X users
might ask.

4.1. Where’s my...?

Experienced Windows and MacOS X users are normally accustomed to certain functions and/or concepts
which are often treated differently in GNU/Linux.

4.1.1. Start Menu

In Windows, most applications and system tools are accessed through the so-called Start Menu; this concept
remains more or less the same, except it’s now called the Main Menu: in KDE you open it by clicking on the
yellow star at the bottom left of your screen.

For users coming from MacOS X, Mandrakelinux’s Main Menu can be considered as a replacement for functions
from both the Apple Menu, located at the far left of the menu bar, and the Applications folder available in the
Finder.

4.1.2. Applications

The wide variety of applications is a large differentiator between GNU/Linux and Windows. Mandrakelinux ins-
talls many more applications onto your system, and clicking on the main menu will give you a wide range
of choices depending on what you would like to do. There are many full-fledged applications available to
accomplish many common tasks such as word processing, e-mail handling, web browsing, etc.

MacOS X users may find similarities between MacOS X and GNU/Linux applications, because MacOS X is
based on BSD, a UNIX-like system on which GNU/Linux is also based. Moreover, other applications designed
for the desktop have been ported to or are available under the X11 implementation available for MacOS X.

You may also install a large number of applications through the RpmDrake utility (please refer to the “Rpmdrake:
Package Management”, page 173).

4.1.3. Control Panel/System Preferences

The Control Panel in Windows and the System Preferences utility in MacOS X are replaced by the Mandrakelinux
Control Center under Mandrakelinux. It can be found in the main menu, in System+Configuration→Configure your
computer. Through this interface, you have the ability to modify most of your system’s settings with graphical
tools.

4.1.4. DOS Shell

GNU/Linux is still very fond of shell environments. Unlike Windows the popularity of the shell is not fading
away as is evident by the availability of the shell in MacOS X. By default, Mandrakelinux installs bash, a truly
powerful shell environment. You can access it by opening the main menu and choosing System+Terminals→
Konsole.

None of your DOS commands or functions will work in a Linux shell.
Take a look at the Introduction to the Command Line chapter of the
Reference Manual to discover their equivalence and much, much
more. Have fun, you now have a real shell at hand!
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4.1.5. Network Neighborhood

GNU/Linux uses TCP/IP by default, not SMB (the Windows network protocol), so there’s nothing like a network
neighborhood icon to give you a view of the network you’re in. However, you may use the LinNeighborhood
application to give you similar functionality.

Konqueror can also accomplish the same tasks. Just type smb:/ in the location bar, and all of the shared Windows
resources on the network will appear. Please remember that for this to work, the samba-client package must
be installed.

See File Sharing, page 88 for more information.

4.1.6. C: Drive

The “lettered drive” is a concept exclusive to Windows. On UNIX systems, the drive notion (C:, D:, ..., Z:) is
replaced by “mount points”. From a user perspective, you’re always accessing directories. Your system will
use configuration files to instruct the file system how to “load” all relevant disks, disk partitions and remote
systems, and then assign them to a specified directory, generally under the /mnt/ directory. While this concept
is similar to that found in MacOS X, it is slightly different. What is mounted under /mnt with GNU/Linux is
mounted under /Volumes in MacOS X but is made available as a “root file system” in the Finder.

4.1.7. CD-ROM Drives

The same concept as for C: applies here. CD-ROMs are mounted in /mnt/cdrom/. To access the CD-ROM, just
click on the desktop icon. If you have Konqueror running, the CD-ROM contents will appear in a new window.

Things are a bit different for audio CDs: upon inserting one in the
drive, the KsCD CD player is automatically loaded. Please see Audio
Applications, page 95.

4.1.8. Floppy Disk Drives

Like CD-ROMs and disk partitions, floppy disks are mounted and will appear on /mnt/floppy/. This feature
directly supports reading Windows diskettes.

Icons are displayed on your desktop to access all your removable
media drives: floppy, CD-ROM, ZIP, USB keys, etc.

4.1.9. My Documents

Under Mandrakelinux every user has a directory called Documents/ located in their home directory.

The home directory concept is equivalent to the C:\Winnt\Profiles\user_name\ or C:\Documents and Set-
tings\user_name\ directories in Windows NT, Windows 2000 and Windows XP and is explained in “Using
KDE”, page 51.

Under MacOS X this is very similar. The home directory’s equivalent is /Users/user_name and it also contains
a directory called Documents.

You may also have many files in proprietary formats such as Microsoft Excel® or Microsoft Word® documents.
OpenOffice.org is just one application which can import many popular formats for office applications (see Word
Processor, page 81 and Spreadsheet, page 82).

34



Chapter 4. Migrating to Linux from Windows®/Mac OS X®

We are specifically mentioning office documents because they are
important. Due to space constraints we cannot enumerate every sin-
gle Windows application and its GNU/Linux equivalent. However,
there is a high probability that you will find GNU/Linux equiva-
lents for all the programs you used under Windows or MacOS X.
To get an idea of GNU/Linux equivalents of Windows applications,
you can consult the table of equivalents (http://linuxshop.ru/
linuxbegin/win-lin-soft-en/table.shtml).

4.2. A Brave New World!

Now that you have found your way around GNU/Linux, here is a brief presentation of the features which make
excellent reasons to migrate to GNU/Linux.

4.2.1. A Multi-User Environment

GNU/Linux, like MacOS X, is based on UNIX. This basically implies a shift in the structure of your environment,
from a single workstation to a multi-user architecture and implies very thorough user management. Each file,
service and application is exclusively allocated to a user or a group of users, according to its nature. For
example, every user has their own personal directory, inaccessible (even invisible) to other users, containing
personal data and personal configuration files.

GNU/Linux also offers advanced server functionality, such as the ability to host mail or web page servers.

4.2.2. Multiple Tasking

GNU/Linux has always been a very strong operating system for multi-tasking (running many applications
concurrently). Although other operating systems have made great progress, GNU/Linux remains a leader in
that domain.

4.2.3. Multiple Desktops

With GNU/Linux, KDE and GNOME give you as many desktops as necessary to work with, instead of just a
single desktop. Users who like to have numerous applications running at the same time will greatly appreciate
this feature since it makes for a much cleaner working environment.

4.2.4. Full Desktop Customization

Regarding aesthetics, GNU/Linux truly rocks! Not only can you choose between KDE or GNOME and many
other window managers, but you can also highly customize their appearances with themes. Themes go be-
yond just the initial look and feel: actually, everything you see can be modified, from the background image
to the behavior of applications when they are closed, which is truly unique.

See the themes page on Freshmeat (http://themes.freshmeat.net/) for available designs.

4.2.5. Thousands of Free Applications

By far, the GNU/Linux community is the most generous one. Given a specific problem, you will most likely find
a script or an application to answer your needs, for free! Also, Mandrakelinux includes hundreds of applications
not documented in this book, so do not be shy, try them out. You’ll most probably be surprised by the extent
of the possibilities GNU/Linux offers.
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4.2.6. No More Reboots!

Windows and MacOS (although this has largely been addressed in MacOS X) users know the level of frustration
generated by crashing systems. Even though GNU/Linux is not perfect, its stability is one of its strongest points.
Sometimes, applications crash, but rarely do they take the operating system with it.

We hope this rapid tour will help you truly appreciate GNU/Linux’s strengths. Do not be afraid to explore
further!
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5.1. Introduction

This chapter was written for inexperienced users. If you know how to create an icon on the desktop, or how
to put a window on all workspaces, skip ahead to the next chapter. If not, read on! You will learn how to
access your desktop environment, launch programs and shut down the computer. After reading this chapter,
all subsequent ones will make much more sense to you.

If you are an experienced Windows or MacOS user, refer to “Migrating to Linux from Windows®/Mac OS X®”,
page 33 which will ease the transition between the two operating systems and GNU/Linux.

We assume that you are sitting in front of a running Mandrakelinux computer which, when turned on, auto-
matically displays the graphical login screen. If this is not the case and you will be facing a black screen with
something like:

Mandrakelinux release 10.0 (CodeName) for i586

Kernel 2.6.3-4mdk on an i686 / tty1

machine_name login:

with a flashing cursor, type your user name (usually your first name or your nickname), then your secret
password. You should now be “logged in”. Now type startx and the graphical interface will be launched.

GNU/Linux offers many graphical interfaces. In this manual we will discuss the popular KDE (see “Using
KDE”, page 51).

5.2. The Boot-Loader Menu

When you reboot your computer after completing your Mandrakelinux installation, you will first see a menu
containing three or more items called the “boot-loader menu”. This allows you to boot your GNU/Linux system,
or any other operating systems you may have already installed, as well as some special options.

The number of items and their names can vary depending on your particular configuration. The one we are
interested in at the moment is obviously the one labeled linux, which will start your Mandrakelinux system. It is
the default item unless you manually configured it differently. All you need to do is to wait a few seconds ––
you will see a countdown at the bottom of the screen –– or press Enter, and Mandrakelinux will start loading.
You can select a different item by using the arrow keys on your keyboard to select the item and pressing the
Enter key.

5.3. Getting Ready for your Session

GNU/Linux is a multiuser system. This means that more than one user can access the same machine, each one
with the ability to keep his or her own data and configuration files private and protected from other users.
To be able to do this, different user accounts must be created by the administrator. The administrator is the
user named root, whose password has been set during installation, and who has no restrictions at all on the
system.

It’s also important to understand the terms “to log in” and “to log out”. To log in means: to identify yourself
to the computer. Think of it as a security officer validating who you are before letting you in. After logging in,
the system takes a number of actions in order to give you access to the system’s resources. By logging in, you
start a so-called “session”.

When you log out you are telling the system you no longer need to use its resources. Your personal session is
closed, you exit the graphical interface and the login screen appears once more.

Although these definitions are valid within the scope of this chapter,
they are oversimplified. As you read the following chapters, you will
better understand these concepts, their advantages and options.
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5.4. Beginning your Session

5.4.1. Identifying Yourself

To log into the system, you need to know and supply both your login name and your password. If you did
your own installation, you already have your login name and password. If not, you must ask the person who
installed your computer to help you out urgently!

You are currently in front of the following display (figure 5-1). Of course, it will appear slightly different as the
user names displayed next to the icons are probably different.

Figure 5-1. The Login Window

The login procedure takes place in four simple steps:

1. Click on the icon corresponding to your login name.

2. Type your secret password when that field is displayed.

You will notice that the letters do not appear while you type them
in the password field. They are replaced by little stars (*) in order
to avoid any other person from seeing your secret password. This is
a common computer behavior whenever you enter a password. Be-
cause of this, make sure you type the correct keys since you cannot
check them visually. Remember: passwords under GNU/Linux are
case sensitive, which means that if your password is Very_Secret

and you type Very_secret, access will be denied!

3. Choose your favorite graphical environment from the Session Type pull-down menu. Your most recently
used one is selected by default, but if this is the first time that you’re logging in, e.g. immediately after the
installation, no default environment has yet been defined and the Mandrakefirsttime Wizard will pop up
when you log in. Please refer to The Mandrakefirsttime Wizard, page 39 for more information.
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Figure 5-2. The Password Field and the Pull-Down Session Type List

This step is optional and allows you to choose a specific graphical
environment. While we encourage you to try the various available
choices so you can find the one you prefer, we strongly suggest you
start with KDE.

4. Finally click on the Login button to begin your session. Be patient! It may take a few seconds before your
desktop is ready to be used.

If you are the only user of your new Mandrakelinux system, and you are annoyed by having to type your login
name and password every time you start a new session, there is a way to avoid this step: booting directly in
your favorite desktop environment. This feature is known as auto-login and can be activated as follows, after
the login process has completed:

• Launch the Mandrakelinux Control Center choosing System+Configuration→Configure your computer from the
main menu. You can also click on the Welcome icon on your desktop, then click on Configuration tools.

• Click on the first section (Boot) then on the Autologin icon.

• Select the Yes, I want autologin with this (user, desktop) option. You must select the user name and the default
desktop environment to be used by choosing one from the corresponding pull-down menus in the lower
part of the window.

Be careful with this option as no password will be asked for, hence
anybody can access your system. We suggest that you use this
option only if no one but yourself can access your computer, or if
only non-sensitive data is stored in it.

5.4.2. The Mandrakefirsttime Wizard

If this is the first time you have accessed your Mandrakelinux system, you will encounter the Mandrakefirstti-
me Wizard (figure 5-3). It will help you by setting up some basic configuration options and registering your
product. We recommend that you complete all its steps.

First of all, you will be asked to choose an appearance for your working environment1. The different choices
will affect the way files, objects and windows are displayed on the screen, and the way you will interact with
them, but it is important to know that they all share the same functions. Hence you will be able to do the
same operations and use the same programs whichever graphic environment you choose: preferring one over
another is just a matter of personal taste.

1. If you are using the download edition of Mandrakelinux, you will first be asked to fill a questionnaire that will help
Mandrakesoft know better its user base.
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Figure 5-3. The Mandrakefirsttime Wizard

Click on the Choose Desktop pull-down menu to see the available choices. Some of them also offer more than
one variation. The default setting is KDE with the Galaxy 2 theme.

Then you may create a personal Mandrakeclub account, which will give you instant access to many valuable
on-line services offered by Mandrakesoft, such as special commercial software downloads (complete with au-
tomatic download and install procedures), dedicated multilingual forums, the option to vote for your favorite
software packages to be included in the Mandrakelinux distribution, special discounts, and more. Your Man-
drakelinux package includes a one-month trial Mandrakeclub account, so you can evaluate the many available
services and then later extend your account if you like their features (and we are sure you will!).

Moreover, if you already have a Mandrakeclub account or are going to activate one now, Mandrakefirsttime
Wizard will also help you configure your system to allow easy download and installation of special updates
from the Mandrakeclub web site, directly using our user-friendly Software Manager. Please remember that e-
mail addresses and user names are unique on Mandrakeclub, so you will not be able to open a trial account if
you already are a subscriber. Once you have made your choices click on the Next button.

Now that the Mandrakefirsttime Wizard introduction is completed, your new working environment will be
displayed.

5.4.3. Some Notes About Security

It is important to assimilate a few security notions with regard with your Mandrakelinux box:

• Do not write down your password on any piece of paper (a post-it for example) that can be seen by anyone.

• Always make sure your password is complex enough to keep people from guessing it, but simple enough
for you to remember it! Try to use a mix of numbers and letters with mixed case for your passwords.

It is a good idea to think of a sentence or phrase you can remember
easily. Then, take the first letters and/or numbers of every word in
the sentence to form a password. For example, the sentence: “I
was born on September 10th 1973” would make up the password:
IwboS101973, which is easy to remember (it is your birth date after
all...) and fairly hard to guess.

• If you have a permanent connection to the Internet, and you do not want to use your computer for some
time, it is better to close it down completely, as crackers could be able to use your machine. That is, do not
just log out of it, but shut it down (power off). This can be done using the Halt button in the login window.

The list above is not extensive at all. There are many things you can do in order to make your system more
secure. You should especially read DrakSec: Securing your Machine, page 151.
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5.5. Using your Graphical Environment

This section will introduce a few basic concepts and skills for using your computer.

5.5.1. The Mandrakelinux Desktop

All modern graphical environments share a common set of features: a main menu, a desktop area with some
icons, a panel, etc. In the following paragraphs we will describe the elements which compose the desktop
environment.

Figure 5-4. The KDE Desktop

1. On the left of the screen and in the bar at the bottom of the screen are icons. They are usually enhanced by
a short description beneath them (the icon’s title or name). Clicking on an icon either launches a program
or opens a folder. In both cases a window will appear on the desktop.

2. In the lower part of the screen is the panel. It provides a quick access to useful tools such as a Terminal, a
web browser, etc. Each icon symbolizes an application (or program). Just move your mouse cursor over
one of the icons and leave it there for a few seconds. A yellow help balloon will appear to describe the
icon’s function.

3. The icons and the panel do not float on the screen: they are “stuck” on something called the desktop, also
called the background. In a sense, the desktop is where everything you see or use lives. Bring your mouse
cursor to a free place on the desktop (i.e. where there is nothing) and right-click: a menu will appear which
will give you access to several functions.

5.5.2. Accessing Applications

Since there are not a lot of icons on the desktop nor in the panel, you may be wondering how to access all of
the software you installed during the installation process. To do so, access the first icon on the left-side of the
panel (also called the main menu):

Click on this icon and a pull-up menu listing the programs you can run will be displayed. They are
organized by tasks, so finding the program you are looking for is pretty easy.

To launch an application or a tool, click on the main menu icon, navigate through the menu’s tree until you
find the desired item and click on it.
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5.5.3. Opening a Window on the Desktop

If you click on the icon on the desktop labeled as Home, or [your login name]’s Home, this window will
appear:

Figure 5-5. KDE File Manager

You just launched a file manager called Konqueror. The window which pops up displays the content of your
Home directory. This is where all of your personal documents and files are stored: only you can access them.
If you start saving a lot of files in it (e.g. text documents, MP3 files, etc.) we suggest that you create some
sub-directories (for instance Music, Photos, Accounting, etc.).

A window is composed of several parts. On the top is the title bar. It shows the name or title of the program
you launched and possibly, the name of the document you are working on. It can be in two different states:

• active, which means you are currently using it, or

• inactive: the program is still running, but you are not currently interacting with it.

Usually, the active title bar is full-colored, whereas the inactive one is shaded or gray.

Just under the title bar is the menu bar. In our example, it contains menus named Edit, View, and so on. Click
on Edit. A list of items will appear in a drop-down menu, each item giving you access to one of the program’s
functions.

Below the menu bar is the application’s tool bar. It consists of one or more rows of icons, each one equivalent to
an item in one of the application’s drop-down menu: you can view them as a short-hand access to frequently-
accessed program features which can be found elsewhere in the menu bar.

The status bar usually sits at the bottom of the window. There you will find information about what the
program is doing. Not all programs offer this feature, but if the one you are using does, remember to check it
from time to time.

5.5.4. Managing Windows and Desktops

We introduced the word “desktop” to point out the area of the screen where all objects (panels, icons, win-
dows) are placed. Now, look at the panel at the bottom of the screen. You can see a group of four buttons:

Figure 5-6. KDE’s Virtual Desktop Buttons

These buttons give you access to virtual desktops, which are identical copies of the desktop you see after you
have logged in. You will find more information about the handling and usage of virtual desktops in “Using
KDE”, page 51.

42



Chapter 5. Linux for Beginners

Click on the button labeled 2: as you can see, the window you opened before disappears. Don’t worry, you
didn’t close it, you simply switched desktops.

Click on the button labeled 1. The previous desktop will be displayed.

This feature called virtual desktops (also known as workspace switcher) is very handy. It allows you to open
several windows and to organize them as you desire.

You can also change the virtual desktop a window is currently in. This may be handy to logically organize your
work by desktop, for instance moving all network related windows into desktop 2, all multimedia applications
into desktop 3, and so on.

For this exercise you will need to use your mouse. With KDE, right-click on the window’s title bar and a pull-
down menu will appear containing an item named To Desktop. Just point to this item and a list of your virtual
desktops will appear. Simply choose the virtual desktop towards which you want to move it.

You will often find your window is in the right place, but that it is too small or too big. Click on this button in
the title bar:

Figure 5-7. Maximizing Windows

This operation is called maximizing a window. Click again on the same button to bring the window back to
its original size.

On the other hand, if you want to hide your window but keep the program running, click on this button:

Figure 5-8. Minimizing Windows

The window seems to disappear. In fact, you resized it to its minimal possible size: an icon. This is called
minimizing a window. You cleared the screen space it was using, but the program is still running. You can
still see it there in the panel, on the KDE Taskbar:

Figure 5-9. The Task Bar under KDE

To view the window on your desktop once more, just click on the icon associated with it.

In most cases you do not want to maximize nor minimize the window. You just want some sort of middle
range where you can adjust the window’s size according to your needs. You can achieve this with your mouse
and the boundary borders of the window.

Bring the mouse cursor to the right edge between the desktop and the running program. Your cursor
will change to a double-arrow. Now press the left mouse button and keep it pressed while moving.
The window resizes and its contents rearranges. When the new size satisfies you, just release the

mouse button.

We did this using the right-hand border of the window. You can do the same thing with the bottom, top or
left-hand borders. You can even do it with the window’s corners, in which case you can resize the window in
two directions at once.

Not all windows can be resized this way, and sometimes minimum
and maximum sizes are predefined.

As a final note about the buttons in the window’s title bar, consider this:
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Figure 5-10. Closing a Window

By clicking on this button (the close button) you quit the running program.

5.5.5. Personalizing your Desktop

You can fully personalize your working environment to suit your personal tastes, such as the background, the
windows and background colors, the themes, the way windows and icons behave, and so on. Please refer to
Personalizing your Desktop, page 52.

5.6. Closing your Session

When you are finally done using your computer, do not forget to tell the system you are leaving, that is
remember to log out in a proper manner.

Logging out can be carried out in many ways. You can use the main menu, log-out icons, right-click on pop-up
menus. Let us look at the different procedures:

From KDE

• Using the Main Menu

Open the main menu and select the Logout item. A window (see figure 5-11) will appear asking you to
confirm.

Figure 5-11. KDE Log-Out Confirmation

• Right-Clicking on the Desktop

You can right-click on the desktop in an “empty” area and a pop-up menu will be displayed.
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Figure 5-12. Logging Out Using the Pop-Up Menu under KDE

Whichever method you use, the screen will shade and a little box will pop up with options. If you click on the
OK button you will quit the current session and, after all of your windows and the desktop itself have closed,
you will be returned to the login screen.

However there are two other options available in the confirmation window: you can choose to shutdown the
system and power off the computer, as well as reboot your system. Again, just click on the OK button after
you’ve selected the desired option.

This is the correct and safe way to shut down or reboot your system. You should never try to do it by pushing
your computer’s power button because this could lead to serious problems such as file-system corruption or
the loss of data.
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Chapter 6. Where to Get Documentation

Apart from the manuals included with Mandrakelinux, documentation is available from many sources. The
next few pages contain suggestions which you might find useful.

6.1. The Documentation Included with Mandrakelinux

6.1.1. Mandrakesoft’s Own Documentation

This section lists all the documentation which Mandrakesoft produced for the current release:

• You may also consult our updated on-line versions on our Documentation pages (http://www.mandrakelinux.
com/en/fdoc.php3).

If you chose the documentation group during the installation, selecting More applications+Documentation
from the main menu will display all the documentation for the languages you selected during the installa-
tion process.

• Starter Guide;

This manual is intended to get you going with Mandrakelinux. It includes basic topics which should be of
interest to new GNU/Linux users, as well as configuration procedures for the most important elements of
Mandrakelinux.

• Reference Manual;

Available on-line and in the Mandrakelinux –– PowerPack Edition, this document covers advanced
GNU/Linux operations and system administration.

• Server Administration Guide;

It covers the most popular services such as HTTP, FTP, POP, and SMTP available with Linux. This document
is only available on-line and on CD.

6.1.2. The Man Pages

This should be your primary source of information on a day-to-day basis. Almost all commands have a manual
page. Other items, such as certain configuration files, library functions for programmers and others system
aspects also have their own man pages.

Man page contents are arranged in different sections. References to these are made in the following manner:
for example, open(2), fstab(5) will respectively refer to the open page in section 2 and the fstab page in section
5.

To display a manual page in a terminal (or shell), type man. The syntax for obtaining a man page is:

man [options] [section] <manual page>

man also has documentation, which can be obtained by typing: man man. Manual pages are formatted and then
displayed using the less pager.

The names of the manual pages and their relevant sections appear at the top of each page. At the bottom are
given references to other pages with related subjects (in general in the SEE ALSO section).

You can start by consulting the pages related to the different commands covered in the Reference Manual: ls(1),
chmod(1), etc.

If you cannot find the right manual page –– for example, you want to use the mknod function in one of your
programs but you end up on the mknod command page –– make sure you spell out the section explicitly. In our
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example: mknod(2). If you forgot the exact section, man -a mknod will read through all the sections looking
for pages named mknod.

6.1.3. Info Pages

info pages complete the documentation included in the manual pages. The command to access info pages
from a terminal is info.

Info pages are organized using a tree structure, the top of which is called dir. From there, you can access all
info pages.

info may be called up in two ways: either by omitting any argument, thereby placing you at the very top of
the tree structure, or by adding a command or a package name, which (if it exists) will open the relevant page.
For example:

info emacs

In the info pages:

* Buffers::

will indicate a link. Moving the cursor to this link (using the arrow keys) and pressing Enter will take you to
the corresponding info page.

You may use the following keyboard shortcuts:

• u: for Up, takes you up one level;

• n: for Next, takes you to the next info page on the same tree-structure level;

• p: for Prev, takes you back to the previous info page.

• q: for Quit, will exit the info page viewer.

A great number of commands may be listed by typing “?”.

6.1.4. HOWTOs

HOWTOs published by the TLDP (The Linux Documentation Project) and available in many languages
will help you configure many aspects of your system. As long as the proper packages are installed (the
howto-html-en package for the English edition), HOWTOs will provide you with an answer to a specific
question or a solution to a problem. The documentation is located in the /usr/share/doc/HOWTO/HTML/en/ di-
rectory. These are HTML files readable and printable with any web browser.

The list is quite long. To get an idea of its length, consult the index from the main menu: Documentation→
HOWTOs English. When you encounter a complex problem, start by reading the corresponding HOWTO (if it
exists, of course!). Not only will you be given a solution to your problem but you’ll also learn a great deal at
the same time. Examples of what is covered range from networking (NET-3-HOWTO), sound card configuration
(Sound-HOWTO), the writing of CD media (CD-Writing-HOWTO) as well as NIS and NFS configuration and much
much more.

An important step is to check the modification dates of the HOWTO documents –– such as the publication date
located at the beginning of the document –– to make sure they are up-to-date, otherwise, the information may
be invalid. Watch out for old HOWTOs relating to hardware configuration: Linux evolves very quickly in the
hardware area. Something else to keep in mind: in the free software world the term “old” carries even more
weight than in IT in general: free software may be considered old after being around for fifteen days!

HOWTOs are available on-line on the TLDP (http://www.tldp.
org/) web site and are likely to be slightly more up-to-date
there. Have a look at the following as well: HOWTOs classi-
fied by categories (http://www.tldp.org/HOWTO/HOWTO-INDEX/
categories.html), and FAQs (http://www.tldp.org/docs.
html##faq).
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6.1.5. The /usr/share/doc Directory

Some packages include their own documentation in one of /usr/share/doc’s sub-directories, which will be
named after the specific package.

6.2. General Guidelines for Solving a Problem under Mandrakelinux

Here are the different means available to you in your problem-solving quest. Try the first option and only
then, if that does not work, try the second, and so on.

6.2.1. Search the Internet

The various Internet sites previously mentioned are excellent starting points. They deal with general and
very specific aspects of your potential problems. Finally, try a general search engine such as Google or, as
mentioned above, the Linux-specific Google search engine. And do not hesitate to use the Advanced search
(http://www.google.com/advanced_search) option with very detailed questions, such as the error message
you are receiving.

6.2.2. Mailing Lists and Newsgroups Archives

The previous searches may lead you to general answers which hide the results of your specific question
amongst many other answers. To refine your search, you can try the following.

First, try to find a list which seems specifically geared to your problem, then perform a search in its archive
pages.

Example
You’ve noticed some strange behavior while trying to use GRUB with a minix partition.

One of the results of a search using the “grub mailing list” keywords in Google is a link to the GRUB mailing list
archive (http://mail.gnu.org/archive/html/bug-grub/). It even offers a search engine, which when searched for
“Minix” leads you directly to a patch.

Note that not all archives have an embedded search engine. Howe-
ver, using Google as an example, you can easily use the advanced
field domain to limit your search to the specific site hosting the
archive. This strategy may also be used to exclude sites which keep
returning garbage.

For a newsgroups search, Google Groups (http://groups.google.com/) maintains an archive of an ama-
zingly large number of newsgroup channels.

6.2.3. Directly Contacting the Person in Charge

Use this option as a very last resort and in really extreme situations –– unless you want to offer your collabo-
ration! Software developers generally receive mountains of e-mails, so your anguished question on the use of
the cd command will most likely... be ignored!

The addresses will be found either on the home page of a project’s site or in the software documentation.
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A last word: do not underestimate your neighbors’ skills or those of your local LUG (Linux Users Group).
And please, do not throw your computer through the window. If your problem isn’t fixed today, it may be
tomorrow...

6.2.4. Mandrakesoft Business Services

Finally, when facing a really challenging situation, corporate users (especially) might consider hiring one of
Mandrakesoft’s consultants to address their specific needs.

This is one of the strong suits of open-source products: we have the source, we have the power! Therefore,
almost any problem, no matter how complex, specific or high level, may be solved right in the heart of the
software.

You might also want to customize your Linux environment to meet very precise goals. For example, you could
use Mandrakelinux as a custom routing application on special devices. Know that Mandrakesoft consulting ser-
vices (http://www.mandrakesoft.com/products/business) can help you.
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7.1. Discovering the K Desktop Environment

This chapter will introduce the K Desktop Environment (KDE) and its panel. It will also talk about the concept
of virtual desktops, how to navigate through and manage them and session support.

7.1.1. The Desktop

Figure 7-1. The KDE Desktop

KDE follows the modern desktop paradigm. In the above figure you see the desktop itself with some icons on
it, while the panel sits at the bottom. However, it introduces something new if you come from the Windows
world: virtual desktops (see Virtual Desktops, page 52)

The icons on the desktop represent files, directories, applications, devices, web pages (actually, the page’s
URL), etc. Almost “everything” can be placed on it. Different actions are associated to icons. For example:
clicking on a text file opens it into a text editor, clicking on a web page opens the URL inside Konqueror (see
Managing your Files, page 86), and so on.

Here are some of your desktop’s default icons, along with a brief explanation for each of them.

Home. Gives access to all your personal files. Under UNIX-like operating systems (Mandrakelinux is
one of them), every user has a personal directory usually named /home/user_name where user_name is the
user’s login name.

Trash. Gives access to all deleted files (the equivalent of Windows’ Recycle Bin). Please bear in mind
that files can be deleted without being thrown into the trash can (“direct” file deletion) so some deleted files
might not be accessible through the trash can.

Dynamic Icons for Removable Media. There will be icons for removable devices on your system
(CD-ROM drive, floppy disk drive, ZIP/JAZ drives, etc.). Clicking on a device icon opens the medium inside
that device. An error message may also be shown if there is no medium present or if the medium can not be
read for some reason.
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7.1.2. The Panel

Figure 7-2. The KDE Panel

The panel is the bar which sits at the bottom of your desktop1 which contains the following main components:

The Main Menu. Allows you to access the software installed on your system. It is the equivalent of
Windows’s Start menu. Programs are arranged into convenient categories so you can quickly and easily find
the application you want to run.

Show Desktop. Use this to minimize all currently opened windows. Pressing it again will restore the
windows to the state they were previously in. Handy when you your desktop is so full of opened windows
and that you want to access, for example, a folder on your desktop.

Desktop Switching Applet. Makes switching between virtual desktops as easy as one, two, three.
See Virtual Desktops, page 52 for more information.

Klipper. Allows you to access the clipboard. The latter is a temporary storage place for all objects
(text, pictures, etc.) you copy on applications (using the application’s Edit->Copy function). Using Klipper you
can browse and manipulate all objects copied onto the clipboard.

7.1.3. Virtual Desktops

Virtual desktops give you more room to place your windows; they also allow you to better organize your
windows by task.

Think of virtual desktops as having several screens available but with only one monitor. By default, there are
four virtual desktops. To add or remove virtual desktops right-click on the desktop switching applet and select
Configure Virtual Desktops from the pop-up menu. Using the slider at the top of the configuration dialog will
allow you to select up to 16 virtual desktops. Press OK once you are satisfied with your settings.

By default, virtual desktops are named DesktopN, where N is the desktop number. To give more meaningful
names to your virtual desktops (such as Work, Play, Internet...), right-click on the desktop switching bar and
select Configure Virtual Desktops from the pop-up menu. Click in the input field of the desktop for which you
wish to change the name and type in the new one. Pressing Apply will make the changes effective immediately.
Press OK once you are satisfied with your settings.

The first virtual desktop is the one opened by default when you log in into KDE. To switch between virtual
desktops just click on the desktop name in the desktop switching applet et voilà !

1. By default the panel is at the bottom, but it may be placed on any border of the desktop.
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7.2. Personalizing your Desktop

7.2.1. Changing your Desktop’s Appearance

Figure 7-3. Changing KDE’s Color Scheme

To change the desktop color scheme choose System+Configuration+KDE+LookNFeel→Colors from the main me-
nu. In the Color Scheme list are predefined color schemes. Select the one you like and click on Apply.

You can also define your custom color scheme by clicking on the element you want to change (for example,
Active Window to change the active window colors) or selecting it in the Widget Color pull-down list. Once the
element (widget) is selected, click on the color bar to open KDE’s color selection dialog, choose the color you
like and click on OK to apply it.

Clicking on Save Scheme... will allow you save the color scheme for later use; you will be prompted for the
scheme name, fill it and click on OK. Clicking on Remove Scheme will remove the currently selected color
scheme.

You are not asked for confirmation before removing a color scheme.
Hence use the Remove Scheme button carefully.

Figure 7-4. Changing KDE’s Background Wallpaper
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To change the desktop background, choose System+Configuration+KDE+LookNFeel→Background from the main
menu. Select the background picture option in the Background section and background scaling, colors and
blending in the Options section.

Click on the Advanced Options... button to adjust settings such as an external program to draw the background,
the cache size for images, etc.

All desktop background settings can be applied on a per-desktop
basis using the Setting for desktop pull-down list. Please note that
doing so consumes more memory.

7.2.2. Managing Desktop Icons

Adding Icons. To add an icon on the desktop simply right-click on the desktop’s background. A pull-down
menu will appear in which you must choose Create New. Another menu will appear in which you must select
the type of object to create on your desktop:

• Folder... creates a new folder on your desktop where you can store files.

• Choosing File→Link to Application... creates an application launcher. When you click on it, the application
will run as if you called it from a menu or the command line. Use it to have quick access to the applications
you use most.

• Choosing File→Link to Location (URL)... creates an icon giving you direct access to an URL (typically a web
page or a web site). Use it to add icons the sites you visit the most on your desktop.

The above list is not extensive. Actually, the choices you have in
the menu will depend on the software you installed on your system.

Please bear in mind that the forms you will have to fill to complete the icon adding operation are different for
each kind of object being created. However, their options are fairly simple.

Modifying Icons. Right-click on the icon you want to modify and select Properties from the menu. You will
then be able change the title (the string displayed under the icon), the icon picture itself, and other properties
of that type of object (folder, application, URL, etc.). Once you are satisfied with your settings, click on the OK
button.

Removing Icons. To remove an icon, right-click on it and select Delete from the menu that pops up to delete
it permanently, or Move to Trash (from where you can restore it later on). In either case, you will be asked to
confirm before proceeding.

7.3. KDE Sessions

KDE and its applications support sessions. This feature allows the system to restore all applications that were
in use when the user logs out of the desktop environment.

Please bear in mind that non-KDE applications, and even some
KDE ones, may have limited session support. The degree of session
recovery is up to the application, ranging from just opening the
application again, to opening it along with all the files that were
open inside that application.

By default, KDE automatically saves sessions whenever you log out of the desktop environment. To change the
default behavior, open the Session Manager (System+Configuration+KDE+Components→Session Manager from
the main menu.), make your choices and click on the OK button once you are satisfied with your settings. They
will be effective the next time you log into KDE.
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Browsing and Surfing

Using the Internet with Mandrakelinux is very easy. And since it includes many mail clients and web browsers,
you can choose the one really suits your needs.

Regarding web browsing, we will talk about Mozilla for various reasons. It is easy to use (in fact, a Windows
version exists so you might have used it already; users accustomed to netscape will also find it familiar). It’s
also very integrated, which means it unites many applications into one. Notwithstanding the web browser
(“Surfing with Mozilla”, page 57), you can also read your e-mail, news from different forums, and use the
ChatZilla IRC client. Hence, it is a powerful suite of applications which provide you with a unified interface.
Since it’s integrated in the Kontact PIM (“The Kontact Client”, page 71), we chose to document KMail for e-mail,
however (“Writing E-mails with KMail”, page 63).
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8.1. Mozilla Interface

You can launch the Mozilla Navigator by selecting Internet+Web browsers→Mozilla from the main menu.

Figure 8-1. Mozilla Browser Interface

Mozilla’s interface is shown in figure 8-1. It is composed of the following:

• Page Display Area. Where the contents of the web pages you browse are displayed.

• Bookmarks Bar. Contains buttons which give you quick access to your bookmarked (favorite) sites (see
Managing Bookmarks, page 59).

• Navigation Buttons & Location Bar. Navigation buttons are explained in Surfing the Web, page 57. The lo-
cation bar is where you enter a web site’s URL (or a local file using file:// as the protocol part of the
URL).

8.2. Surfing the Web

The following table summarizes the most commonly used navigation buttons every web browser possesses.

Button Keyboard Shortcut Function

Alt-left_arrow

Go back. Returns to the page visited before the current one. By
clicking on it more than once, you can go back more than one page,
but some pages use automatic redirection so this may not always
work. Keeping this button pressed (or clicking on the little black
triangle at its right) will show you a list of all the pages you can
access through this feature.

Alt-right_arrow Go forward. Returns to the page visited after the current one
being visited. The same back-button comments apply.
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Button Keyboard Shortcut Function

Ctrl-R

Reload. Refreshes the current page. By default, Mozilla will first
look for the page in the browser’s cache (on-disk temporary
storage space) and use the local copy. Press the Shift key while
clicking on the reload button to force Mozilla to fetch the page from
the network.

Esc

Stop. Stops transferring the currently requested object and will
therefore cancel the page currently being loaded. Notice that we
use the word “object” instead of “page”. This is due to the fact that
web pages are not only HTML code but images and maybe other
media too.

Table 8-1. Mozilla’s Web Browser Toolbar Buttons

8.3. Using the Sidebar

The sidebar gives you quick access to sites related to the one currently displayed, search engines, your book-
marks, history and more if customized. You can hide/show it by selecting the View+Show/Hide→Sidebar sub-
menu or by pressing the F9 key.

The sidebar is arranged in tabs. We’ll only describe some of them, so feel free to investigate tab customization
by selecting Tabs→Customize Sidebar from the sidebar’s menu.

Figure 8-2. What’s Related and Search Tabs

What’s Related. Under Related Links is a list of the sites somehow related (for example: same subject, same
keywords, etc.) to the one currently displayed. Click on the link you’re interested in and the linked site will
be displayed in Mozilla’s Page Display Area. The related-sites list will be automatically updated to reflect the
new site you browsed to.

Search. Enter the text to search for and click on the Search button to start the search using the search engine
you’ve selected in the using pull-down list1. The Search Results field will display links to sites matching your

1. The default search engine (which is Google) and other search options can be changed by accessing Edit→Preferences
from the menu. Go to the Internet Search sub-section of the Navigator section
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search criteria. Only a limited number of search results are displayed, and using the Previous and Next buttons
will let you access more results for the same search.

Figure 8-3. Bookmarks and History Tabs

Bookmarks. In order to conveniently access your bookmarks, it is handy to display them in the sidebar. Clic-
king on Add... will add a bookmark for the site currently displayed. Clicking on Manage will bring up the
bookmarks manager (see Managing Bookmarks, page 59) and clicking on Search... will open a window to search
for bookmarks based on name, location, description or keyword.

History. Mozilla keeps track of the URLs you have visited in the past N days, where N is a number which can be
configured (the default is set to 9 days). If you want to return to a site you visited a week ago, access the Go→
History and look for the 7 days ago entry, open it by clicking on the plus (+) sign and search for the URL which
interests you. Clicking on it will open the site in the Page Display Area.

To change the number of history days to keep, choose
Edit+Preferences→Navigator from the menu and open the History
sub-section of the Navigator section.

8.4. Managing Bookmarks

Bookmarks store the URLs of your favorite web sites so you do not have to type their address again when you
want to access them. You can classify them by subject, category, etc. Your Mandrakelinux system already has
some predefined bookmark categories which you can use as a guide to set up yours. Selecting Bookmarks→
Manage Bookmarks from the browser’s menu or pressing the Ctrl-B keys will open the bookmarks manager
shown in figure 8-4.
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Figure 8-4. Bookmarks Manager Dialog

Bookmarks are classified in a tree structure, with all operations taking place on the currently selected tree node.
Click on the New Folder button to create a new folder. Use folders to group bookmarks by subject, category, etc.
Click on the New Separator button to add a separating line below the current node. Click on the Properties...
button to change the current bookmark’s properties (name, URL, etc.). Click on the Rename... button to change
the bookmark’s displayed name. Click on the Delete button to remove the current bookmark.

Bookmarks can be exported to an HTML file. Choose Tools→Export from the menu, enter the file name
(bookmarks.html by default) of the exported bookmarks file and click on the Save button.

Bookmarks can also be imported from an HTML file. Choose Tools→Import from the menu, enter the file name
of the bookmarks file to import and click on the Open button.

8.5. Tabbed Browsing

Figure 8-5. Mozilla’s Browser Tabs

Mozilla allows you to browse many web pages at a time using a very nice feature called “tabbed browsing”.
Instead of opening a new browser window every time you want to view another page you can open a new
tab.

Clicking on this button (at the left end of the tab list), or choosing File+New→Navigator Tab from the
menu, will open a new tab. You can now input the URL or select a bookmarked site to browse that site in the
new tab. Keyboard shortcut: Ctrl-T.

Use this button (at the right end of the tab list) to close the currently displayed tab. Click on a tab’s
title to display the contents of that specific tab.

8.6. Installing Plugins

Plugins are programs which let your browser handle content other than HTML and graphics, such as ani-
mations, streaming audio, Java applets, and more. Mozilla’s plugins are stored in the /usr/lib/mozilla/
plugins directory and installing plugins require root privileges.

We will look at the procedures to install Java, Flash and Real plugins. If you own a Mandrakelinux –– Power-
Pack Edition, installation is greatly simplified and all the needed packages are on the CDs.
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If you have a Mandrakeclub user name and password, you may be
able to install even newer versions of the software mentioned here.

8.6.1. JAVA

Install the jre RPM package. See “Rpmdrake: Package Management”, page 173, for information on how to install
RPM packages.

You can obtain the Java plugin on the Java Plug-in Home Page (http://java.sun.com/products/plugin/).
Follow the links to J2SE (Java 2, Standard Edition) and download JRE for Linux. Choose the RPM file for the
Linux Platform, make it executable once the download is finished (chmod 700 j2re_*.rpm.bin) and execute
it. Accept the license and a “real” RPM will be created.

8.6.2. Flash

Install the FlashPlayer RPM package (see “Rpmdrake: Package Management”, page 173 for more information).

You can retrieve the Flash plugin on the Macromedia web site (http://www.macromedia.com). Follow the link
to the Flash Player and click on the Download Now button. Extract the tar.gz file to a temporary directory
and follow the instructions given in the included readme.txt file to complete the plugin installation. Test the
plugin by opening the Flash web site (http://www.flash.com) URL in the browser.

8.6.3. Real

Install the RealPlayer RPM package (see “Rpmdrake: Package Management”, page 173 for more information).

You can get the Real plugin on the Real.com (http://forms.real.com/real/player/unix/unix.html?src=
rpbform) site. At the time of writing, the latest Real player available for GNU/Linux was version 8. Complete
the form and select the Linux 2.x (libc6 i386) RPM, then click on the Download User Supported Player button and
download the rpm file.

Follow the instructions on Real’s web page to complete the installation.
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Chapter 9. Writing E-mails with KMail

There are many graphical mail clients under GNU/Linux: KMail, Evolution, Mozilla Messenger, etc. This chapter
will describe how to configure and use KMail to compose, read and organize your e-mail messages.

9.1. Configuring KMail

You can launch KMail by clicking on this icon in the panel or by selecting Internet+Mail→KMail from
the main menu. As we proceed, please note that only the minimum configuration steps will be explained in
this section. Feel free to explore the various configuration options.

Clicking on Settings→Configure KMail... will bring up the configuration window. It is organized as a list of
categories (on the left) and the configuration options for each of those categories (on the right). First, an iden-
tity1 must be defined under the Identities category. KMail offers you a “skeleton” for the default identity based
on your system’s account data (login, name, etc.). Click on the Modify button and, in the General tab, fill Your
name, Organization and Email address with your data (see figure 9-1).

Figure 9-1. Setting General User Parameters

Use the Advanced and Signature tabs to set up other parameters such as different “Reply-To” addresses, a GPG
key for secure messages transmission, and so on. Once you are satisfied with your settings, click on OK and
then on Apply: your default identity will be defined.

To configure the mail servers, select the Network category. In the Sending tab click on the Add... button, select
SMTP as the transport type and click on OK. In the General tab, fill the Name field with a meaningful name for
this server and the Host field with the SMTP server’s name or IP address (see figure 9-2). The remaining fields
can be left with their default values.

1. If you have more than one e-mail address, for example one for your work and a private one, it is useful to create a
different identity for each of them.
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Figure 9-2. Setting the Outgoing Mail Server

For security reasons, it may be that the outgoing mail server you
use needs authentication. If this is the case, check the Server re-
quires authentication option and complete the login and password
provided by your ISP or network administrator.

To receive mail, you need to create at least one account. In the Receiving tab click on the Add... button, select
POP3 as the account type2 and click on OK. In the General tab, complete the Name field with a meaningful name
for this account and the Host field with the POP3 server’s name or IP address. Your ISP should have provided
you with an e-mail user name and password which have to be entered in the Login and Password fields. Put
a check mark in the Store POP Password in configuration file to avoid having to type the password each time
messages are retrieved (see figure 9-3). Click on OK to add the account.

However this could become a security issue. If you do select that
option, anyone accessing your computer while you are logged in
could read (or worst, delete) your e-mails: use at your own risk.

2. Since almost all ISPs provide POP3 accounts to retrieve mail, we used it in our example. If you have another account
type, such as an IMAP (Internet Mail Access Protocol) one, the configuration will differ slightly.
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Figure 9-3. Configuring a POP3 Mail Account

If you have a permanent network connection (such as DSL or cable-
modem) putting a check-mark on the Enable interval mail checking
option and selecting a period (in minutes) using Check interval will
tell KMail to automatically fetch messages periodically.

If you want KMail to handle more than one mail account just repeat the above procedure for each extra account.
Once you are satisfied with your settings, click on OK. KMail is now ready to read and send mail on the
Internet.

9.2. KMail’s Interface

Figure 9-4. Mail Client Interface
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Toolbar. This is where the main action buttons lie. See table 9-1.

Messages List. Where information (subject, date, sender, etc.) about messages stored in the currently selected
folder is displayed.

Message View Pane. Where the currently selected message’s contents are displayed.

Folders List. Where all folders are listed. The default folders are inbox (incoming messages), outbox (unsent
templates), sent-mail (already sent messages), trash (deleted messages) and drafts (messages drafts).

Kontact Buttons. KMail is now a component of Kontact. On the left of the interface you have buttons to access
Kontact’s components.

The following table shows the most important buttons available in KMail’s toolbar, their equivalent keyboard
shortcuts and a brief explanation of the functions they provide.

Button Keyboard
Shortcut

Function

Ctrl-N Compose a New Message. You will need to complete the To and Subject
fields in the message-compose window.

Ctrl-L
Get new messages for all defined e-mail accounts. Keep this button
pressed to display a list of all defined accounts; select the one you want
to get mail from in order to retrieve messages only for that account.

R Reply to the author of the selected message. A message-compose
window will pop up with some fields already set.

F Forward (send to a third party) the selected message. You will need to
fill in the To field in the message-compose window.

D
Delete the selected messages. Deleted messages are moved to the Trash
folder. You can recover messages moved into the trash folder, but
deletion from the Trash folder cannot be undone: be careful!

Table 9-1. KMail’s Toolbar Buttons

9.3. Composing a Message

Figure 9-5. The Message-Compose Window

Toolbar. This is where the main composing buttons reside. See table 9-2

Message Body. The area where you will type the contents of your message.

Message Recipients. The list of all recipients of this message. By default, the following options are shown:

• To: The “principal” intended recipient of this message.
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• Cc (Carbon Copy): Not-hidden “secondary” intended recipient(s) of this message. All recipients will have
access to the mail addresses to which this message is sent.

Select View→BCC from the menu to show the BCC (Blind Carbon
Copy) field. These recipients are also “secondary” but are hidden
from the other recipients of this message. No recipients of the mes-
sage will have access to the other mail addresses to which this
message was sent.

Sending Identity. This appears if you have more than one identity defined and specifies the identity from
which this message is sent. Select the corresponding one using the pull-down list.

The following table shows the buttons which are mostly used in the message-compose window, their equiva-
lent keyboard shortcuts and a brief explanation of the functions they provide.

Button Keyboard
Shortcut

Function

Ctrl-Enter
Sends the message immediately (your network connection must be
active). A copy of the message will be kept in the Sent-messages
folder.

Queue the message. The message will be saved in the Outbox folder
and will be sent the next time you request mail to be sent.

Attach a file to the message. This function is also accessible through the
Attach→
Attach File... menu. A standard file dialog will pop up. Select the file
you want to attach and click on OK. Repeat for multiple files.

Table 9-2. Message Compose Toolbar Buttons
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Using Mandrakelinux on a Daily Basis

This chapter is an introduction to the applications available under Mandrakelinux such as file managers and
external devices.

First, we explore the office suite domain. We discuss the basic uses of OpenOffice.org placing emphasis on its
word processor (Word Processor, page 81) and spreadsheet (Spreadsheet, page 82) components.

The next section (Managing your Files, page 86) discusses the versatile Konqueror application, which can be
used to manage or share files; you can also browse the web with it. Then we guide you through basic printing
operations (Printing and Faxing from Applications, page 89).

Multimedia applications are a must for any OS to be considered as a personal workstation. We introduce you
to XMMS which is a multiple format audio player (Audio Applications, page 95) as well as the best open-source
movie applications such as Xine and MPlayer (Movie Applications, page 101).

We close out this part with a detailed chapter on CD burning. Whether you want to copy audio, data or even
mixed data CDs, we guide you in accomplishing those operations using K3b (CD Burning, page 103).
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Kontact is the client part of Kroupware, the KDE groupware solution which groups together PIM software in a
single working environment. This group of tools allows you to organize e-mail, contacts, appointments, tasks,
news and notes. When Kontact is connected to a groupware server you can synchronize contact, address and
appointment information with other members of your organization.

Kontact is designed to use Kolab, the Kroupware server, as its groupware server. It’s also possible to configure
Kontact to connect to other servers.

In this chapter we’ll show you how to configure Kontact for use with the Kolab server, it will also show you how
to use Kontact’s mail, address book, calendar and to-do item features. For information on how to configure
Kolab see the The Kolab Server chapter of the Server Administration Guide. You can also visit the Kroupware
web site (http://kroupware.kde.org).

10.1. Configuring Kontact

To start Kontact, choose Internet→Mail→Kontact from the main menu. The first time you start Kontact, a con-
figuration window will pop up (see figure 10-1).

10.1.1. Initial configuration

Figure 10-1. The Kontact groupware Window

There are two possible type of configuration:

Enable groupware functions

Check this if you plan on using a Kolab groupware server. We will detail that configuration in Configuring
Kontact to Work with Kolab, page 71.

Disable groupware functions

If you plan on using Kontact standalone with standard mail servers, choose this option. We will detail
that configuration in Configuring Kontact to Work Standalone, page 73.
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10.1.1.1. Configuring Kontact to Work with Kolab

The first dialog asks for some personal information. This is the information which will be shown to your
contacts when sending email.

Figure 10-2. Kontact’s Kolab configuration

The next one asks for the authentication information to contact the Kolab server. Ask your network adminis-
trator for this information.

Figure 10-3. The Kontact Configuration Window

Finally the full mail configuration dialog will appear.

Enter your name, organization and e-mail address. This information constitutes your public profile. If you
wish e-mail replies to be sent to a different address, fill in the Reply-to address field with the alternative e-
mail address. If you want copies of your messages to be sent to another e-mail address automatically, fill the
Mail-copies-to field with that address.
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You can specify a signature to be added to the messages you send either from a file or as a text message. To
add a text signature, select the Specify signature below option and write your signature in the input field.

To add a signature file, select the Use a signature from file option and enter the name of the file in the Signature
file field or click on the Choose button to browse to the desired signature file.

You have now filled in the basic configuration information necessary for running Kontact. Using this configu-
ration window it’s also possible to set:

• news and SMTP servers (Accounts section);

• the visual appearance of Kontact (Appearance section);

• configuration information for reading and posting news (Reading News and Posting News sections);

• privacy settings for signing and encrypting messages (Signing/Verifying section);

• article expiration settings, for example in order to save disk space (Cleanup section).

Set the options as required, and click on OK once you’re satisfied with your settings. The main Kontact window
will now be shown (figure 10-5).

10.1.1.2. Configuring Kontact to Work Standalone

The first dialog asks for some personal details. This is what will be shown to your contacts when sending
email.

Figure 10-4. Kontact’s Kolab configuration

You will need to define one outgoing account, and at least one incoming account. Your Internet service provi-
der should have provided you with the required information.
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10.1.2. Kontact Interface

Figure 10-5. The Kontact Summary Component

By default Kontact opens to the Summary component. In the right hand panel you see a list of new messages,
birthdays and anniversaries, pending appointments and notes. In the left hand panel are some icons which
allow you to open Kontact’s components.

10.1.3. Importing Kolab IMAP Resources

To take full advantage of Kolab, you should now direct KMail –– Kontact’s mail component –– to import:

1. Click the Mail icon in the left hand panel

2. Click Configure Kmail in the Settings menu.

3. Click the Misc icon in the configure Kontact window.

4. Click the Groupware tab.

74



Chapter 10. The Kontact Client

Figure 10-6. Enable Kontact Groupware Settings

5. Select the Enable IMAP resource functionality check-box.

6. Select a resource folder for the IMAP folders.

7. Select the Enable groupware functionality check-box.

KMail is now configured to synchronize with a Kolab installation.

10.1.4. Configuring the Kontact Calendar

The groupware functions of the Kontact Calendar permit you to synchronize free or busy information with
other users. This allows you to take into account calendar information of other users when organizing events.
The configuration to communicate with a Kolab server has already been done during initial configuration.

To ensure that calendar and to-do events are synchronized via the Kolab server. In the Kontact interface:

1. Click the Calendar icon in the left hand panel of the Kontact window.

2. Click the Add button at the bottom of the right hand panel.

3. In the Resource Configuration dialog, select, Calendar on IMAP-server via Kmail.

4. Click OK.

Kontact is now configured to work with the Kolab Server.

10.2. Accessing Group Contact Information

This section will show you how to retrieve contact information from the Kolab web server and store it locally.
It will also show you how to create a local vCard for a personal contact.

Kontact gives read-only access to information stored by the Kolab server, To look up addresses on the server
do the following:

1. Click the Contact icon.

2. Select Tools→Lookup Addresses in the LDAP Directory.
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Figure 10-7. The Search for Addresses Window

3. In the Search for text box, type the name you wish to search for.

4. Click Search. A list of names matching the search string will appear.

Selecting the Recursive search check-box to enable a search of all
directories and subdirectories.

5. Select the users you wish to add locally or click Select All.

6. Click Add Selected.

7. Click Cancel.

The names you selected are now in your users list. Select a user and Kontact will display the user information
stored by the Kolab server in the right-hand panel.

To add personal information about this contact for later use, select the user you wish to edit, Click Edit Contact
in the file menu. The Edit Contact window will pop up.

Figure 10-8. The Edit Contacts Window

Add the contact information and click OK for the vCard to be saved locally.

If you wish to add information about a new contact locally, click New Contact in the File menu. The Edit Contact
window will pop up. Add the contact information and click OK.

All user information –– both local and global –– is now available to all other parts of Kontact, not just in the
Contacts interface. If you write an e-mail or create a meeting, details about these users are accessible.
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10.3. Using the Kontact Calendar Features

Kontact calendar allows you to organize and co-ordinate tasks and events. If you have configured Kontact to
work with the Kolab server as described in the configuration part of this chapter, calendar information of all
other users will be available for you and events will be synchronized via the Kolab server.

10.3.1. The Kontact Calendar Interface

To see the calender interface, click the Calender icon in the left hand panel.

Figure 10-9. The Kontact Calendar Interface

Dates on which you have meetings are marked in a bold font in
your monthly calendar.

As shown in figure 10-9, the Kontact calendar interface displays To-do items, your days’ itinerary and calendar
month.

10.3.2. Organizing a New Event

If you have a meeting on the current day, Kontact displays the meeting times with its subject in the Itinerary
window. If you wish to organize a new event:

1. Select the day you wish to hold the meeting from the calendar.

2. In the days’ itinerary, click on a start time, and drag to the end time of the meeting. The time you have
selected will be highlighted.

3. Right-click in the highlighted area, select New Event and a window will pop up.
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Figure 10-10. The Edit Event Window

You will notice that the times selected previously are noted as the start and end times of the event. The duration
is automatically marked as busy but can be set as free.

Select the Reminder check-box and the number of minutes before the event that you wish to receive the remin-
der. A sound file may be used to signal the reminder by clicking the note icon.

To associate categories to the event:

1. Click the Select Categories button.

2. Select the check box next to the categories you wish to be associated to this event.

3. Click OK.

To add a new category type, click the Edit Categories button in the
Select Categories dialog and type your new category name.

To invite other users to this event, click the Attendees tab. It is possible to add users by clicking the New button.
This creates a new user with empty fields. Simply fill in the blanks with the appropriate values.

Stored contacts may be accessed by clicking the Select Addresses button. This opens the Select Addresses
window. Select the contact you wish to invite to the event and click OK.

If this event is going to occur on a regular basis, click the Recurrence tab. Select the Enable recurrence check-box
and the recurrence option will be enable.

In the Recurrence Rule section, select the frequency with which your event will recur, either daily, weekly,
monthly or yearly. You may also add an end date to the recurring event and special exceptions. For example,
if your meeting occurs at midday on the 25th of every month, you may wish to add the 25th of December as a
special exception when this event will not take place.

By clicking on the Gantt tab, you will see that it is possible to see the calendar information for invited users.

When you have configured your event click OK. As shown in figure 10-9, the event is now marked in the main
calendar interface.

10.3.3. Organizing To-Do Items

To-do items may be jobs you wish to do yourself, or tasks which need to be fulfilled by a group of users. The
Kontact task systems functions in a similar way to the event system.

To create a new to-do item, write the name of your new task in the To-do items text box in the Kontact calendar
interface and press Enter. If you are using a groupware server the Resource Selection dialog will pop up.
Choose the resource you wish to use and click OK. If you are not linked to a groupware server, this event will
automatically be saved locally. The to-do item you have just created will appear in the to-do summary. To edit
this item double click on the to-do name. The Edit To-Do window will open.
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Figure 10-11. The Edit To-Do Window

Most importantly with to-do items, you can edit the items priority and percentage completed.

As with events, you can edit the title, name, start and end times, attendees and attachments. When you have
edited the to-do item, click OK.

When you have edited your event, click the Todo List icon in the left-hand panel of the Kontact window. You
will see the event in the summary.
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11.1. Word Processor

This section will give you a brief introduction to OpenOffice.org Writer’s word processing functions.

In order to make the text a little easier to read, we will alternate
between the popular OOo acronym and the very long, yet full and
correct OpenOffice.org name.

11.1.1. OpenOffice.org Writer

OpenOffice.org Writer is the part of the OpenOffice.org suite which provides the word processing functions.
OpenOffice.org Writer can read popular Office formats, easing the transition from, and ensuring compatibility
with, other Office suites.

11.1.1.1. Starting

To launch OpenOffice.org Writer, select Office→Wordprocessors→OpenOffice.org Writer from the main menu.

You can also open it from any other OOo application screen, by selecting File→New→Text Document, which
will open a blank OOo Writer document.

11.1.1.2. Interface

Figure 11-1. OpenOffice.org Writer’s Main Window

Format Bar

This is the standard format bar used for all OpenOffice.org applications and is used to change fonts, colors,
alignment, etc. of the application’s data.

Rulers

Rulers define the horizontal location of the text and format elements. They are extremely useful when you
want to establish tabulations and paragraphs indentation.
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Work Area

Where you enter the content of your document: words, numbers, images, tables, hyperlinks, etc.

Insert Point

All characters typed on your keyboard will be placed at the left of this point. Also called the cursor.

Stylist

Clicking on any of the styles shown on the list will change the current selected text’s style or the whole
page style if no text is currently selected.

Page Style

Page size, margins, text-orientation, etc. all define the style. Page style can be changed by choosing
Format→Page from the menu. You may use any one of the pre-defined styles or define one of your own.

Page Zoom

The current zoom level at which the page is being displayed, 100% by default. You can reduce it to, say
50% to take a “quick glance” at the page’s layout. However the page preview feature (more on that later)
is the preferred way to do this.

Insert Mode

When this shows OVER, the characters you type will overwrite the existing ones (if any) at the Insert Point.
When this shows INSRT (the default mode), existing text at the Insert Point will not be overwritten but
characters you type will be “inserted” at the cursor.

11.1.2. Going Further

If you wish to learn more on the usage of OpenOffice.org Writer, you should consult the tutorial available on
the OpenOffice Support (http://www.openofficesupport.com/writertutorial.html) Web site.

Also do not hesitate to refer to the OpenOffice.org Writer on-disk help accessible through the Help→Contents
menu. You are bound to find the answers to your questions. Topics are accessible through a table of contents,
an index is available as well as a contextual search tool.

OpenOffice.org Writer is able to export your documents in PDF
format (File→Export as PDF ...). This allows you to publish your
documents in the famous Adobe® Reader® format.

11.1.3. Conclusion

Word processing could be considered as one of the most performed actions with a personal computer. As you
have read above, OpenOffice.org Writer is a tool which not only gives you everything you need to create simple
or complex documents, but is also compatible with existing Office file formats. Enjoy creating your documents
with OpenOffice.org Writer!

11.2. Spreadsheet

This section will give you a brief introduction to OpenOffice.org Calc’s spreadsheet functions.

It takes for granted that you know why you intend to use a spreadsheet and will not delve deeply into
application-specific (accounting, financial, simulation, etc.) considerations.
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11.2.1. What’s a Spreadsheet?

Spreadsheets are electronic replacements for an accountant’s ledger book and calculator. This software
uses columns and rows to allow math operations to be performed on previously entered data. Nowadays,
spreadsheets do a lot more as they are often used as (very) simple databases or as a charts and graphs appli-
cation, even though that was not the original intention of such software.

Figure 11-2. Rows, Columns and Cells

Rows are named 1, 2, etc. Columns are named A, ..., Z, AA, AB, etc. The intersection of a row and a column is a
cell, and its name is composed of the column and row attributes, for example: C3 (shown in figure 11-2).

11.2.2. Using the Spreadsheet

OpenOffice.org Calc is an enterprise-ready spreadsheet application and includes many features way beyond
the scope of this document. Consult Going Further, page 86, for more information on how to make full use of
OpenOffice.org Calc.

The following sections will explore basic functions such as entering data and formulas in the spreadsheet and
adding graphics to represent that data. An example of an imaginary company’s monthly expenses and sales
figures will be used.

11.2.2.1. Entering Data

To enter data into a cell (either text or numbers) use the arrow keys to navigate to that cell or click in the cell
and type the data in it, pressing the Enter key when you are finished. You can also use the Tab key or the
Shift-Tab keys to move to the cell on the right or on the left, respectively.

The auto-completion feature simplifies data entry. Auto-completion “guesses” the next cell’s data using the
current cell’s value as a base. It works not only for numeric data, but also for the days of the week, the months
of the year, and others. Generally speaking, any kind of data which can be associated to a series of consecutive
integral numbers can be entered using auto-completion.

Figure 11-3. Simplifying Data Entry Using Auto-Completion
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To use auto-completion put your mouse over the cell “handle” (the little black square located at the bottom
right of the cell border), click on it and drag the cell. The cell values will be shown in a tool-tip (see figure
11-3). Once the desired final value is shown, release the mouse button and the cells will be completed.

Cell data can also be sorted according to different criteria (by column or row, depending on how you arrange
your data). To do so, first select the cells you want to sort and then open the sort options dialog choosing Data→
Sort from the menu.

Make sure you also select columns and rows which act as“headers”
for the data (in our example, the column B which contains the
months) in order for those to“follow” the sorting of the data.

In the Sort Criteria tab select the columns/rows to sort data by and the sort order Ascending or Descending.
The Options tab contains custom sort order settings, whether to perform a case sensitive sort or not and the
direction of the sorting (top to bottom sorts data disposed in columns and left to right sorts data disposed in
rows), among others. Click on the OK button once you are satisfied with the options and the selected cells will
be sorted.

11.2.2.2. Adding Formulas

Formulas can be used to “automate” the spreadsheet allowing you, for example, to run complex simulations.
Within cells, formulas are defined by preceding all cell data with the = sign. Anything else is treated as “static”
data.

Operations are expressed using conventional algebraic notation. For example =3*A25+4*(A20+C34/B34) divi-
des the value in cell C34 by the value in cell B34, adds the value in A20 to the result, multiplies that by 4 and
adds to 3 times the value of cell A25. Thus, rather complex expressions can be made using simpler ones as a
base.

OpenOffice.org Calc gives you a lot of pre-defined functions which you can use in your formulas. There are
date and time, mathematical, statistical, financial, logical and many other kinds of functions available. Explore
them by invoking the function AutoPilot by choosing Insert→Function from the menu or pressing the Ctrl-F2
keys.

Under KDE the Ctrl-F2 key combination switches to desktop num-
ber two, so you might want to redefine that in order to be able
to invoke OpenOffice.org Calc’s functions wizard using a keyboard
shortcut.

figure 11-4 shows the AVERAGE function applied to the selected range of cells to calculate their average value.
Note the use of the : character to specify a range of contiguous cells in the function.

Figure 11-4. Using a Function in a Formula
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11.2.2.3. Charts: Explaining Data in a Simpler Way

When a spreadsheet contains too much information it becomes difficult to understand how data relates to
other data: too many numbers and too little meaning. The best way to represent this kind of data is through a
chart.

As in all data-analysis functions, you must select the region you intend to show in the chart. So, select a range
of cells and then chose Insert→Chart... from the menu to bring up the chart assistant.

Figure 11-5. Choosing the Chart Type

After making your selections in the first page of the chart assistant and clicking on its Next >> button, you
will see the chart-type selection page (in figure 11-5, a 3D side-by-side bar chart is chosen). Make your choices
and click on Next >> to obtain variants on the type you have selected. Again, make your choices and click on
Next >> to choose the final chart options, such as the chart’s title, axis titles, etc. Make your choices, and click
on Create to create and insert the chart in the spreadsheet (see figure 11-6).

Figure 11-6. A 3D Chart Inside the Spreadsheet

Charts are “live” in the spreadsheet which means that when you
change data in a cell belonging to a chart, the chart will be auto-
matically updated.

Right-clicking on an inserted chart brings up a menu showing op-
tions to change many chart parameters. For instance, the chart’s
title can be changed by double-clicking on it.
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11.2.3. Going Further

If you wish to learn more on the use of OpenOffice.org Calc, you should consult the tutorial available at the
OpenOffice Support (http://www.openofficesupport.com/calctutorial.html) Web site.

Also, do not hesitate to refer to the OpenOffice.org Calc on-disk help accessible through the Help→Contents
menu. There you are bound to find answers to your questions. Topics are accessible through a table of contents,
an index is available as well as a contextual search tool.

11.2.4. Conclusion

Spreadsheets simplify many accounting and other numeric-data-related tasks. They are used all over the
world, from the corner-store manager who wants to manage schedules, to the biggest accounting firms which
use it to write extensive and consistent data reports.

OpenOffice.org Calc offers extensive features for advanced users. You can use it as a simple database, or even
program complete interfaces. You can also convert formats, define templates, etc. OpenOffice.org Calc is a very
powerful application and will surely be around for quite a while.

11.3. Managing your Files

File managers have grown to become multi-tasking applications, which do not only take care of basic tasks
such as copying and moving files around. In fact, with Konqueror you are able to manage your files, browse a
LAN, play audio files such as MP3s, surf on the web, and more.

In this chapter, we take for granted that you have used a file manager before, and that it is not necessary to
describe elementary features which are self-explanatory. We decided to talk about Konqueror which is KDE
default file manager.

11.3.1. Main Window

You access your file manager by clicking on the Home icon located on the top left of your desktop.

Figure 11-7. Konqueror
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The right side of the window displays the current folder’s contents (by default, what your home directory
contains). On the left side of the window is the sidebar (refer to Sidebars, page 87). Each file or sub-directory is
represented by an icon, although you can change that view through the View→View Mode menu.

The first time you launch Konqueror you will not see its sidebar.
To show/hide it, select Window→Show Navigation Panel. You can
also show/hide it by hitting the F9 key.

11.3.2. Sidebars

Here are short definitions of the icons in Konqueror’s sidebar:

Icon Meaning

Show Navigation Panel. This icon lets you change the sidebar view, add new folders,
and more.

Bookmarks. Where you can store your preferred web and FTP sites.

Devices. Gives you access to the CD-ROM, the Floppy, removable devices (such as USB
keys under the Hard disk entry), and Remote Shared folders, such as NFS or SMB
shares (see Local Disk Sharing: Allowing Users to Share Folders, page 141).

History. A list of the folders and network (web, FTP, etc.) sites you have visited
during the current session.

Home Directory. Represents your personal folder in which you organize your audio
and data files.

Network. Gives you access to FTP archives as well as Mandrakelinux- and KDE-
specific web sites (of course, you can add or delete some sites).

Root Folder. Lets you access your whole tree structure. Usually, you do not have
enough rights to manipulate files outside your home directory. Only the system
administrator (root) possesses the rights to do so.

Services. Gives you access to the Audio CD Browser, Devices, Fonts, the LAN Browser
and the Print System Browser.

Table 11-1. Konqueror Sidebar Icons

11.3.3. Copying, Moving, Linking and Deleting Files

Copying Files. Let’s imagine you want to copy test.png to the Documents folder. With Konqueror, you first
need to access the Window→Split View Left/Right (or press the Ctrl-Shift-L keys) menu or the Window→Split
View Top/Bottom (or press the Ctrl-Shift-T keys) menu. Your window will be duplicated and you will be able
to drag’n’drop the test.png image file into the Documents folder. Once you let go the file on the folder, a pop
up menu will ask you whether you want to move, copy or link the file. The easiest way is still the drag’n’drop
technique.

There are many ways to manipulate files within your file mana-
ger. Drag’n’drop, keyboard shortcut combinations, opening two file
managers, etc. Choose the one you prefer.

Moving Files. The same principle applies to moving files around. However, use the Ctrl-X shortcut instead
of Ctrl-C to move your files. Of course, you can accomplish this by drag’n’drop too.
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Linking Files. Linking files allows you to access them without actually copying them all around your
home directory. Let’s imagine one of your files is deeply buried into the /home/queen/Music/Artists/
FavoriteArtist/ directory and you want to access it quickly. Here’s how to proceed. With Konqueror simply
drag it to the desired location, release the mouse button and select Link Here.

Deleting Files. There are “safe” and “unsafe” ways to delete files. The safe way would be to move it to the
Trash, while the unsafe one would be to delete it for good directly. To delete a file, select it and press the Del
key. To restore it, double-click on the Trash icon on your desktop and drag the file(s) back into your browser.
To delete trashed files, simply Empty Trash Bin with a right click on it. To delete a file directly, right-click on it
and select Delete.

11.3.4. Browsing Web Pages

If you frequently browse through directories containing HTML files, for example your distribution’s docu-
mentation, these directories generally contain a file called index.html.

Let’s take the /usr/share/doc/HTML/ diresctory as an example. If you do not activate the Use index.html op-
tion, you will only get a list of files and directories which that folder contains. If you activate that option,
Konqueror displays the contents of the index.html file, and you can browse through the documentation, as if
you were on the web. To activate it, access the View→Use index.html.

Browsing the web with Konqueror is as easy as using a “real” web browser (please see “Surfing with Mozilla”,
page 57). Just type in the URL of the site you want to visit in the location bar and surf.

11.3.5. File Sharing

This feature allows you to share your documents with other people on the local network and access documents
other people share. It also enables system administrators to provide users with common repositories where
everyone can add, modify and consult files.

11.3.5.1. Sharing Files

If file sharing is activated through the Mandrakelinux Control Center (please see Local Disk Sharing: Allowing
Users to Share Folders, page 141) you can right-click on folders in your Konqueror window and choose Share. It
allows you to share one or as many folders as you like through NFS 1 or Samba 2.

11.3.5.2. Browsing Shared Files with Konqueror

You can browse all available shared files on the network by opening the LAN Browser section in the Services
sidebar icon. All machines offering shared files will appear as folders under this section. Inside the host name
folder appears one folder per protocol supported by this machine. Those may be:

FISH

This protocol relies on ssh communications. So every local machine having an ssh server running on
it will allow you to connect to it (providing proper authentication) and browse all the folders you have
access to.

NFS

Under this folder will appear the shares provided by UNIX machines (see Importing Remote NFS Directories,
page 141).

1. NFS (Network File System) allows you to share, export/import files from/to your computer in a networked envi-
ronment. Although the NFS setup is easier than the Samba one, it can only be used within a UNIX-based system (like
GNU/Linux). Moreover, NFS is an insecure protocol and should be used exclusively in a secure local environment.
2. SMB is a protocol by which PCs share resources such as files and printers. Windows, GNU/Linux (through Samba) and
OS/2 operating systems, among others, support the SMB protocol. It can be considered an alternative to Netware and NFS.
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SMB

Shares provided by Windows or SMB-enabled machines will show up under this folder (see Importing
Remote SMB Directories, page 139).

for LAN browsing to work, make sure the lisa package is installed.
If not, you will have to start the lisa service after installing it.

11.4. Printing and Faxing from Applications

Once your printer is properly installed (refer to PrinterDrake: Configuring Printers, page 126 for instructions on
printer installation) it is time to put it to use. In the past printing has been a “hard” topic under GNU/Linux
but as you will soon discover, that has changed a lot. Both KDE and GNOME applications support a simple
printing method based on a program called kprinter. kprinter can even be used to build PDF files and to send
faxes.

11.4.1. Accessing KPrinter

From KDE applications, clicking on the print button or selecting File→Print will invoke kprinter directly. Make
sure you select the page range, the printing quality, the number of copies, etc., and click on the Print button.

GNOME applications have to be set up to print with kprinter. In fact, every X application which supports the
definition of its printing command (for example, Mozilla) can use kprinter. All you have to do is invoke the
print options (by typing Ctrl-P, or by selecting File+Print) then look for an option named “Print command”,
“Printer” or similar, and fill it with kprinter --stdin. This way, kprinter will be invoked every time you ask
that application to print. Then click on the Print button and you will see kprinter’s main window (no actual
document will be printed at this point).

11.4.2. KPrinter’s Interface

kprinter allows you to set many options3 for printing your documents, such as the output device (generally a
physical, local or remote printer), the number of copies, the paper size, the printer resolution, etc.

Figure 11-8. KPrinter Window

3. The actual printing options you will be able to set will depend on the output device you select, not all devices have
the same capabilities.
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As you can see in figure 11-8, the interface is quite clean and simple4: in the Printer section you can choose
the printer from a pull-down list. Depending on the printing system you use, you can also add new printers
(clicking on the magic wand icon will launch a wizard to help you to do this) and you can further configure
the printer settings by clicking on the Properties... button.

At the bottom of the window are buttons which allow you to Expand kprinter’s options. The System Options...
button gives you access to global printing configuration. Then, the buttons to get Help, Print your document
or Cancel that printing operation.

11.4.2.1. The Printer Section

In this section, you set the device which will receive your print job and its properties, such as page size,
resolution, etc. All the available printers are listed in the Name pull-down list. Just select the one you want to
print to.

Usually, your local printer, the “Print to file” printers (both PDF
and Postscript) and the“Fax”printer are listed. However, if you are
in a network, all printers available on the network will be listed too,
so network printing becomes very simple.

Click on the Properties... button to change the device’s options. Please note that the options available will
depend on the chosen device.

Figure 11-9. Printer Properties Window

Most options available are self-explanatory. One worth mentioning is Pages per sheet (set to 2 in the example).
This allows you to put up to 4 pages onto a single sheet of paper (or 8 if you can print on both sides). This is a
nice feature to save paper when printing book drafts or other lengthy material which changes often.

4. For applications defined to use the kprinter --stdin command, the interface will open showing the expanded view
by default. Click on the Collapse button to change to the simplified interface.
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Figure 11-10. Changing Printer Resolution

If you want to change printer-specific options such as the resolution of the printing device, you click on the
Driver Settings tab. Here you will find the Resolution option as one of the available categories. When you click
on it, the available resolutions will be displayed in the bottom part of the window. Select the one you want
from the list.

Other settings include printing modes which use much less toner or ink (search for something like “Economy
Mode”, “Toner Density” or “Toner Saving”). However, the output is much paler. If this is not available, choo-
sing a lower resolution often has similar effects.

You can use the Save button to save the current settings for future printing jobs. Once you are satisfied with
your settings, click on the OK button.

11.4.2.2. Expanded Printing Dialog

After clicking on the Expand button, kprinter’s dialog changes to the one shown in figure 11-11.
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Figure 11-11. More Printing Settings

In the Copies tab you have the page range settings and the number and order of the copies. Page selection can
be set to:

All

Prints all of the document’s pages.

Current

Prints only the document’s current page. This option might not be available at all times.

Range

Allows you to specify page ranges to print. You can specify pages or groups of pages separated by com-
mas (1,2,5 prints pages 1, 2 and 5; 1-3, 7-21 prints pages 1 to 3 and 7 to 21, etc.).

The Page set pull-down list lets you specify pre-defined sets of pages to print (All pages, Odd pages or Even
pages). This allows you to print double-sided documents on a printer without a duplex unit: print the odd
pages, turn the stack of printed pages over and put them back into the input tray, then print the even pages.

Under the Copies section, use the little arrows to increase or decrease the number of copies or just type the
number of copies you want to print in the Copies field.

When you are printing multiple copies, you may check the Collate check box to print the whole document
before starting to print the second copy, instead of getting all copies of page number 1, then all copies of page
number 2, and so on.

The Reverse check box makes the printing start at the last page and end at the first one (the document is printed
“backwards”). This option is useful if your printer leaves the paper sheets face-up in the output tray.

The HTML Settings tab lets you define options concerning HTML pages printing such as: a “Printer friendly
mode” which does not print the background and prints all text black to save toner or ink, and whether or not
to print images and a header.

In the Advanced options tab you may set some options concerning printing time, priority of the print job and
so on.
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Click on the Collapse button to return to the “minimal” display mode of kprinter.

11.4.3. Building PDF Files

Creating a PDF file from your document is very easy with kprinter. Simply select the Print To File (PDF) special
printer, enter the file name in the Output file field as shown in figure 11-12 and click on Print. A PDF file will
be written (print.pdf in your home directory in our example).

Figure 11-12. Generating a PDF File

11.4.4. Sending Faxes

The special Send To Fax printer allows you to send faxes in the same way as some Windows applications, by
“printing to the fax”. When you click on the Print button, a dialog like the one shown in figure 11-13 appears.

Figure 11-13. Faxing Main Window

First, you need to make sure that your fax modem is properly configured. To configure your fax modem,
select Settings→Configure KdeprintFax... from the menu. Fill the information under the Personal section with
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your name, company and fax number. Under the System section make sure the correct faxing system and its
corresponding parameters are set. An example is shown in figure 11-14.

Figure 11-14. Fax Settings

Fill in the Fax number field and click on the Send Fax button, or press the Enter key, to send the fax
immediately.

The View Log button (Ctrl-L) will show you a window with the fax activity log (check it to make sure
your fax has been sent correctly).

The Address Book button (Ctrl-A) will open the KDE address book to let you select fax numbers to
dial.

Once your fax has been sent you can quit the fax window by selecting File→Quit from the menu or pressing
Ctrl-Q keys.

11.4.5. Multi-Function Printers

Some printers are known as multi-function devices. This generally means that the printer may also be used as
a scanner and maybe also as a fax. There are also printers that can read digital photo camera memory cards,
some can even print photos directly from the memory card.

If you have a multi-function device with scanning functionality, please note that the scanner may be configured
with PrinterDrake and not with ScannerDrake. Make sure you read PrinterDrake’s messages when installing the
device. Please refer to PrinterDrake: Configuring Printers, page 126.

In any case, refer to your printer documentation for information on operating the different functions or devices
your multi-function printer has.
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12.1. Audio Applications

This chapter will concentrate on audio applications. First we will look at XMMS (a multi-format audio player);
then we’ll describe KsCD (a CD player) and Aumix (a mixer).

12.1.1. Using XMMS

XMMS stands for X MultiMedia System. With it you can play a variety of audio sources, such as regular music
CDs, MP3 and Ogg Vorbis formats.

To launch XMMS1, access the main menu and choose Multimedia→Sound→Xmms.

Figure 12-1. XMMS Main Window

The upper part of the window is called the title bar. The buttons at the right-hand end of the title bar do the
following:

• the leftmost button minimizes the window;

• the middle button shrinks XMMS into “mini” mode: you will only see the title bar, the vu-meter, the elapsed
time and the play controls.

• the rightmost button closes XMMS.

Let us look at the different sliders. The one beneath the bit rate info is the volume slider. To its right is the left-
right balance slider. The longest slider is used to browse through the current audio track, and is equivalent to
the rewind and forward functions.

To the left of the time display and the spectrum analyzer are 5 letters: you may not see them at first because by
default the letters are in black, while the background skin is in dark gray. Here are the letters and what they
represent:

• O: pops up the options menu

• A: means the XMMS window will always be on top of other windows

• I: pops up a file-info box

• D: doubles the size of the XMMS window

• V: pops up a visualization options menu

You can also right-click on XMMS’ window to access every possible
option.

1. The xmms package must be installed. Please refer to “Rpmdrake: Package Management”, page 173.
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12.1.1.1. Equalizer and Playlist

Figure 12-2. XMMS Main Window with Equalizer and Playlist

To access the equalizer and playlist, simply click on the EQ and PL buttons found below the MONO / STEREO
indicator on the right-side of the main window.

12.1.1.1.1. Configuring the Equalizer

The equalizer window acts exactly like the one you probably have on your stereo. If you wish to change the
settings, click on its ON button. You can then change the bass and treble levels to your liking. You can use the
PRESETS menu item to save your settings for future use, to load any previously saved ones, and more.

If you want to import WinAMP settings, use the PRESETS→
Load→From WinAMP EQF file sub-menu.

12.1.1.1.2. Using the Playlist

To access the playlist, click on the PL button. It contains 5 buttons:

+ FILE

Clicking once on this button pops up a window which you may use to select your songs. For example,
if you had a directory called MP3 you would select /home/queen/MP3/ and then start adding songs from
that directory.

However, if you click and hold the mouse pointer on it, two buttons will pop up: + DIR and + URL.
Use the former to add a music directory to your playlist; or the latter to enter a URL such as
http://205.188.209.193:80/stream/1040, which is a high-bandwidth connection streaming address.

- FILE

If you want to delete a file from the playlist, select it with your mouse and click on the - FILE button. You
can also use your keyboard’s Delete key. If you want to remove more than one file, click and hold the
mouse over the - FILE button and select the appropriate option.

SEL ALL

Clicking on this button will select all the files in your playlist. If you click and hold, you will also have
SEL ZERO (which selects no files) and INV SEL (which inverts the current file selection) entries.

MISC OPT.

Clicking and holding this button gives you a pull-up menu which shows FILE INF (pops up a file-
information window) and SORT LIST (gives you sorting and randomizing options).
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LOAD LIST

Clicking once on this button pops up a window from which you can choose the list you wish to listen to.
Clicking and holding on this button allows you to save your playlist’s files as a list of audio tracks (SAVE
LIST). The NEW LIST entry is self-explanatory.

12.1.1.2. Playing Audio Tracks

To play audio tracks, simply follow the instructions given in Using the Playlist, page 96 to load a playlist and
hit the Play button. Pressing on the Eject button allows you to add files to your playlist. Once you have selected
the tracks you want to add, click on Add and on Close.

Figure 12-3. Loading Files into XMMS

Right-clicking in the Playlist opens a handy menu which includes all the playlist options explained above.

12.1.1.3. Using the Options Menu

To access the various options, click on the O to the left of the spectrum analyzer or right-click on XMMS’
window and choose Options:
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Figure 12-4. Options Menu

12.1.1.4. Skins

Like other players, you can change the look of XMMS by altering its skin2. To do so, open the Preferences menu
and select Skin Browser. You can also press on Alt-S.

Figure 12-5. XMMS Skins Browser

The Skin Browser selects the (none) skins by default. Clicking on one of the skins will give you a real-time look
at it. As an example, scroll down through the list of skins and click on chaos_XMMS.

Figure 12-6. Chaos Skin

If you wish to add skins to your Skin Browser, you can do so by visiting sites such as the XMMS site (http:
//www.xmms.org/skins.html) or the Customize site (http://www.customize.org/).

2. The xmms-skins package must be installed. Please refer to “Rpmdrake: Package Management”, page 173.
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Once you have found a skin you like on a web site, download it into the ~/.xmms/Skins directory. Open the
Skins Browser and XMMS will be wearing that new skin.

12.1.1.4.1. Other Types of Skins

As stated above, you can use other types of skins such as WinAMP ones.

Here is an example of a skin found on the WinAMP site (http://www.winamp.com/) which can be added to
your Skins Browser:

Figure 12-7. Using WinAMP Skins with XMMS

Download the skin file to your skins directory ~/.xmms/Skins, select it in the Skins Browser and enjoy!

12.1.1.5. Streaming

You can listen to your favorite web radio sites, whether they be from Shoutcast (http://www.shoutcast.
com/), Icecast (http://yp.icecast.org/index.html) or plain radio sites.

When you have found a channel you like, save the .pls file to your hard disk and then insert it into your
playlist.

Figure 12-8. Opening the Connection Information for a Streaming Channel
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12.1.2. KsCD CD Player

Although you can play CD’s with XMMS, we will briefly describe the KsCD CD player since it’s the default
application launched by KDE when you insert an audio CD.

Figure 12-9. KsCD’s Main Window

You can access this application through the Multimedia→Sound→KsCD sub-menu.

The buttons on the left are typical CD player ones, such as Play, Stop, Eject, etc. The ones below (Random and
Loop) are also self-explanatory. The CDDB button gives you info on the disk you are listening to (artist, title,
song names, etc.). The Extras button enables you to Configure KsCD, Configure Shortcuts, and more.

12.1.3. Using Aumix

Aumix is a very small yet useful application which allows you to control your sound card’s mixer and volume.

As a matter of fact, you might not be able to hear any sound from XMMS or KsCD. Adjusting Aumix will
usually solve that problem.

To launch the sound mixer application, select Multimedia→Sound→AuMix.

Figure 12-10. Aumix Application

First, let us take a look at the File menu.

12.1.3.1. File Menu

This menu lets you access the basic functions that allow you to load or save mixer settings. The available menu
items are:

Load

Loads the default mixer level setting.
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Save

Saves your new mixer level settings.

Load From

Allows you to load mixer settings from another file than the default one.

Save To

Enables you to save settings in a file other than the default one.

Quit

Quits the application.

When you launch Aumix, it loads the last configuration file you
used. So, if you used ~/My_aumixrc the last time you opened Au-
mix, this file will be used. However, if you click on the Load sub-
menu, it will automatically load the default ~/.aumixrc file.

12.1.3.2. View and Mute Menus

The View menu allows you to choose which components will be shown in the Aumix window. For instance, if
you never use a microphone, you may choose not to view that entry. Clicking in the check-box next to Mic in
the View pull-down menu would add or delete the Mic choice from the list. The Mute menu lets you completely
mute the sound.

12.2. Movie Applications

This section will discuss movie players available with Mandrakelinux. It will introduce the best applications,
hint at the problems you could face while using them, and suggest resources to get the best out of them.

12.2.1. Introduction

The main problem with video players under GNU/Linux is that most popular video codecs are proprietary, and
to implement them in a free software application (mainly due to the cost of licensing), the codecs have to be
reverse-engineered. This is very complex and may not be legal in some countries, which limits the availability
of such codecs, and thus the type of video files which may be reproduced under GNU/Linux.

For example, it will be virtually impossible to play some compressed digital video files or DVDs without
downloading the corresponding codecs from the Internet.

In some countries, the status of the DVD playback and reverse-
engineered codecs is still under review. That is why Mandrakesoft
does not include all the plugins to use those codecs3. The informa-
tion included here is meant to help Mandrakelinux users who know
that, in their country, using these is legal. Mandrakesoft does not
encourage law violation and you should verify the law(s) that
apply in your case, before you download these codecs and plu-
gins.
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12.2.2. Xine

This is one of the most interesting video application for GNU/Linux. It supports a wide range of formats and
input sources. It is fast, flexible and extensible. The last version is quite stable and able to support all popular
formats.

Make sure the xine-ui package is installed (refer to “Rpmdrake: Package Management”, page 173 for more
information on packages installation). To launch Xine, simply select the Multimedia+Video→Xine item of the
main menu. You can also run Xine from a terminal. Type xine --help to see all available options.

The 1st time Xine is invoked, its configuration dialog window will be opened in the foreground and will be
waiting for you to accept the suggested settings or to change them to your liking. Make your choices and click
on the OK button. The window that is empty apart from the application name and the URL of its web site, will
be used for actual movie playing. Unless, of course, you decide to use full-screen playback mode.

The other one is the application’s main window, containing all the controls. Its interface can be modified by
selecting different skins. Here we will refer to the default skin, as shown in figure 12-11.

Figure 12-11. Xine’s Control Window

If the meaning of one of the buttons is not immediately clear, leave the mouse pointer over it for a second or
two, and you will see a nice help balloon explaining the button’s function. The interface itself is very similar to
that of a CD player, so many of the controls should be self-explanatory. To watch a DVD (unencrypted only) or
VCD disk, insert the medium in the drive, click on the DVD or VCD button, then on the Play button. To choose
a file, click on the MRL Browser button (the one labelled ://, located at the lower left corner, just above the
Quit button) to open a window which will let you navigate the directory tree and choose the desired file.

To move the control window, click on it with the left mouse button and, keeping it pressed, move the mouse
pointer. When in full-screen mode, you will be able to hide and recall the control window by simply clicking
once with the right mouse button and removing (to hide) or adding (to show) the mark from the GUI visibi-
lity menu entry, a very handy feature when you do not want the control window to “interfere” with movie
playback.

12.2.3. MPlayer

MPlayer is yet another interesting application and supports multiple output drivers, and even old video cards.
It also supports DVD, AVI, VideoCD, amongst others. You will probably have to download and install winDLLs
and proprietary codecs to make it work with many popular video formats. On one hand this might seem
unfortunate, but on the other it gives you access to all formats supported under Windows.

Install the mplayer-gui package (refer to “Rpmdrake: Package Management”, page 173 for more information on
package installation). Then, choose Multimedia+Video→MPlayer to launch MPlayer.

The interface is very similar to that of Xine (see figure 12-12), unless you opt for some of the more “exotic”
skins. It is less user-friendly, however, lacking some of the features that are expected from modern software
(such as help balloons for all the buttons), but fortunately the pop-up menu is very easy to access and use: just
right click anywhere on MPlayer’s interface and you will be able to choose the most important options.

Figure 12-12. MPlayer’s Control Window

102



Chapter 12. Audio, Movie and Video Applications

You can easily switch to and from full-screen playback mode pressing the F key over MPlayer’s video output
window. When in full-screen playback mode, the main window can be hidden by simply moving the mouse
over it and then out of it; clicking on the screen will bring the main window back.

To watch a movie, either a file or a DVD/VCD disk, choose the appropriate medium in the pop-up menu, e.g.
Open→Play VCD ...: it will start immediately. Use the VCR buttons to suspend, resume, fast forward or rewind
the video playing.

Do not forget to check MPlayer’s web site (http://www.mplayerhq.hu/) from time to time. You will be able
to follow its progress and to download new versions, skins, plugins, etc.

12.2.4. Other Movie Applications for Linux

XMovie

This application is tailored to playback high resolution movies such as MPEG1, MPEG2 and AVI files. It is
not really made to playback compressed files such as Quicktime, but does support MPEG2 streams.

Totem

Totem (available in package totem) is a GNOME 2 application based on Xine’s libraries. As you might
imagine, its capabilities are very similar to those of its “parent”, but it is better integrated in the GNOME
environment.

KMPlayer

KMPlayer (that can be downloaded from the KMPlayer web site (http://www.xs4all.nl/~jjvrieze/
kmplayer.html)) is a KDE application based on MPlayer and Xine libraries. Its capabilities are very similar
to those of its “parents”, but it is better integrated in the KDE environment.

Finally, there are other video applications for GNU/Linux such as vlc (http://www.videolan.org/) (an MPEG2
files/streaming video and DVD player), Ogle (http://www.dtek.chalmers.se/~dvd/) (a DVD player which
supports menus and navigation) and RealPlayer (http://www.real.com/) (which is proprietary software). We
encourage you to explore them as they may answer your specific needs.

12.3. CD Burning

In this section we will discuss the usage of K3b to burn:

• a CD from an ISO image;

• a set of files to a CD;

• an audio CD (CDDA);

as well as how to duplicate a CD and erase re-writable media.

K3b also supports DVD recording, but we will concentrate on CD recording here. DVD recording is not very
different from CD recording anyway.

Copyrighted Material. Please note that data/audio CD copying
is often forbidden by copyright law. The examples provided here
are informational only and are not intended to make a CD pirate
out of you. It is assumed that if you want to duplicate copyrighted
material, it is because you have the right to do so.
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12.3.1. Getting Started

DrakX or HardDrake should have already configured your CD-R(W) drive properly, we will show you how to
put it to use.

Usually, you need root privileges to access the CD burner. With K3b this is not true anymore since it is auto-
matically configured at installation time to give non-privileged users access to the CD burner. However, it is
highly recommended that non-privileged users wanting to burn CDs be part of the cdwriter group in order
to try to minimize burning errors due to an overloaded system. So, go ahead and add those users to the cdw-
riter group. Please refer to UserDrake: Managing Users and Groups on your System, page 164, for information
on users and group management.

Choosing System+Archiving+Cd burning→K3b from the main menu will start K3b. figure 12-13 shows K3b’s
interface with a new data project open.

If you get a message stating that cdrdao does not run with root
privileges or that cdrdao has problems with ATAPI writers, you
can safely ignore it. To prevent that message from appearing again
put a mark on the Don’t show again check-box and click on the
Close button.

The first time K3b is run, or if you change the CD-R(W) drive, a
dialog will pop up asking you for confirmation about the burner’s
speed. Set the speed to match the fastest speed of your burner and
click on the OK button.

Figure 12-13. K3b’s Interface

Tool-Bar. Where buttons to perform common actions lie. See table 12-1.

File Manager. To choose which files will be part of the burned CD. You can use the left-side tree to navigate
your file system structure and also the browser-like buttons at the bottom. The Filter pull-down list is handy
for selecting which file types are going to be shown in the File Manager. Drag the files you want to include in
the project and drop them into the Project Manager.

Project Manager. Where all files which will be part of the burned CD are shown and handled. Files can be
removed and their location (directory) on the CD can be changed here.

The following table shows the most important buttons available in K3b’s tool-bar, their equivalent keyboard
shortcuts and a brief explanation of the functions they provide.
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Not all buttons might be enabled at all times. For example, the
Burn CD button will not be enabled if there is no active project.

Button Keyboard
Shortcut

Function

Create a New Project. Once you click on this button a list of available
project types will be shown: choose New Audio CD Project to create an
audio CD (see Burning Audio CDs (CDDA), page 108); choose New Data
CD Project to create a data CD (see Burning Data CDs (CD-ROMs), page
105); choose New Mixed Mode CD Project to create a mixed mode
(data+audio) CD; choose New Video CD Project to create a digital
compressed video CD; choose New eMovix CD Project to create an
eMovix (http://movix.sourceforge.net) CD.

Ctrl-O

Open an Existing Project. A standard file dialog will be opened from
where you can choose the existing project you wish to open. By default,
only K3b’s project files (*.k3b) are shown. Select the project you are
interested in and click on the OK button.

Ctrl-S
Save the Current Project. A standard file dialog will be opened where

you can enter the name under which the current project will be saved.
Type the name of the project and click on the Save button.

Ctrl-B
Burn the Current Project to a CD. It opens a window which asks for the
project’s burn settings. Please refer to Burning Data CDs (CD-ROMs),
page 105, for more information.

Copy a CD. To make an exact copy of a CD. It opens a window which
asks for the copy settings. Please refer to Duplicating a CD, page 109, for
more information.

Erase a CD-RW. To erase re-writable media. It opens a window which
asks for the erase operation settings. Please refer to Erasing CD-RW
media, page 110, for more information.

Table 12-1. K3b’s Toolbar Buttons

12.3.2. Burning Data CDs (CD-ROMs)

12.3.2.1. Burning From an ISO Image

Let us assume you have downloaded a CD-ROM image from the Internet and you want to burn it on a CD.
Choose Tools+CD→Burn CD Image... from K3b’s menu. Click on the “open file” button to browse for the CD
image file and select the file in the standard open file dialog. The CD image will be verified and information
about it will be displayed (see figure 12-14).
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Figure 12-14. Burn CD Image Options

Once the image is verified, you can insert the recordable medium and click on the Start button to write it to
the disc.

If an already written re-writable medium is found in the CD burner,
a dialog will pop-up asking you whether to erase it first. Click Yes
and follow subsequent instructions if you want to erase it, or change
the medium for a non-written one and click No.

The Speed pull-down list should be set to Auto to make K3b select
the fastest possible recording speed supported by the the combi-
nation of your CD burner and the currently inserted recordable
medium. The“slowest”of them limits that maximum speed.

12.3.2.2. Burning a Set of Files or Directories

Choose File→New Project→New Data CD Project from K3b’s menu (or use the New Project button or keyboard
shortcut shown in table 12-1). Then drop, in the Project Manager, the files and/or directories to be included
on the CD (see figure 12-15).
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Figure 12-15. Selecting Files/Directories to Include on the CD

Adding directories containing lots of files, can take some time, plea-
se be patient and wait until the Adding files to Project PRO-

JECT_NAME... message disappears from K3b’s status bar.

The space occupied by the selected files/directories will be shown by a color-coded bar at the bottom of the
Project Manager, together with the quantity expressed in MB and the available MB of the medium’s total
capacity. The bar’s color codes are as follows:

Green

The set’s size is less than that of the selected medium’s capacity (700 MB by default). There are no capacity-
related problems.

Yellow

The set’s size is nearly equal the selected medium’s capacity. If it is a few MB below the medium’s capacity,
there will be no capacity-related problems; if it is a few MB above the medium’s capacity, the CD might
be written without problems, but there is little guarantee of success.

Red

The set’s size exceeds the medium’s capacity by lots of MB. The CD will not be recorded properly.

Right-clicking on any file/directory in the Project Manager will pop-up a contextual menu with options to
remove and rename files, create new (empty) directories, etc. Files and directories can be relocated (change the
directory under which they will appear) on the CD using drag-and-drop.

Renaming the top element of the left side tree in the Project Ma-
nager will change the CD’s volume name (K3b data project by
default for data CDs).

Clicking on the Burn CD button (or choosing the Project→Burn menu entry) will display a window where you
can select writing parameters (see figure 12-16). Insert a recordable medium on the CD burner and then click
on the Write button to start writing the CD.
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Figure 12-16. Setting Writing Parameters

12.3.3. Burning Audio CDs (CDDA)

CD recording is not limited to data CDs, you can also record audio CDs. By audio CDs, we mean CDs that
you can play in your car or home stereo equipment, not data CDs with OGG, MP3 or any other digital audio
format files on them.

At the time of writing, K3b supports recording audio CDs from tracks digitized in the wave (*.wav), Ogg
Vorbis (*.ogg) and MP3 (*.mp3) formats. You can mix digital audio formats, K3b will decompress the com-
pressed ones on the fly. K3b can also create digital audio tracks starting from audio CDs: this task is known as
“ripping” (see Audio CD Extraction (Ripping), page 110).

Choose File→New Project→New Audio CD Project from K3b’s menu (or use the New Project button shown in
table 12-1). Select K3b’s File Manager’s filter to Sound Files, navigate to where the digitized audio files are and
then drag the audio tracks and drop them in the Project Manager (see figure 12-17).

108



Chapter 12. Audio, Movie and Video Applications

Figure 12-17. Selecting Audio Tracks to Include on the CD

Use drag and drop to move the files up and down the compilation. Once you have the tracks compiled in the
order you want in the Project Manager, proceed as described in Burning a Set of Files or Directories, page 106, to
write them to CD.

12.3.4. Duplicating a CD

Figure 12-18. Setting Copy CD Options

Choose Tools+CD→Copy CD from the menu (or use the button shown in table 12-1) and a dialog will pop up
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(see figure 12-18). Select the number of copies (1 in the example), whether to remove the temporary image or
not (yes in the example), the reader and burning devices (automatically set) and click on the Start button to
start duplicating the CD. The “source” CD will be read, an image of it will be made and then the “target” CD
will be written.

12.3.5. Audio CD Extraction (Ripping)

The cdparanoia package must be installed to be able to rip audio CDs. Please refer to “Rpmdrake: Package
Management”, page 173 for information on package installation. Also, make sure that enough temporary space
is available: you can check the available space in K3b’s status bar near the right.

Insert the audio CD to rip tracks from and double click on the drive in K3b’s File Manager left side tree. The
CD will be read and, by default, all tracks will be marked to be ripped. Remove the check mark from the ones

you do not want to rip and click on gears button to show a dialog to set ripping options (see figure
12-19).

Figure 12-19. CD Ripping Options

Remove the checkmark from the Use filename pattern for ripped files option to have tracks named TrackNN.
wav and stored in the directory specified in the Destination Base Directory field (your home directory, by default)
and click on the Start Ripping button to start ripping.
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12.3.6. Erasing CD-RW media

Figure 12-20. Setting CD-RW Blanking Options

You might want to format your CD-RW media in order to write it with different data. To do so, choose
Tools+CD→Erase CD-RW... from the menu (or use the button shown in table 12-1) and a dialog will pop up (see
figure 12-20). The Erase Type can be set to Fast (the CD-RW is quickly erased in up to 3 minutes); Complete (the
CD-RW is completely erased taking up to 90 minutes); and a few options related to multi-session recording.
Insert the medium on the CD burner and click on the Start button to erase the CD-RW.

12.3.7. Going Further

As you can see, CD recording with Mandrakelinux is well supported with graphical programs. This section is
a kind of mini-HOWTO of CD recording for the most common tasks you might want to do. However, CD
recording uses are not limited to things described here. Please refer to the FAQ on the K3b web site (http:
//k3b.sourceforge.net) for more information.
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Chapter 13. Introduction to the Mandrakelinux Control Center

13.1. What is in DrakConf

Mandrakelinux Control Center is Mandrakelinux’s main configuration tool. It enables the system administrator
to configure the hardware and the services used for all users. The tools accessible through the Mandrakelinux
Control Center greatly simplify the use of the system, particularly by avoiding the use of the “evil” command
line.

You will find this icon in the “Welcome” screen. You can also access the Mandrakelinux Control Center
through the main menu (System+Configuration →Configure your computer).

Mandrakelinux Control Center is also available from the command
line in text mode by running drakconf.

Figure 13-1. The Control Center’s Main Window

We will detail some of the available menu entries:

• Options→Display Logs. When activated this option displays a Tools Logs window. It displays all system
modifications made by the configuration tools launched from within the Mandrakelinux Control Center.

• Help→Help. This will open the help browser which will display documentation about that particular confi-
guration tool.

• Help→Report Bug. A window will pop up allowing you to report a bug to the development team. See The
Drakbug Reporting Tool, page 114.

The tools are sorted into categories. The following table lists all the tools it contains as well as references to the
corresponding sections of this manual.
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Boot Configuring the Login Mode, page 117

DrakBoot: Changing your Boot-Up Configuration, page 117

Customizing your Boot Theme, page 118

Hardware HardDrake: Configuring your Hardware, page 121

Controlling the Graphical Configuration, page 123

KeyboardDrake: Changing your Keyboard Layout, page 125

MouseDrake: Changing your Mouse, page 125

PrinterDrake: Configuring Printers, page 126

Mount Points DiskDrake: Managing your Hard Drive Partitions, page 135

Managing Removable Devices, page 138

Importing Remote NFS Directories, page 141

Importing Remote SMB Directories, page 139

Setting up WebDAV Mount Points, page 142This is an experimental
utility to mount remote WebDAV directories.

Local Disk Sharing: Allowing Users to Share Folders, page 141

Network & Internet Network and Internet Connection Management, page 145

DrakProxy: a simple tool which allows you to configure any proxies
your computer may need to use to access the Internet.

Internet Connection Sharing, page 148

Security DrakSec: Securing your Machine, page 151

DrakPerm: Control File Permissions, page 152

DrakFirewall: Securing your Internet Access, page 154

System MenuDrake: Customizing your Menus, page 157

Display manager chooser: DrakeDM enables you to choose the X11
Display Manager to be used by users who graphically log onto the
machine. Basically, all display managers offer the same features, it is
just a question of taste.

DrakXServices: Configuring Start-Up Services, page 160

DrakFont: Managing Available Fonts on your System, page 161

Setting your Machine’s Date and Time, page 162

LogDrake: Searching through the Log Files, page 163

Console: Simply opens a terminal to directly enter commands with the
manager account (root).

UserDrake: Managing Users and Groups on your System, page 164

DrakBackup: Backing-Up and Restore your Files, page 166

Software Management “Rpmdrake: Package Management”, page 173

Table 13-1. Overview of Graphical Tools

Another category, Server Wizards, appears if the drakwizard pac-
kage is installed. The documentation for those wizards is available
on-disk or in the Server Administration Guide. It contains wizards
for the basic configuration of common LAN services, as well as web
and FTP servers.

13.2. The Drakbug Reporting Tool
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If you find unexpected behavior in Mandrakelinux-specific tools, Drakbug allows you to report them to the
development team.

To be able to report bugs using Drakbug, you need to have a
working Internet connection as well as a Drakbug account (http:
//bugs.mandrakelinux.com/newuser.php).

To run Drakbug, go to the Help→Report Bug menu entry of the faulty tool, or run it from Mandrakelinux Control
Center’s own menu. Drakbug can also be triggered automatically by a crashed Mandrakelinux tool.

Figure 13-2. Reporting a Bug with Drakbug

Check that all the information you entered is accurate and click on the Report button. Your web browser
will then open. If you are not logged in to the Anthill Drakbug web site (http://bugs.mandrakelinux.com/
drakbug.php?request=1) you will be asked to log in (or create an account if you do not have one). Once you
are logged on the site, upload the /tmp/drakbug.report file and click on Upload Report. If all went well, you
just sent a bug report to the Mandrakelinux team.
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14.1. Configuring the Login Mode

This tool allows you to control the way users log onto your machine.

Figure 14-1. Choosing the Login Mode

There are two methods:

1. Graphical interface: if you wish to see the X-Window (graphical display) system started at boot time, check
the Launch the graphical environment when your system starts box. If you leave it unchecked, the text login
will be displayed.

2. Autologin: if you’re the only one to use your machine and nobody else has access to it, you may choose
to be automatically logged in at boot time. If you wish that, check Yes, I want to autologin with this (user,
desktop). Then choose the user who will be logged on automatically in the Default user pull-down menu,
and the preferred Default desktop in the other pull-down menu.

14.2. DrakBoot: Changing your Boot-Up Configuration

This tool allows you to configure the bootloader and the boot menu entries.
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Figure 14-2. Choosing the Boot Mode

14.2.1. Configuring the Bootloader

You can choose between two bootloaders: GRUB and LILO. For the latter you can either choose a text or a
graphical menu. Either one will allow you to boot Mandrakelinux, it’s just a question of taste.

Unless you know what you’re doing, you should not change the default Boot device shown, since that is where
the bootloader installs itself. The next field allows you to set the time (in seconds) before the bootloader starts
the default OS. If you have more than one OS installed onto your machine, it’s a good idea to leave at least 5
seconds so that you can easily select a different menu item, if needed.

Unless you really know what you are doing, it is not recommended
that you change these settings as this may prevent you from booting
your machine the next time you try to power it on.

You may need to put a check mark in the two last options (Enable ACPI and Force No APIC) but only if you have
a state-of-the-art machine provided with all the newest “bells and whistles” and are experiencing problems at
system start-up time. Use at your own risk.

14.2.2. Choosing the boot entries

After clicking Next, you are presented with the list of entries which will be available at boot time. You can here
Add, Modify or Remove entries.

It is also possible to make an entry the default one by checking the Default check-box in the Modify dialog.

14.3. Customizing your Boot Theme

The Boot Theme utility enables you to change the default theme as well as a few other options:
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Figure 14-3. DrakBoot Theme Window

• Un-check the Use graphical boot box if you prefer to view a text interface at boot time.

• Un-check the Display theme under console if you want a clean, “traditional” console. This concerns the con-
soles accessible through the Ctrl-Alt-Fn keys.

Please note that there is only one theme available by default. You
can also install the bootsplash-themes package which you will find
on the Supplementary Applications CD. You may also install
themes from the web.

119



Chapter 14. Configuration: “Boot” Section

120



Chapter 15. Configuration: “Hardware”Section

15.1. HardDrake: Configuring your Hardware

15.1.1. Introduction

The HardDrake project has been developed to simplify hardware detection and configuration
under GNU/Linux by providing an easy-to-use interface.

15.1.1.1. Description

HardDrake is a full GUI-based tool which ties many of the tools already included in a GNU/Linux distribution
together. It automates and simplifies the process of installing new hardware. For the most part, HardDrake will
be able to detect most devices.

On one hand, HardDrake is used to display information, and on the other, it can launch configuration tools.
With its easy-to-use interface, you should be able to browse all the hardware your system contains.

HardDrake uses the “ldetect” engine, so if your new hardware is not detected, you may try to upgrade the
ldetect library itself and its hardware database, located in ldetect-lst.

15.1.1.2. Usage

To launch HardDrake, you can start it through:

• the Mandrakelinux Control Center: click on the Hardware icon. And then you need to click again on another
Hardware icon!

• a terminal: type harddrake2 as root. You can also pass parameters to HardDrake through the command line
(type harddrake2 -h to get a list of possible parameters).

• the desktop: go in the main menu. The HardDrake entry is in the System+Configuration+Hardware→HardDrake
sub-menu.

After a wait screen (while device detection goes on), the main HardDrake window will appear (figure 15-1).

On the left, you can see the device tree showing you all of the hardware categories.

For some categories, you will notice an arrow “>” symbol. By clicking on it, the subtree will be expanded and
all detected hardware in this category will be listed.
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Figure 15-1. HardDrake –– Selected Device

By selecting a device, you will see additional information about it in the right frame. You can consult the help
page accessible in the Help→Fields description for more information.

In some cases, you will see a configuration button which allows you to configure the selected device. In figure
15-1, we expanded some parts of the tree and selected a device in one of the categories.

Depending on the device selected, two other buttons may appear:

• Configure module. This pops up a window with all the module device parameters listed. For experts only!

• Run config tool. Launches the Mandrakelinux configuration tool (available through the Mandrakelinux Control
Center) associated with that device.

A special category called Unknown/Others might also show up, containing all currently unknown hardware in
your system as well as known hardware that does not fit into the existing categories (thermal sensors, random
number generators, etc.).

If your hardware is really unknown (no description or no driver even though you know a working driver
exists), you may be able to see your hardware recognized in future versions! To contribute to the effort, report
the displayed information to the harddrake team (mailto:harddrake@mandrakesoft.com) and use the subject
“[Unknown_devices]” in your e-mail.

15.1.2. Problems/Troubleshooting

If your hardware is not recognized or your system freezes, contact the harddrake team (mailto:harddrake@
mandrakesoft.com) and use the subject “[Detect_devices]” in your e-mail.

If you think you have found a bug related to HardDrake (bugs with the user interface), contact the same e-mail
address but use “[harddrake::ui]” as the subject.

ISA PnP devices are not probed for by HardDrake. If you have an ISA PnP sound card, run sndconfig or
alsaconf from the command line. You may need to install the sndconfig package or the alsa-utils package.

15.1.3. Other Information

• If you have a hard time getting your IsaPnP tools working, please check out the IsaPnPTools home page
(http://www.roestock.demon.co.uk/isapnptools) (used by the detect library).
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15.2. Controlling the Graphical Configuration

This set of tools allows you to configure your graphical display. With it you will be able to change your
video card, your resolution and your monitor. It can be useful if you happen to change one of your graphical
components after the initial installation.

If you cannot boot into graphical mode and you end up in a console
(command-line interface), log in as root and launch the XFdrake

command. You will get the same tool and functions as described in
this section but in text mode.

15.2.1. Configuring your Graphical Display

XFdrake contains 3 main configuration fields as well as a Test and Options field. Let’s look at the interface.

Figure 15-2. XFdrake’s Main Window

The first three fields allow you to change certain aspects of the graphical configuration:

• Graphic Card. The button displays the name of the graphic card currently configured. If you wish to change
it, just click on it. Depending on your card, different servers may be available, with or without 3D accelera-
tion. You may need to try different ones until you get the best result.

• Monitor. Click on this button if you wish to change your current monitor. A window will pop up listing
many monitor models. Choose the appropriate one. If you do not find your monitor, choose one with para-
meters corresponding to your own monitor from the Generic entry
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Figure 15-3. Choosing a New Monitor

• Resolution. Clicking on this button will launch this tool (figure 15-4). It enables you to change the pixel re-
solution (800x600, 1024x768, etc.) and the color depth. Simply choose the one you wish to use. The monitor
in the window displays what the desktop will look like with the chosen configuration. If it looks good, click
on the OK button.

Figure 15-4. Changing your Screen’s Resolution

Then, there are three more buttons:

• Test. Click on this button to verify that your modifications actually work. It is highly recommended you do
test it, because if it does not work, it will be harder later to recover a working graphical environment. If the
test fails, or if you are not satisfied with the proposed settings, choose No during the test, and you will be
returned to XFdrake’s main menu.

Depending on your video card, video testing may not be available.
You will then be warned of such a situation. If it happens that
the settings are incorrect and your display does not work, refer to
“Troubleshooting”, page 181 to use XFdrake’s text version.
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• Options. You can start the graphical server at boot time or not. Answer No if you prefer to have a text login
at boot time. Selecting Yes will launch the graphical login manager at boot time.

• Quit. If you have modified your graphical display in some way, the current configuration will be displayed
and XFdrake will ask you whether you want to keep your changes or not. This is your last chance to go back
to the old configuration. If all seems OK, click on Yes. If you wish to restore old parameters, click on No.

The changes will be activated after you quit and restart your graphical environment.

15.3. KeyboardDrake: Changing your Keyboard Layout

The following window (figure 15-5) allows you to define another keyboard layout. This is com-
monly done when the keyboard you want to use is different from the one you chose at insta-
llation time.

Figure 15-5. Choosing a Different Keyboard Layout

Changes are effective immediately after clicking OK.

If you choose a keyboard layout based on a non-Latin alphabet,
the next dialog will ask you to choose the key binding that will
switch the keyboard configuration between the Latin and non-Latin
layouts.

15.4. MouseDrake: Changing your Mouse

The following window (figure 15-6) allows you to set up a different mouse, which is useful if
the mouse you are currently using is not the same as the one you chose during installation.
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Figure 15-6. Choosing a Different Mouse

Mice are sorted into a tree according to their connection type and model. Highlight the mouse of your choice
and click Ok.

Changes take effect immediately.

15.5. PrinterDrake: Configuring Printers

This tool allows you to configure a newly installed printer on your machine, or to configu-
re your machine to act as a server for a printer which has just been connected to your local
network.

If you have just installed a printer that was not available when you installed Mandrakelinux, make sure it is
correctly connected and powered on. When launching the PrinterDrake tool, the new printer will be automati-
cally installed and configured, and when completed you will see the tool described below (figure 15-7), which
shows your local printer as it is configured at the present time. You may modify or correct this configura-
tion, or configure printers which were not auto-detected. If your machine is in a local network, you may also
configure network printers or printer sharing.
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Figure 15-7. Managing Printers

If your printer has been automatically added you should now verify
its configuration. Select it in the list, click the Edit button and
check the Printer options.

The printer configuration tool (figure 15-7) has two tabs. The first one for locally connected printers (Configured
on this machine), the other one for printers available on the local network (Configured on other machines). Then
six buttons at the top give access to all the available maintenance tasks:

• Add printer: launches the printer configuration wizard described below.

• Set as default: sets the selected printer as the default printer when no specific printer is chosen at printing
time. A cross appears in the Def. column of that printer.

• Edit: opens the printer configuration dialog (see Reconfiguring an Existing Printer, page 131).

• Delete: removes the selected printer from the available printer pool.

• Refresh: updates the printers list with possible new or removed printers, especially for networked printers.

• Configure CUPS: (if a local network exists) by default, your system will be totally open. It will use all of the
network’s available printers and share all of its local printers with the local network. Click this button if you
do not want to access network printers, or if you want to restrict access to your local printers. This dialog
will also let you configure the access to servers outside the local network.

The Options→Expert mode menu check-box will add extra features
to the tool. See Expert Mode, page 132.

15.5.1. The Printer Configuration Wizard

Click the Add printer button and the configuration wizard will come up. To go from one step to another, click
on OK or Next ->. Use Cancel to abort the installation.
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Figure 15-8. Auto-Detecting Printers

The first screen allows you to enable the auto-detection of locally connected printers, network printers, and
finally printers served by SMB (windows) servers. First try to activate auto-detection for the printer types you
are looking for. The next step will show which printer(s) was/were detected. If the one you want to set up is
listed, select it, click on OK, confirm the printer model, and go to figure 15-14. If the detected printer is not the
correct one check the Manual configuration box and go to figure 15-11. If auto-detection fails, remove the check
mark from all check boxes, click on Next and follow the instructions below.

Figure 15-9. The Printer Port

First, you need determine which port your printer is connected to: either a parallel or a USB port.
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Figure 15-10. Multi-Function Device

You will then be asked whether your printer is a multi-function device from HP or Sony. If so, additional
packages will be installed on your system and you will be told how to scan and access photo memory cards
with your device.

Figure 15-11. Choosing a Name for your Printer

You then need to provide a name for your printer to easily identify it. Optionally, you can also supply a Printer
description and a physical Location (figure 15-11).
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Figure 15-12. Choosing the Printer Model

In the next step you will see the list of supported printers. It is a tree view with the manufacturer’s name first
and then the printer’s model. Select the printer you have or a compatible one (figure 15-12) if yours is not
specifically listed.

If you want to install the driver supplied by your printer’s manufacturer, click on the Install a manufacturer-
supplied PPD file button and select the medium containing the PPD file and browse to it. Accept subsequent
dialogs to use your chosen PPD file.

Figure 15-13. Configuring the Printer’s Options

After that, the options associated with the chosen printer will be shown (figure 15-13). It is important you
choose the proper settings (such as paper size, media source, etc.) currently installed on the printer. If the
settings you choose are not correct, printing may fail to work.
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For settings referring to printout quality, bear in mind that higher
quality levels may make the printing operation slower, and may also
consume more ink.

If you already have one or more configured printers, you will be
asked whether the printer you are configuring will be the default
printer for applications on your system. If you say No, the previous
default printer will be retained.

Figure 15-14. Test the Printer

Finally, you will be asked whether or not you want to test the printer. Two test pages are available (figure
15-14) so you can adjust the parameters according to your needs. It is advisable to print at least one test page
so you can immediately correct the parameters if something goes wrong. The printer should begin to print
almost immediately.

Congratulations, you are ready to print! If you’re not satisfied with your test page, answer the appropriate
question with No and you are lead to the printer configuration menu (figure 15-15) in order to correct the
settings. See the Reconfiguring an Existing Printer, page 131 section.

Your printer will now appear in the list of available printers in the main window (figure 15-7).

15.5.2. Reconfiguring an Existing Printer

Double-clicking on a printer’s name in the list, or clicking on the Edit button, displays a menu where you can
choose actions to take on the selected printer, as shown in figure 15-15. Each option gives access to a particular
step of the wizard we described above (The Printer Configuration Wizard, page 127) during our example of how
to configure a new printer. One difference will be that the current settings will be predefined in all fields, and
you may update them where required.
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Figure 15-15. Modifying an Existing Printer

There are two additional options:

1. Learn how to use this printer. Displays information on how to use a particular model of printer. In the case
of a multi-function device from HP, information about scanning and photo memory card access is also
displayed.

2. Remove printer. Use this option to delete that printer’s configuration from the system.

Select an option in the dialog and then click on Do it!.

15.5.3. Expert Mode

The expert mode (activated by selecting Options→Expert mode from the menu) basically has three additional
features:

• Choose a Different Driver to the Default One for a Printer. Generally speaking, there are different drivers
available for the same printer. In expert mode, a third level appears in the printer model selection list (figure
15-12) which allows you to change the driver for each printer.

• Install Many Kinds of Remote Printers. This feature allows you to print on remote printers using the LPD
protocol, printers on Windows servers which require a login, or other arbitrary printer types.

If PrinterDrake is in expert mode, it does not automatically confi-
gure new local printers on startup. Use the Add printer button to
configure the printer.

If you start the new printer wizard in expert mode, there is an additional step at the beginning.
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Figure 15-16. Configuring a Remote Printer

Five different connection types are available:

• Local printer. A printer directly connected to a parallel or USB port on your computer. In most cases, the
printer model will be auto-detected.

• Printer on remote lpd server. A printer already served by another machine on a lpd server.

• Network printer (TCP/socket). A printer directly connected to your local network. The network can be scan-
ned and printer models automatically detected provided the Printer auto-detection box is checked.

• Printer on SMB/Windows 95/98/NT server. Relevant for printers already connected to a computer running
an OS which serves printers with the SMB protocol, including Samba printers (the necessary Samba compo-
nents will be automatically installed in this case). The network can be scanned provided the Printer auto-
detection box is checked. However, the printer model will have to be entered manually.

• Enter a printer device URI. This option allows you to directly enter the printer’s Universal Resource Identifier
(URI) on your network. It can be used for any of the above remote connections and more. This is useful
when your system administrator provides you directly with the printer’s URI.
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16.1. DiskDrake: Managing your Hard Drive Partitions

Please refer to the Reference Manual to learn what partitions are used for. Partitions are initially
set up during the installation process. DiskDrake allows you, to some extent, to resize your
partitions, move them, etc. DiskDrake can also deal with RAID devices and supports LVM but
we will not discuss these advanced uses here.

DiskDrake is very powerful and can therefore be a dangerous tool.
Misuse of it can very easily lead to data loss on your hard drive.
Because of this potential loss of data, you are strongly advised to
take some protective measures before using DiskDrake:

1. Back up your data. Transfer it to another computer, ZIP
disks, etc.

2. Save your current partition table (the table describing
the partitions held on your hard drive(s)) to a floppy disk
(see DiskDrake’s action buttons, page 136).

16.1.1. The Interface

Figure 16-1. DiskDrake’s Main Window

DiskDrake enables you to configure each physical hard drive on the machine. If you only have one IDE disk,
you will see a single tab called hda below the file-system types. If there is more than one drive, then each drive
will have its own tab and will be named according to the Linux name for that drive. DiskDrake will allow you
to manage the partitioning of each drive.

The window (figure 16-1) is divided into four zones:
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• Top. The structure of your hard drive. When you launch DiskDrake it will display the current structure of
the drive. DiskDrake will update the display as you make changes.

• Left. A menu relevant to the partition currently selected in the above diagram.

• Right. A description of the selected partition.

• Bottom. Buttons for making general actions. See next section.

We will now review the actions available through the buttons at the bottom at the window, and then see a
practical use case.

16.1.2. DiskDrake’s action buttons

Clear all

Clicking on this button will clear all partitions on the current hard drive.

More

Display a three button dialog allowing you to:

Save partition table

Allows you to save the current partition table to a file on a disk (a floppy, for example). This may
prove useful if a problem arises (such as an error made during drive repartitioning).

Restore partition table

Allows you to restore the partition table as previously saved with Save partition table. Restoring a par-
tition table may recover your data as long as you do not reformat partitions, because the formatting
process will overwrite all your data.

Rescue partition table

If you lose your partition table and have no backup, this function tries to scan your hard drive to
reconstruct the partition table.

Help

Display this documentation in a browser window.

Undo

Cancels last action. Most modifications done on your partitions are not made permanent until DiskDrake
warns you it will write the partition table. This button therefore allows you to undo all of your modifica-
tions on partitions up to last write.

Toggle to expert mode

This button allows you to access the expert mode functions (which are even more dangerous if you are
not sure what you are doing). Reserved for experts.

Done

Saves your changes and exits DiskDrake.
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16.1.3. From Theory to Practice: Resizing an Old Partition and Creating a New One

In this section, we are going to do a little exercise to demonstrate one of the more useful features of DiskDrake.
Let us imagine that you decide to use your machine as an FTP server and you want to create a separate
/var/ftp partition in order to host the FTP files. Note that doing this step by step tutorial will actually
modify the structure of your hard drive.

This is what the current /home partition looks like (figure 16-2), before any modification. We are going to shrink
this partition in order to create free space for the new file system.

In order to perform the steps in this example, all users of your
system must be logged out, except root.

First of all, you need to unmount the /home partition by clicking on it and then pressing the unmount button.

Figure 16-2. The /home Partition Before Resizing

The next step, as you may have guessed, is to click on the Resize button. A dialog will appear (figure 16-3)
which will allow you to choose the new size for the /home partition. Move the slider, then click on OK.

Figure 16-3. Choosing a New Size

When this is done, you will notice that the graphic representation of your hard drive has changed. The
/home partition is smaller, and an empty space appears on the right. Click on the empty space and then on
the Create button which appears. A dialog (figure 16-4) will appear to let you choose the parameters for the
new partition. Set the size, choose the file-system you want (usually Journalized FS: ext3) and then enter
the mount point for the partition, which in our example will be /var/ftp.
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Figure 16-4. Defining the New Partition

This is what our projected partition table now looks like (figure 16-5).

Figure 16-5. The New Partition Table

The last step is to format (prepare to host files) the newly created partition. To format the partition, click on its
representation in the partitions picture, then on the Format button. Confirm the writing of the partition table to
disk and the formatting of the partition. You may be asked to reboot the computer to make changes effective.

Figure 16-6. Confirming the Writing of the Partition Table

16.2. Managing Removable Devices

This tool allows the system administrator to easily control most options which affect the beha-
vior of removable devices such as floppy, CD and DVD disks. It is available through a different
icon for each removable device on your machine.
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Figure 16-7. Changing a Criterion

For each device three properties may be changed:

• Mount point. The directory where the device’s files will be accessible from. You can either choose an entry
in the list or type in your own path. If the directory does not exist, it will automatically be created.

• Options. Controls various device options, notably whether it is mounted automatically (supermount) or not.
Note that if the supermount option is selected, the two others (user and noauto) must be deselected.

• Type. Displays a list of file-system types. If you have a specific media with an uncommon file system on it,
this is where you can tell Linux how to access it.

Select the property you wish to change and click on OK. The corresponding dialog will pop up in which
you can change your setting. Then click on OK again. The system will then ask you if you want to save the
modifications in the /etc/fstab file. By saying yes, you will not have to unmount and re-mount that device.

16.3. Importing Remote SMB Directories

File sharing between various machines has been available for a long time on UNIX systems. All
system users may now take advantage of file sharing. Sharing data between two users on two
different machines is made in three simple steps:

1. Admin authorizes sharing: Local Disk Sharing: Allowing Users to Share Folders, page 141.

2. Users share directories: see File Sharing, page 88.

3. Users browse remotely shared directories: see File Sharing, page 88.

This tool allows the system administrator to import remote shared directories on the local machine. It affects
shares based on the SMB protocol, used mainly by Windows OSes.

While users can individually access remote shares through their file managers, it may be interesting in some
cases to import a specific share for it to become available at once for all users. We’ll go through an example
showing how to import a template directory from a Windows machine.
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Figure 16-8. Scanning the Whole Network

Clicking on the Search servers button scans the local network for machines which currently share directories
(including the local one). In our example, many servers are available. We’ll choose skywalker and we’ll make
it available locally for all users.

Clicking on a machine’s name will try to connect to it and browse available shares. If those shares are
password-protected, a dialog will pop up asking you to identify yourself.

Figure 16-9. Authenticating on a Remote Samba Server

Enter the correct Username, Password and Domain. The available shares on that machine will then appear. Click
on the little arrow on the left of the server icon to show available shares.

If the machine you’re connecting to has public shares, then cance-
ling the password entry dialog will connect you to that machine,
but only to those public shares.

Figure 16-10. Choosing the Remote Directory to Import

Once a share is selected, a Mount point button appears. Clicking on it displays a dialog where you can type the
local directory where remote files will be accessible.

Once this is done, two more buttons appear:

• Mount. Makes the resource available locally. When this is done, users simply have to point their file manager
to the directory selected as mount point to get the files hosted by the server.

• Options. Allows to set a user name and password to access that SMB mount point. Other permissions can
also be set through that button.

Also, the little icon in front of the shared directory becomes
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When you’re finished configuring the access points for remote directories, click on Done. A dialog box will
appear asking you whether you wish to save your modifications to the /etc/fstab file (where mount point
information is usually stored), or not. Click on Yes to make the shares always accessible. Click on No to exit
without saving your changes.

16.4. Importing Remote NFS Directories

This tool is exactly the same as the one mentioned in Importing Remote SMB Directories, page
139, except that it controls file sharing through the NFS protocol rather than SMB. Hence, it
allows local importing of shared files from NFS-friendly machines. The interface is the same
as the one described in Importing Remote SMB Directories, page 139 and the effects are similar.
Only the corresponding machines are different: UNIX for NFS and Windows for SMB.

16.5. Local Disk Sharing: Allowing Users to Share Folders

This feature enables users to share personal files with users on other machines on the same
network on heterogeneous systems such as GNU/Linux and Windows.

The file-sharing configuration is done in two simple steps: determine who can export folders, and then which
protocol will be used. A 3rd step will be required if you select the Custom export option.

Figure 16-11. Controlling Exports

First of all, you must determine who will be able to share folders. Three different options are available:

• No sharing. Prevents users from sharing data with others.

• Allow all users. All users are allowed to share data with others.

• Custom. By choosing this option, only users within the fileshare group will be allowed to share data. If
you choose this option, the fileshare group will be created and, as a 3rd step, you will be prompted to run
UserDrake in order to add the allowed users to this group (see UserDrake: Managing Users and Groups on your
System, page 164).
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Figure 16-12. Choosing the Export Protocol

Then you must choose which protocol to use for file sharing. Check one or both of the following:

• NFS. If you want your users to share files using UNIX systems (like GNU/Linux);

• SMB. If you want your users to share files using Windows systems.

When you have checked the desired boxes, click on the OK button. The required packages will be installed. If
you uncheck a previously checked box, the corresponding package will be uninstalled.

Once users are allowed to share data, they can select the folders to be shared through their preferred file
manager (see File Sharing, page 88).

16.6. Setting up WebDAV Mount Points

WebDAV (Web-based Distributed Authoring and Versioning) is an extension to the HTTP protocol
which allows you to create, move, copy, and delete resources on a remote web server. In prac-
tice, mounting a remote WebDAV repository on your local machine will allow users to modify
a remote web server’s files simply by modifying files which appear to be local to the local file
system.

Browse the WebDAV Resources (http://www.webdav.org/) pages
to learn more about this protocol.
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Figure 16-13. Managing WebDAV Mounts Points

The first time you launch this tool, only two buttons are available. New allows you to define a new mount
point, the other one just Quits the application. After you have defined mount points, they will appear as new
buttons at the top of the buttons list. Clicking on a mount point button will get you to the mount point menu
(see figure 16-15).

First of all, clicking on New will ask you the URL of the web server (see figure 16-14).

Figure 16-14. Specifying the WebDAV Server URL

Enter the complete URL of the web server, beginning with http:// or https://. Then click OK.

Figure 16-15. WebDAV Menu

You must now decide where the web server files will be accessible from. Select the Mount point option and
click OK. There you will be able to choose a local directory or type in your own.

If the server requires authentication, do not forget to fill the username and password fields in the Options dialog.
Then all you need to do is to actually mount the remote repository by selecting Mount and clicking OK.

You will now be able to browse and modify files on the local mount point you have defined and the changes
will be immediately available on the web server.
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17.1. Network and Internet Connection Management

Before connecting to the Internet, you are encouraged to setup a
firewall on your machine first so as to avoid bad surprises such as
intrusions to your system. You can setup a very simple, yet effective,
firewall using DrakFirewall (please refer to DrakFirewall: Securing
your Internet Access, page 154, for more information).

Your Mandrakelinux system contains a tool which allows easy Internet services configuration. It also helps you
to configure your local network access if any. To launch drakconnect, first open Mandrakelinux Control Center
and click on Network & Internet. Here, five tools allow you to configure and maintain network connections. A
view of the main interface is shown in figure 17-1.

Figure 17-1. Connecting to the Internet

17.1.1. New Connection

drakconnect supports different types of Internet and network connections. The first step consists of choosing
which type of connection you wish to use (see figure 17-2).
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Figure 17-2. Choosing the Internet Connections to Configure

Then a list of detected devices is shown. Choose the one you wish to configure and follow the wizard to its
end. If the device you wish to configure has not been automatically detected, select the Manual choice box.

The example will show how to setup a“traditional”(dial-up) modem
connection. Other connection types are not documented here but
are very similar. Always make sure you have all the information
provided by your ISP or network administrator at hand.

Figure 17-3. Configuring the Network Connection

Fill all required fields with the parameters provided by your Internet Service Provider (see figure 17-3). De-
pending on the connection type chosen, the parameters may differ.

Then come some optional steps depending on the type of connection you are configuring. You will be asked
whether you wish to activate the network connection at boot time.

Finally, the last step asks if you wish to test your network configuration to ensure it actually works. It is
advisable to do so, to be able to correct any errors immediately.

After the configuration is done, you can bring the network connection up or down as described in Monitor
Connections, page 147.
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If you have modified the machine’s host name during configuration,
you should now logout from your session and login again.

17.1.2. Internet Access

Figure 17-4. Configuring the Internet Access

This allows you to specify Internet access parameters if they need to be modified after initial configuration.
These parameters are system wide and apply to all interfaces. If needed, the gateway address may be modified
as described in Manage Connections, page 147.

17.1.3. Manage Connections

Figure 17-5. Manage network connections

This interface allows you to modify interface-specific parameters. Use the drop-down list at the top to select
the interface to be configured. Three tabs allow you to change the TCP/IP parameters, set up some Options,
and display interface Information.
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17.1.4. Monitor Connections

This interface shows the activity of the network interfaces. It can also be used to control the status of the
network connection, bringing it up or down.

17.1.5. Remove a Connection

This tool simply allows you to remove a connection’s configuration parameters.

17.2. Internet Connection Sharing

This tool configures your system so that it acts as a gateway to the Internet for other machines
connected to it via a LAN. In order for your machine to do this, you will need an already
configured and working connection to the Internet and a network connection to your LAN.
This implies at least two interfaces, for example, a modem and an Ethernet card.

This wizard will also configure a firewall to block most connections
from the Internet. You are encouraged to check that the firewall
configuration suits you after completing the wizard.

After you complete this wizard, all computers on the LAN will be able to access the Internet. Their configura-
tion will be automated thanks to the DHCP server that will be installed on your gateway, and the Web access
will be optimized thanks to the use of the squid transparent proxy cache.

1. Choosing the Internet Interface

You first need to specify the name of the interface connected to the Internet. Make sure you select the
correct one: use the examples in the on-line help as a guide.

2. Choosing The LAN Network Adapter

If you have more than one Ethernet interface, the wizard will ask you to choose the one connected to your
LAN. Make sure you select the correct one. Note that all traffic to and from this network passing through
the gateway will be masqueraded.

3. Configuring The LAN Interface

At this point, if the LAN interface has not been previously configured, the wizard will automatically install
and setup all the software needed for the gateway to function properly.

Otherwise, in the situation where your interface has been previously configured, the wizard will offer to
reconfigure the LAN interface so that it will be compatible with the gateway services. It is recommended
that you leave the options at their defaults and click on the Next button.

Configuring the Clients

A DHCP server has been installed on the machine. By configuring the clients on the local network to use
DHCP, they will automatically use the Mandrakelinux machine as a gateway to the Internet. This works for
Windows, GNU/Linux and any other OS that supports DHCP.

For example, on a Mandrakelinux client system, check the DHCP box when configuring the network as shown
in figure 17-6.
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Figure 17-6. Configuring a Client to Use DHCP
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18.1. DrakSec: Securing your Machine

There is a graphical interface to msec called draksec which you can access through Control
Center. It allows you to change your system’s security level and to configure every option of
msec’s security features.

18.1.1. Setting your Security Level

Figure 18-1. Choosing the Security Level of your System

Simply choose the security level you want from the Security Level pull-down list: it will be effective as soon as
you click on the OK button. Please read the help text regarding security levels very carefully so that you know
what setting a specific security level implies for you and your system’s users.

If you wish to check which options are activated for each security
level, review the three other tabs: Network Options, System Options
and Periodic Checks. For each available option, a tool-tip explains
what that option does and what the default setting are. If some of
the default options do not suit your needs, simply redefine them in
each tab. See Customizing a Security Level , page 152 for details.

Put a check mark on the Security Alerts box to send by mail possible security issues found by msec to the local
user name or to the e-mail address defined in the Security Administrator field.

It is highly recommended that you do activate the security alerts
option so that the administrator is immediately informed of possible
security issues. Otherwise, the administrator will have to regularly
check the /var/log/security.log and /var/log/syslog log fi-
les.
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18.1.2. Customizing a Security Level

Clicking on each of the Options tabs (and the Periodic Checks one) will lead you to msec’s list of security options.
This allows you to define your own security level based on the security level previously chosen.

Figure 18-2. Modifying Standard MSEC Options

For each tab, there are two columns:

1. Options List. All available options are listed.

2. Value. For each option1 you can choose from the corresponding pull-down menu:

• Yes. Activate this option no matter what the default value is.

• No. Deactivate this option no matter what the default value is.

• Default. Keep the default security level behavior.

• Ignore. Use this option if you do not wish that test to be performed.

• ALL, LOCAL, NONE. The meaning of these is option-dependent. Please see the corresponding tool-tip
for more information.

The different available buttons are:

• OK. Accepts the current security level with custom options, applies it to the system and exits the application.

• Cancel. Discards changes, keeping the old security level and exits the application.

1. The default security level setting will be shown between parenthesis in a tool-tip.
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18.2. DrakPerm: Control File Permissions

In DrakSec: Securing your Machine, page 151, we have seen how to change your system’s security level and
customize the security checks associated to those levels.

drakperm allows you to customize the permissions that should be associated with each file
and directory in the system: configuration, personal files, applications, etc. If the owners and
permissions listed here do not match the actual permissions of the files in the system, then msec
(which stands for Mandrakelinux Security Tool) will change them during its hourly checks.
Those modifications can help prevent possible security holes or a possible intrusion.

Figure 18-3. Configuring File Permission Checks

The list of files and directories that appears will depend on the current system’s security level as set by msec
and their expected permissions for that security level. For each entry (Path) there is the corresponding owner
(User), owner group (Group) and Permissions. In the drop-down menu at the top of the list, you can choose to
display only msec rules (System settings), your own user-defined rules (Custom settings) or both of them as in
the example shown in figure 18-3.

You cannot edit system rules, as stated by the“Do not enter” sign
on the left. However, you can override them by adding custom rules.

If you wish to add your own rules for specific files, or modify the default behavior, display the Custom settings
list, and click on the Add a rule button.
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Figure 18-4. Adding a File Permissions Rule

Let us imagine your current security level is set to 3 (high). This means that only the owners of the home
directories will be able to browse them. If you wish to share the content of Queen’s home directory with
others, you will need to modify the /home/queen/ directory permissions.

Filling the new rule dialog as seen in figure 18-4 accomplishes this.

If you create more rules, you can change their priorities by moving them up and down the rules list: use the
Up and Down buttons on your custom rules to have more control over your system’s permissions.

When you are satisfied with your settings, do not forget to save your changes by clicking on the OK button.

18.3. DrakFirewall: Securing your Internet Access

This little tool allows you to set up a basic firewall on your machine. It will filter connection
attempts made from the outside, and block unauthorized ones. It is a good idea to run it just
after installing your machine and before connecting to the Internet, thus minimizing the risks
of your machine being cracked.
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Figure 18-5. The DrakFirewall Window

Simply un-check the Everything (no firewall) box, and then check the boxes corresponding to the services you
wish to make available to the outside world. If you wish to authorize a service which is not listed here, click
on the Advanced button to manually enter the port numbers to open.

The Advanced button will open an Other ports field where you can
enter any port to be opened to the outside world. Examples of ports
specifications are presented just above the input field, use them as
a guide. It is possible to specify port ranges by using the : syntax.
Example: 24300:24350/udp

Not checking a service in this list will not prevent you from connecting to it. It will only prevent people from
the Internet connecting to your machine. If you do not plan to host any services on your machine (common
case for a desktop machine) just leave all boxes unchecked.

Then, simply click on OK to activate the firewall and enjoy your secure Internet connection.

If, on the other hand, you wish to disable the firewall and leave all services accessible from the outside, check
Everything (no firewall).
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19.1. MenuDrake: Customizing your Menus

In order to help you manage the main menu of your preferred graphical interface, Mandrakeli-
nux provides you with a menu editor that ensures menus from all desktop environments (like
KDE or GNOME) are coherent.

This tool allows system administrators to control the menus for all users (the system menu) but can also be
used by users to personalize their own menus. You can launch MenuDrake from the Mandrakelinux Control
Center or from the System+Configuration+Other→Menudrake menu entry.

Figure 19-1. Launching MenuDrake in System or User Mode

If started by root, MenuDrake can be used in two different modes: either changing menus for all users, or
customizing the menus for user root. Click on:

• System menu to make changes to menus available for all system users;

• Root menu to customize the menus for the root user only.

When you launch MenuDrake, it first scans your current menu structure and displays it. The main window
(see figure 19-2) is divided in two parts: the menu itself on the left, and on the right a form relative to the
highlighted menu item.

Figure 19-2. MenuDrake’s Main Window

You can click on the [+] signs of the tree to view the content of the related sub-menus, on [-] to hide them.
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In your tree you may see entries which do not appear in your actual
menu. These are empty directories which are not displayed but can
be used for future installed applications.

19.1.1. Adding a New Menu Entry

This should seldom happen as all Mandrakelinux graphical applications should provide a menu entry. However
if you want to add a menu entry for a package you have compiled, or for a console mode program, you may
use this function. Let’s suppose that you want to open a new message window directly within Mozilla through
a menu entry in the Internet menu.

Select the Internet directory, and click on the Add application button on the toolbar. A dialog will appear asking
you for the title of the menu entry and the command associated with it.

Figure 19-3. Adding a New Menu Entry

Edit the title (you could insert “Write a new message”) to be shown in the menu. Then you need to provide
the action to be executed by the system in the Command field: /usr/bin/mozilla -compose. Click on OK and
the entry will be added to the menu tree.

You can also choose an icon for your entry from the list you get by clicking on the icon button itself. The new
entry is shown in figure 19-4.

Figure 19-4. A New Menu Entry with MenuDrake

While modifying your menus, you might make a big mess out of
them... Remember that you can reload the menus as you last saved
them by pressing the Ctrl-R keys (or accessing the File→Reload
user config sub-menu). You can also revert to the default menus by
accessing the File→Reload system menu sub-menu.

158



Chapter 19. Configuration: “System” Section

Finally to activate your modifications, click on the Save button and that’s it. Congratulations! You can now test
your new settings by accessing the main menu.

Depending on the graphical interface you are using, the changes to
your menu may not be shown immediately. In some cases, you may
need to log out and log in again for the changes to take effect.

19.1.2. Advanced Features

19.1.2.1. Different Menu Styles

Depending on the experience the users working with your machine have, you may want to provide them
with different menu styles. Mandrakelinux provides three template menus which you can eventually customize.
Those templates are available through the Menu Style button in the main window.

Figure 19-5. Choosing a Menu Style

Choose one of the available options:

• All applications. This is the traditional menu shipped with Mandrakelinux and it contains nearly all the
available applications, sorted into functional categories.

• What to do? Specifically designed by our ergonomics team, this menu provides a fast access to most com-
mon applications sorted by usage, such as Play a game, Use the Internet, etc.

• Original menu. These are the plain menus as provided by the KDE or GNOME desktops. This menu probably
lacks some applications.

You can activate a sub-menu by checking the Add link to box. Hence you will be able to access the sub-menu
from the main one, thus ensuring all applications remain available.

When you have chosen a menu style and possibly an option, click on OK. You will then be able to see the
corresponding menu structure in the main window, and you can now customize it.
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19.1.2.2. About the Environment Menu

The entry we have just added to the menu is now available in all graphical manager menus. It is also possible
to make modifications to a specific menu by switching the Environment you are working with. For exam-
ple, if you wish to add an application that should be available only in the KDE menu, simply switch from
environment all to environment kde.

All entries which only apply to the active graphical environment appear in blue in the tree structure on the
left.

19.1.2.3. Moving and Removing Entries

MenuDrake entries support the drag-and-drop feature. Similarly, you may have noticed that whenever you
remove an application from the menu, it appears in the “attic”, that is the Available applications list on the
bottom right corner. If you ever wish to add them again, you simply have to drag them to the desired directory.

19.2. DrakXServices: Configuring Start-Up Services

At boot time, a number of services (programs running in background) to perform a variety
of tasks are started. This tool gives the administrator control over those services. See the The
Start-Up Files: init sysv chapter of the Reference Manual for more information.

Figure 19-6. Choosing The Services Available at System Start-Up

For each service, this is the list of items found in each column:

• Service name;

• Current Status: either running or stopped;

• Info: click on this button to get a little explanatory text on that service;
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• On Boot: check this box if you wish this service to be automatically brought up at boot time1. Alternatively,
if the service is a xinetd service the label Start when requested will be displayed. Checking the box will
then mean to activate that service in xinetd. You will also have to make sure that the xinetd service itself is
activated.

• Start: immediately starts the service, or restarts it (stop+start) if it is already running;

• Stop: immediately stops the service.

19.3. DrakFont: Managing Available Fonts on your System

This tool enables you to review the different font families, styles, and sizes available on your
system. It also allows the system administrator to install new fonts from a local Windows insta-
llation, or from other sources.

The main window (see figure 19-7) shows a visual appearance of the currently selected font combination.

Figure 19-7. DrakFont’s Main Window

drakfont is made up of a few windows which are accessible through the buttons located at the bottom-left
corner.

Options

Allows you to specify which applications will support the fonts. Select the ones you want support for and
click on the OK button.

Uninstall

Allows you to remove installed fonts, in order to save space for example.

1. Generally in runlevels 3 and 5
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Import

Allows you to manually add fonts found outside the Mandrakelinux distribution, on the Internet for exam-
ple. Supported font types are ttf, pfa, pfb, pcf, pfm, gsf. Clicking on the Add button will open a standard
dialog allowing you to specify the font file to import. Once you’ve specified all the fonts you want to
import, click on the Install fonts button.

To select more than one font, double-click on the first font you wish
to select and it will be added to the Import Fonts window. Then
double-click the other fonts you wish to install and the same action
will occur. When you are done click on the Close button and then
on the Install fonts button. Once the installation operation is done,
make sure the new fonts appear in the Font List Family.

19.4. Setting your Machine’s Date and Time

This little tool allows you to set your system’s correct internal date and time.

Figure 19-8. Changing Date and Time

You can set the date on the left and the time on the right:

• To change the year, click on the little arrows on each side of the year; same procedure to change the month.
This updates the month view where you can click on the current day in order to highlight it;

• We recommended that you check the time-zone settings for your geographical location. Click on the Change
Time Zone button and select the correct place in the tree view.

When you’ve chosen the time zone, a dialog will appear asking whether your hardware clock is set to GMT.
Answer Yes if only GNU/Linux is installed on your machine, No otherwise.
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• To change the time, you can then either move the hour, minute and second hands of the analog clock, or
change the numbers below it.

• If you have a permanent Internet connection and want your system to synchronize its internal clock with
time servers on the Internet, put a check mark in the Enable Network Time Protocol option and select a server
in the Server pull-down list.

The NTP (Network Time Protocol) package needs to be installed.
If it is not installed a dialog will pop up and ask you whether you
wish to install it.

If you select the pool.ntp.org server, NTP will automatically
choose the server nearest to the time zone you selected.

When you are finished, click on OK to apply your settings or Cancel to close the tool, which will consequently
discard your changes. If you want to return to your previous settings, click on Reset.

19.5. LogDrake: Searching through the Log Files

This tool allows you to look for specific entries in various log files, thus facilitating the search
for particular incidents or security threats.

Figure 19-9. Browsing and Searching through System Logs

These are the steps to follow in order to browse or make a specific event search into the system logs:

1. You can choose to match lines containing specific words filling the Matching field; and/or not containing
others filling the but not matching field.

2. Then choose the file you want to perform the search in, in the Choose file area: simply check the correspon-
ding box.
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The Mandrake Tools Log is filled by Mandrakelinux-specific confi-
guration tools, like those you find in the Control Center. Each time
those tools modify the system configuration they write a line in this
log file.

3. Optionally, you can restrict the search to a specific day. In that case, check the Show only for the selected
day box and choose the desired day from the calendar.

4. When all is set up, click on the search button. The results will appear in the Content of the file area at the
bottom.

Clicking on the Save button will open a standard dialog letting you save the search results into a plain text
(*.txt) file.

19.6. UserDrake: Managing Users and Groups on your System

UserDrake is an advanced Mandrakelinux tool which allows system administrators to easily add and remove
users of the system, to arrange users in groups, and to manage user groups in the same manner.

In this section we will only focus on user management. Group ma-
nagement is very similar.

19.6.1. The Interface

Launching UserDrake will display the main window (figure 19-10) which lists the users currently defined on
the system. You can switch from users to groups by activating the Groups tab next to the Users tab.

Figure 19-10. The Users List in UserDrake

From top to bottom: a menu, some action buttons, a search field, and the users/groups tabs.

All changes have immediate effect on your local user database. If the users list is modified outside of UserDrake,
you can refresh UserDrake’s window by clicking on the Refresh button.
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If you make changes to an already logged in user, those changes
won’t take effect until that user logs out and in again.

Available actions are:

Add User

Adds a new user to the system. We will detail this procedure in Adding a New User, page 165

Add Group

Adds a new user group to the system.

Edit

Allows you to change the parameters of the selected user or group. We will detail editing user parameters
in Adding a New User, page 165. In the case of a group you’ll be able to assign users to that group.

Delete

Removes the selected user or group from the system. A confirmation dialog will be shown, and in the
case of a user you will also be able to remove the user’s home directory and messages.

19.6.2. Adding a New User

We created the non-privileged user Queen Pingusa at installation time, and now we want to create a new user
called Peter Pingus, and then make them both members of the fileshare group, so that they can share folders
with other users on the network (Local Disk Sharing: Allowing Users to Share Folders, page 141).

Click on the Add User button, the dialog box to add a new user will pop up (figure 19-11). The only required
field is Login. You can also choose to add a comment in Full Name. Generally, this is the full name of the user,
but you can put whatever you want. You will also want to set a password for this new user: enter both the
Password and Confirm Password fields.

Figure 19-11. Adding a New User in the System

We now have two users in our list. Select one of them with your mouse, and click on the Edit button. The
dialog box shown in figure 19-12 will pop up. It allows you to modify most available user parameters.
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Figure 19-12. Adding Users to a Group

The dialog is made of four tabs:

User Data

Allows you to modify information provided when the user was created.

Account Info

Enables you to provide an expiration date for that account, after which the user won’t be able to connect
to the system. This is useful for temporary accounts. It’s also possible to temporary lock an account to
prevent a user from logging in. Finally, this tab allows you to change the icon associated to the user.

Password Info

Allows you to provide a password expiration date, after which a user will have to change his or her
password.

Groups

Shows the list of available groups where you can select the groups to which any user should belong.

For our users we just need to look for the fileshare entry and check the box associated to it. Then click on
the OK button to make the changes effective.

19.7. DrakBackup: Backing-Up and Restore your Files

This tool allows you to back up any data present on your computer to a backup media whether
on hard drive, another networked computer, CD/DVD or tape. Once you have defined the
files to back up and configured the way to access the backup media, you can run the backup
periodically. Then, you can forget about it until you wish to restore some files.

The backup parameters must be defined so that Drakbackup knows what, where and when to perform the bac-
kup. We will guide you step by step with a backup and restore example using the wizard and then introduce
you to automation of periodic backups.
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19.7.1. A Practical Example Using the Wizard

Figure 19-13. Main DrakBackup Window

Start Drakbackup by clicking on the Backups icon found in Mandrakelinux Control Center’s System section. Click
on the Wizard Configuration button to start the wizard. After making your choices in each step click on the Next
button to advance to the next step.

19.7.1.1. First Step: What to Backup.

Figure 19-14. Selecting What to Backup

Select Backup system to include the /etc/ directory where all your current system configuration files lie. This
allows you to “transport” your system to a different computer with little effort: only hardware-dependent
configuration will have to be revised.
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The“system”backup does not include applications themselves (i.e.
executables, libraries). A priori this makes sense because it is li-
kely that you will have access to the system’s installation media
from which applications can be easily installed again on the target
computer.

Select Backup Users to include all the files included in all of your users’ home directories. Clicking on the Select
user manually button will let you select individual users and the following options:

• Do not include the browser cache. Select this to exclude the web browser’s cache from the backup file set.
Recommended due to the very nature of the browser’s cache.

• Use Incremental/Differential Backups. Selecting this will preserve old backups. Choosing Use Incremental Bac-
kups will only save files which have been changed or added since the last backup operation. Choosing Use
Differential Backups will only save files which have been changed or added since the first backup operation
(also known as the “base” backup). This last option takes more space than the first one, but allows you to
restore the system’s state at any given point in time for which a backup operation was made.

19.7.1.2. Second Step: Where to Store the Backup

Figure 19-15. Selecting Where to Store the Backup

Select Across Network to store the backup on a remote computer accessible using one of ssh, FTP, rsync or
WebDAV methods. A machine name or IP address, a user name and password on that machine, a directory
on that machine, and the access method and its options (if applicable) must be specified by clicking on the
corresponding Configure button.

Select On Tape Device to store the backup on a tape drive. Click on the corresponding Configure button to set
the tape device and tape parameters such as whether or not to rewind, erase and eject the tape.

Select On CD-R to store the backup on optical media: (re)writable CD or DVD. This is our media of choice for
the example, so click on its Configure button to set the required parameters (figure 19-16).
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Figure 19-16. Setting Optical Media Parameters

If not set automatically, use the Choose your CD/DVD device combo box to set the CD/DVD device. In our
example, we choose ATAPI:/dev/hdd, which is an IDE recorder. We chose a 700 MB medium size and a re-
writable medium (the CDRW media option is selected).

Select the Erase your RW media option to erase your re-writable media before each backup is performed. If
you select the Multisession CD option, only the 1st session will erase the media. Session-related information
recording takes some space out (20-30 MB) for each session, so the “real data” storage space will actually be
less than the medium’s size.

19.7.1.3. Third Step: Review and Store the Configuration

Figure 19-17. Review Configuration Parameters

The last wizard step shows a summary of configuration parameters. Use the Previous button to change any
parameter you are not satisfied with. Once you are satisfied with all parameters, click on the Save button to
store them. Drakbackup is ready to perform backups.
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19.7.1.4. Performing the Backup

Figure 19-18. Backup Progress Dialog

Click on the Backup Now button on Drakbackup’s main window and then on the Backup Now from configuration
file button to display a confirmation dialog with Drakbackup’s parameters: make sure the corresponding media
(the CD-RW disk in our example) is ready and click on the Build Backup to start the backup operation.

A dialog (figure 19-18) will display the current progress of the operation. Please be patient: the time it takes
to backup depends on many factors such as the size of the backup file set, the speed of the storage option
selected, etc. Once the operation is finished a report will be shown: look for possible errors on it and take
corrective measures if needed.

19.7.2. Restoring Backups

Figure 19-19. Choosing the Restore Type to Perform
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Make sure the media you want to restore the backup from is accessible and ready. Then click on Drakbackup’s
Restore button. In our example we will restore the whole backup so on the restore dialog (figure 19-19) click on
the Restore all backups button. A dialog will show you the current restore settings. Click on the Restore button
to start the restoration process.

Existing files in the target restoration directory (same location whe-
re the backup was made from, by default) will be overwritten.

Feel free to investigate the other restore options if you want to restore part of a backup instead of the full file
set.

19.7.3. Automating Periodic Backups

Figure 19-20. Daemon Options Window

In Drakbackup’s main window, click on the Advanced Configuration button and then on the When button. The
backup scheduling window will appear (figure 19-20). Select Use daemon to define the schedule. You will then
be asked to specify the interval (or period) between each backup operation and the storage media. In our
example we set up a customized calendar (custom period selected) to perform a backup every Friday at a
quarter to midnight and store it on CD. You can also specify hourly (i.e.: performed 1 minute after the hour),
daily (i.e.: performed at 4:02AM), weekly (performed at 4:22AM) and monthly (performed at 4:42AM) periods
instead of custom.
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19.7.4. Other DrakBackup Options

Figure 19-21. Miscellaneous Options Window

Click on the Advanced Configuration button and then on the More Options button. The miscellaneous options
window will appear (figure 19-21).

Use the Please choose the compression type pull down list to select the compression used for your backups
among tar (no compression), tar.gz (gzip compression) and tar.bz2 (bzip2 compression: better but slower).

Select the Use .backupignore files option to have Drakbackup exclude certain files from the backup. The
.backupignore file should be present in every directory of the backup file set where files are to be excluded.
Its syntax is very easy: a one-file-per-line list of the names of the files to exclude.

You can use the star (* =“matches any string”) and the question
mark (? =“matches one and only one character, regardless of what
that character is”) in the .backupignore file to exclude sets of files.
For example, somename* will match all files whose names start with
somename, and image00?.jpg will match files named image001.

jpg, image009.jpg, image00a.jpg, image00h.jpg, etc.

Select the Send mail report after each backup to option and fill the e-mail address to have Drakbackup mail the
backup operation report to that address. Multiple addresses can be used by entering a comma-separated list.
Please bear in mind that the system needs to have a working MTA (Mail Transport Agent) for this option to
be effective.

All methods other than NFS use the hard disk drive to store temporary files. Select the Delete Hard Drive tar
files after backup to other media option to have Drakbackup free that space after performing the backup.
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If you are coming from a Windows environment, you will know the problem, that every piece of software has
its own method of installation: either a MSI file, an InstallShield setup, a self extracting executable or maybe
simply a zip file. When installing software you always risk ending up with some of your applications not wor-
king anymore, as a recently downloaded tool may have replaced some .dll-files with older versions without
warning you. This is why the GNU/Linux community went a totally different way and created software packa-
ge management systems to take care of these problems: rpm. As always under GNU/Linux this is a command
line tool, with lots of nice features, but maybe a bit overloaded for the average user. Therefore Mandrakelinux
provides you with a graphical software installer: Rpmdrake.

Rpmdrake consists of different tools, which you access choosing one of the entries of System+Configuration+Packaging
in the main menu or by clicking on Software Management in the Mandrakelinux Control Center (see figure 20-1).

Figure 20-1. Software Management in the Mandrakelinux Control Center

We recommend that you access Rpmdrake via the Mandrakelinux Control Center.

20.1. Install Software

When launching this tool you will have to wait a few seconds, while Rpmdrake searches the available
packages database. Then you will be presented the Software Packages Installation interface.
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Figure 20-2. The Software Packages Installation interface

The window is divided into four parts: the upper part offers you some possibilities to manipulate the list of
packages you can install. You will find this list in the middle on the left. Next to it, on the right, you have an
area where you can find a description of the currently selected package. In the bottom of the window you will
find a status bar with three buttons.

Let us have a closer look at the interface as shown in figure 20-2. A package named “frozen-bubble-1.0.
0-6mdk” is selected in the tree-view and in the package description area you will see that the required disk
space (11829 KB), a short summary (Frozen Bubble arcade game) and a detailed description (Full-featured,
colorful animated penguin eye candy...).

You may get more information on the package by choosing the
Maximum information radio button in the access-area. In addition
you will see a list of the files provided by the package and the change
log.

The status bar shows you that you have selected 14 MB and you have enough free disk space left (1161 MB).

Rpmdrake will show you an alert box, if you try to install more
software than the free available disk space. Nevertheless you may
proceed (you may, for example, be able to remove some no longer
required files, such as programs downloaded from Internet in the
past and which you do not use anymore, to allow the installation
to continue).

Now you can begin the installation, by simply clicking on the Install button. A new window will appear,
showing you a progress bar of how your installation is proceeding. If you prefer to leave without doing
anything, you can just click on the Quit button.

During the selection it may happen that you choose a package which requires some additional libraries or
another tool to be installed to work correctly. In this case Rpmdrake will display an information window allo-
wing you to choose whether to accept the selected dependencies, or to Cancel the operation (figure 20-3).
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Figure 20-3. Rpmdrake –– dependency alert box

Another possible scenario might be: you want to install a package which requires dependencies, and various
packages are capable of providing that dependency. The list of alternatives is then presented (figure 20-4).
You may read the additional information presented by clicking the Info... button to help you choose the best
alternative.

Figure 20-4. Rpmdrake –– package alternatives

We will now take a closer look at the search and sort functions provided to ease your job as a system adminis-
trator:

20.1.1. Searching packages

Sometimes you may know about some tool you saw somewhere or you heard of at a friends place, now you
wonder how to find and install them on your system.

It is really easy: just type the name, (or part of the name), in the text area next to the Search button. Then choose,
from the radio buttons, where you want to look for it (either in the package name, in the description provided
with the package or in the names of the files stored in the packages). A new list will appear, showing you the
search results, Rpmdrake found while scanning the databases.

Let us take a look on the different sort orders:

20.1.2. Mandrakelinux choices

This sort order will show the list of packages in the four groups you saw during the installation of Mandra-
kelinux. This is the easier sort order because it focuses on a selected part of the available packages, which are
considered to be the most useful of the distribution.

20.1.3. All packages, alphabetical

Instead of a tree view, you will be presented with a flat list of all available packages you can install on your
system.

20.1.4. All packages, by group

Here you will be shown the list of packages grouped by their functions (e.g. Games, System, Video, etc.).

20.1.5. All packages, by size

Here you get a list sorted by size (the biggest package at the top, the smallest at the bottom of the list).
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20.1.6. All packages, by selection state

If you choose this presentation, you will end up with a flat list, in which all selected packages are shown first,
the other available packages below them. To make it easier for you, those two parts are sorted alphabetically.
This sort order is particularly useful just before the actual package installation, when you have selected many
packages because it helps you to see a list of all the selected packages.

20.1.7. All packages, by medium repository

Once again you will find the packages sorted alphabetically, but this time they are shown under the name of
the data medium they belong to.

20.1.8. All packages, by update availability

In this mode, you might get two groups of packages: a list of packages which might be added to your machine,
and a second list with all packages where you have an older version already installed on your computer.

20.2. Remove Software

As this interface works like the “Install Software” one, we will not repeat its basic functions. The
only difference to the installation interface is that you will deal with the already installed packages
list from which to choose those you want to remove, instead of those packages which might be

useful to install on your computer.

20.3. Mandrakelinux Update

Once again: if you have already worked with the software installation interface of Rpmdrake, then
you should feel comfortable with Mandrakeupdate. But let us look at the details.

When you launch this tool, it will first ask you to choose an Internet repository to check for updates. You
should choose one in a country near you.

A small difference to the “Install Software” interface is the ability to choose which kind of update you want
to install on your computer by grouping them in certain ways. You may select Security Updates, Bugfixes and
Normal Updates.

The other difference is a new text section inside the package description area. It provides you with information
about why this update was made available. This may help you decide if you want to update certain packages.
When you have a slow Internet connection or you have to pay per MB when you are downloading, it would
be wise to read it.

If you are not yet familiar with the interface, please go back to Install Software, page 173 to learn about it.

And now to something completely different.

20.4. The Software Media Manager

This part of Rpmdrake is dedicated to the configuration of the package media repositories. As you can
see in figure 20-5 there are some media configured: “Installation CD”, “Contrib CD”, etc. With this
tool you can add other software media: a CD from a magazine containing RPMs, a Web repository,

etc. The check boxes in the left column allow you to temporarily disable a medium: when unchecked, the
associated packages will not appear in the “Install Software” interface.
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Figure 20-5. The “Software Media Manager”

You have several choices here.

Remove

Allows you to remove a medium which you no longer use, e.g. there is a new version of Mandrakelinux
and you bought the new box. Simply select the medium to be removed in the list and click this button.

Edit

Here you may change the URL or the relative path to the synthesis/hdlist (if you do not know what
we are talking about it will be wise to leave this window via Cancel instead of Save changes).

Add...

This button provides access to a new dialog, in which you may define a new software package medium.
In figure 20-6 you can see the dialog when adding a Security updates medium.

Figure 20-6. Rpmdrake –– adding a Media

Update...

You will be shown a list of already defined data media. You can choose the ones you want to update. Just
start the process by clicking on Update.

Manage keys...

It is important that any new packages you install are authenticated. To do so, each package can be elec-
tronically signed with a “key”, and you can allow/disallow keys on a per-medium basis. On figure 20-7,
you can see that Mandrakelinux key is allowed for medium “Installation CD”. Click on Add a key... to
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allow another key for that medium (beware, do this with care, as with all security-related questions), and
Remove key to remove a key.

Figure 20-7. Rpmdrake –– managing keys

Proxy...

If you are sitting behind a firewall and you still need to use Rpmdrake to manage your system, you can
do so, if you have a proxy server which leads to the Internet (at least in an area where you can find a
package server). Normally it should be enough to fill in the Proxy hostname to get it working (figure 20-8).
If you need a user / password combination to get through the proxy, you can also specify these here. Just
confirm your changes by clicking on OK and you are done.

Figure 20-8. Rpmdrake –– configuring a proxy

Parallel...

If you are running a large network of computers, you may want to install a package on all the computers
in parallel; this button will open a dialog window allowing the configuration of the “Parallel” mode. As
it is rather complicated and only useful to a limited group of people, this short introduction will not give
more details about it.

As you have seen on our short trip through Rpmdrake, it is easy to manage your own system, to add new
applications or to remove something if you need more space on disk. Welcome to the world of system admi-
nistration.

20.5. Package Management through the Command Line

Rpmdrake applications are merely graphical interfaces to the powerful urpmi command line tools. For those
wishing to control their packages via the command line (useful if you are working remotely, for example) we
quickly present the most useful commands. Note that most commands will need root privileges.

20.5.1. Installing and Removing Packages

This is done with two simple commands:

urpmi <package_name>

Will install package package_name if it exists or the package which name contains the package_name string
in it.
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urpme <package_name>

Will remove the package package_name.

Consult the urpmi(8) and urpme(8) man pages to learn about the many options and behaviors of these two
commands.

20.5.2. Media Management

Adding and removing media is easy on the command line but the syntax must be strictly respected.

20.5.2.1. Adding New Media

urpmi.addmedia <name> <url>

This command allows you to add a new media either from a local drive, a removable device (CD-ROM), or
from the network through the HTTP, FTP, NFS, ssh or rsync protocols. The syntax varies for each of these
methods so you are encouraged to consult the urpmi.addmedia(8) man page before using it.

If you are declaring a new update media, use the --update option
on your urpmi.addmedia command line.

20.5.2.2. Removing Media

urpmi.removemedia <name>

This command will simply remove the media name. If you cannot remember the media’s name, issuing urp-
mi.removemedia alone on the command line will list all defined media.

20.5.2.3. Updating Media

urpmi.update <name>

This command will scan the named media and update the package list associated to it. This is useful for update
medias. If you wish to rescan all defined media you can simply run urpmi.update -a.

20.5.3. Tricks and Recipes

20.5.3.1. Finding the Package which Contains a Specific File

You know you need a specific file on your system but you do not know which package provides it... The urpmf
utility will scan all media and find it for you. Just run urpmf <filename> and any package(s) which contain it
will be displayed.

You can even provide only a partial name. For example urpmf salsa will return a list of all packages which
contain a file whose name contains the salsa name in it.

[root@test queen]# urpmf salsa

kaffe:/usr/lib/kaffe/lib/i386/libtritonusalsa-1.1.2.so

kaffe:/usr/lib/kaffe/lib/i386/libtritonusalsa.la

kaffe:/usr/lib/kaffe/lib/i386/libtritonusalsa.so
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20.5.3.2. Updating Packages

This command will automatically update all the packages that need it as Mandrakeupdate would do it:

urpmi.update -a; urpmi --update --auto-select --auto
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This chapter will guide you through some troubleshooting basics, that is: what to do when everything goes
wrong or, better yet, what to do to be prepared if something goes wrong and how to fix it.

21.1. Introduction

Making backup copies of your data, fixing little problems, recompiling the kernel, installing software, and
tweaking configuration files are not uncommon scenarios in every day GNU/Linux life: even if you do not do
it all the time, some day you will want or need to. Those tasks can be managed without any hassle at all if you
use a little common sense and follow some practices and guidelines we will introduce here.

Many of the examples and tools presented in this chapter deal with
the command line. Usually, restoration of a damaged system to
a working state can only be done using the command line. It is
assumed that you feel comfortable enough using this powerful tool.

So, on to the basic things you need to have ready...

21.2. A Boot Disk

The very first thing you will need when your system cannot boot from the hard disk, for any of the reasons
we mentioned before, will be a boot disk. A boot disk will allow you to boot your system up and, in a matter
of minutes, enable you to undo the thing that has made your system unusable.

You can also use the Rescue Mode of Mandrakelinux’s installation
CD-ROM to boot your machine and perform some maintenance
tasks, but a boot disk might prove to be useful anyway (for example,
if your machine does not support booting from the CD-ROM drive).

21.2.1. Creating a Boot Floppy from the Console

Open a terminal and type the following, as root:

# mkbootdisk --device /dev/fd0 ‘uname -r‘

and strike the Enter key, then follow the instructions given on screen.

One parameter needed by mkbootdisk is the --device [device] option, which tells mkbootdisk which device
you want to write the boot disk to. In our example, we chose /dev/fd0 which is the first floppy drive in the
system. In 99.9% of cases that should work. If it does not, just choose the right device for your floppy drive.

The other parameter needed is the [kernel-version] option, which tells mkbootdisk which kernel you want
to put on the floppy. In our example, we use ‘uname -r‘ which gives as a result the name of the current
running kernel. Thus, the example given will create a boot disk in the first floppy drive with the current
running kernel on it.

Please note that this will create a boot disk that is based on your current running kernel with all the modules
and stuff which that kernel uses.

21.2.2. Testing the Boot Disk

Always test your boot floppy to make sure it actually works. There are few things more embarrassing than
finding that the floppy will not boot because of media errors. If the floppy boots OK then... You are done!
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21.3. Backup

21.3.1. Why Backup?

Backing up your system is the only means of being able to repair it if it suffers severe damage, if you acci-
dentally delete some important system files, or if someone breaks into your system and intentionally deletes
some files. You should also back up your personal data (compressed audio, images, office documents, e-mails,
address book, etc.) to be safe.

You should make your backups using an appropriate medium and keep them in a safe place. Such a place
should be outside the place you usually work in, if possible. You can even have two backups, one on-site, and
one outside. Generally speaking, you should make sure that you will be able to restore those backups if you
want all this to be really useful.

21.3.2. Preparing your System

You probably have everything you need already installed in your system. You should also keep a boot disk
near at hand (you created one, didn’t you?). Actually, you can make backups using only tar and, optionally,
a compression tool such as gzip or bzip2. See an example in Backup Example Using tar, page 183.

As an alternative, you can use specialized backup programs, such as Taper, Time Navigator, Arkeia, or Mandra-
kelinux’s own Drakbackup.

21.3.3. What to Backup?

Well, this might be the single most difficult question every system administrator asks himself when the time
to back up comes. The answer depends on things such as: are you just backing up your personal data, your
configuration files, or your whole system? How much time or space is it going to take? Will you be restoring
your backup on the same machine/OS version, or on a different one?

Since this is a troubleshooting guide, we will try to focus on doing a backup that will allow us to quickly restore
our system to the state it was before that terrible thing which rendered it unusable happened. Of course, you
will need to make a backup of your personal data if you do not want to lose it.

As a rule of thumb, you will need to back up the following directories: /etc, /home, /root and /var. If you do a
complete backup of these directories, you will have saved not only your system configurations, but your data
as well (in case you are wondering where your data is, it is located in the /home/your_user_name/ directory).
Please bear in mind that this can take a long time to complete, but it is the safest bet.

A more sophisticated scheme would be to back up only those configuration files which have changed, skipping
the ones which have not. This will take more planning time, but will lead to quicker backups (and quicker
restores, too). They will be “easier” to port from one machine/OS version to another.

To summarize, back up all the configuration files of the programs you use and all of the configuration files
you have changed. Also back up all your personal (and your system’s users) data files. You will not regret it.

21.3.4. Where to Backup?

The other big question to answer. This depends on how much you want to back up, how fast you want to
make your backups, how easy is the access to the backup media, and a large list of etceteras.

Generally speaking, you need media that is at least as large as the amount of information you want to back
up, and fast enough so the whole process will not take forever to complete.

Available backup media options vary in capacity, reliability, and speed. You can combine backup medium
according to your backup strategy, for example: tapes and CD-R/DVD+RW, hard disk and tapes, hard disk
and CD-R/DVD+RW, etc., but bear in mind that your backup software may or may not support all of them.
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21.3.5. When to Back Up?

There are many policies for backup schedules. We will introduce you to a few. Please bear in mind that these
are not mandatory, nor the best ones, nor the only ones. These are just guidelines you may want to follow in
rolling out your own backup schedule.

The many backup strategies out there depend on the media you use, on how often your data changes, and on
how critical that data is to you or your organization. For example, one strategy states that you should make a
full backup each weekend, and an incremental (changed stuff only) backup every day; then make a full backup
every month and store that one in at least two places. This strategy might prove useful for an enterprise, but
not for a personal computer. For your personal backups you can think of something like this: make a weekly
backup of your files on your disk drive and each month transfer those backups to CD-R/DVD+RW or tape.

21.3.6. Backup Example Using tar

Next, we will introduce you to a little backup script that uses tar and bzip2 for making a compressed backup
of the list of directories you provide. Please read the script’s comments for tips on its usage.

You need read permission on the files, and read and execute per-
missions on the directories, you are going to back up. Otherwise
the backup operation will fail.

#!/bin/bash

# Create a compressed backup of all the directories specified and put the

# resulting file in a directory of our choice.

BACKUP_DIRS="$HOME /etc /var"

BACKUP_FILENAME=‘date ’+%b%d%Y’‘

BACKUP_DEST_DIR="/backups"

# Uncomment the following line for GZipped backups, comment for

# BZipped backups

#tar cvzf $BACKUP_DEST_DIR/$BACKUP_FILENAME.tar.gz $BACKUP_DIRS

# We do a BZipped backup here...

# Comment the following line for GZipped backups, uncomment for

# BZipped backups

tar cvjf $BACKUP_DEST_DIR/$BACKUP_FILENAME.tar.bz2 $BACKUP_DIRS

Use BACKUP_DIRS to specify the directories you want to include in the backup and BACKUP_DEST_DIR to specify
the destination directory where the backup is going to be stored. Make the script executable: open a terminal
and run chmod 700 backup.sh.

Of course, you can later move the resulting tar.bz2 or tar.gz file to any media you want. You can even
backup directly to the media you want by mounting it and changing the variable BACKUP_DEST_DIR of the
script accordingly. Feel free to enhance this script and make it as flexible as you want.

To restore the backups made this way, please look at Restore Example Using tar, page 183.

21.4. Restore

The restoration of a backup depends on which program, media, and schedule you used to make it. We will
not cover all the restore cases, but only mention that in order to recover your settings and data files, make sure
that you restore the files and/or directories to the same places they were in when you made the backup.
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21.4.1. Restore Example Using tar

Now, we will introduce a little script to restore the backup we made with tar using the script introduced
earlier in Backup Example Using tar, page 183.

You need write permissions on the files and directories you are going
to restore. Otherwise the restore operation will fail.

#!/bin/bash

# Extract a compressed backup of all the directories specified

# putting the backed up files into their original places.

BACKUP_SOURCE_DIR="/backups"

RESTORE_FILENAME=$1

# Uncomment the following line if you are restoring GZipped

# backups

#tar xvzf $BACKUP_SOURCE_DIR/$RESTORE_FILENAME

# Restore a BZipped backup here...

tar xvjf $BACKUP_SOURCE_DIR/$RESTORE_FILENAME

As you can see, this script is simple enough. All we have to do is to pass it the file name of the backup we
want to restore as a parameter (just the file name, not the full path), and it restores the backed up files into
their original locations. Make sure the script is executable: open a terminal and run chmod 700 restore.sh.

21.4.2. Making a Recovery CD-ROM

There is a way to be prepared in case of “total disaster”, and that is by making a full backup of your system.
Programs such as mkCDrec can be very useful to get you up and running in a matter of minutes.

If you are the proud owner of a Mandrakelinux –– PowerPack Edition, you already have this tool in the
“contribs” CD-ROM. Otherwise, you can find it, together with its documentation on the mkCDrec web site
(http://mkcdrec.ota.be).

mkCDrec allows you to do multiple-CD-ROM volumes, disk cloning (copying the full contents of a disk or
partition to another one with similar characteristics –– at least the same size), and many more.

In order to restore a system with mkCDrec you just have to boot with the first CD-ROM of the multiple-CD-
ROM volume and follow the on-screen instructions.

21.5. Problems Arising at Boot Time

It could happen that your system hangs during boot up. If so, do not panic, just keep reading.

The next sections are not introduced in any particular order.
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21.5.1. System Hanging during Boot

If your system hangs during Rebuilding RPM database or Finding module dependencies, just press Ctrl-C.
This will allow the system to skip this step and continue to boot. Once booted, execute rpm --rebuilddb as
root if the system hang was at the Rebuilding RPM database phase. If the system hang was at the Finding
module dependencies phase you have most likely been through a kernel upgrade, but have not done it co-
rrectly. Check if the files in /boot and the /lib/modules directory match the current kernel version (i.e., have
the current version number attached). If they do not match, please read Compiling and Installing New Kernels
from Reference Manual to find out how to fix it.

If the boot process hangs at RAMDISK: Compressed image found at block 0 you have messed up the initrd
image. Either try to boot another lilo.conf entry or boot an emergency system and remove or change the
initrd= section in /etc/lilo.conf

21.5.2. File-System Check on Boot Fails

The information below only applies to ext2 and ext3 file systems.
If you have another file system, please check its documentation.

If, for any reason, you did not shut your box down properly, the system will run a routine file-system check
during the next boot. It may sometimes fail to do this on its own and will drop you to a console. Execute
e2fsck -py [device] where [device] is the name of the partition on which the automatic check has failed.
The -p switch tells e2fsck to do all the necessary repairs without asking, -y assumes you answer yes to all
questions. When the check and repair phase is over, press Ctrl-D to leave the emergency console. The system
will reboot.

If you get this error regularly, there may be bad blocks on your disk. Execute e2fsck -c [device] to find out.
This command will automatically mark any bad blocks and thus prevent the file system from storing data in
these blocks. e2fsck checks the file system automatically only if it has not been unmounted properly during
the previous system shutdown; or if the maximal mount count has been reached. To force a check, use the -f
option.

The check for bad blocks on a disk should only be done on un-
mounted file systems, and can take a long time to complete.

21.5.3. X Doesn’t Start

If you boot into X by default and have managed to break your X configuration somehow and cannot enter X
anymore, you can login into a console and use XFdrake to re-configure X. You can also boot into a different run
level, fix X’s configuration with XFdrake and reboot into X.

21.5.3.1. Booting Into a Different Run Level

The default run level GNU/Linux boots to is defined in the /etc/inittab file. Look for an entry like
id:5:initdefault:. To boot into run level 3 (the console), you have to define that run level on the boot
prompt. Under LILO, press the Esc key once and type linux init 3. Under GRUB, press the E key twice, add
init 3, press the Enter key and then the B key to boot.

For a more detailed description about run levels, please refer to Mandrakelinux’s Reference Manual.

21.5.3.2. Configuring X from the Console

To re-configure X using XFdrake from the console simply type XFdrake, as root.

Using XFdrake is no different to the graphical environment except that you will not have nice icons and may
not be able to use the mouse pointer. To move down you have to press on the right or down arrow keys on your
keyboard; to move up press on the left or up keys on your keyboard. You can also use the Tab key to move
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between the different options/buttons. The text on the currently selected button/option will be highlighted
with a different color; press the Enter key to activate it.

21.6. Boot-Loader Issues

21.6.1. Boot-Loader Reinstall

Sometimes you will make a mistake and wipe your disk’s MBR (Master Boot Record), or some misbehaving
program does it, or you dual boot with Windows and catch a virus that does it. So, you say, I won’t be able to
boot my system anymore, right? Wrong! There are many ways to recover the boot record.

To recover your boot loader you will need a boot disk. Without a boot disk of some kind you might be com-
pletely lost1.

Reboot your computer using the boot disk. What you do next varies according whether you use LILO or GRUB.
No matter which boot loader you use, all the commands you must execute will need to be run as root.

21.6.1.1. With LILO

If you use LILO, you just need to issue the following at the command prompt: /sbin/lilo. This will re-install
LILO in your disk’s boot sector and will fix the problem.

21.6.1.2. With GRUB

If you use GRUB things are a little bit different than with LILO.

The following example will assume that you are trying to install
GRUB in the MBR of your first IDE drive, and that the file stage1 is
in the /boot/grub/ directory.

First, invoke GRUB’s shell by issuing the command: grub. Once there, issue the following command: root
(hd0,0); this will tell GRUB that the files it needs are in the first partition (0) of your first hard disk (hd0). Then
issue the following command: setup (hd0); this will install GRUB in the MBR of your first hard disk. That’s
it!

You can also try to use grub-install /dev/hda to install GRUB on your first hard drive’s MBR, but the
method described above is the preferred one.

21.6.1.3. Some Considerations for Dual-Booting Systems

Windows 9x, NT, 2000 and XP upgrades. If you are running a dual-boot system, be very careful to always
have a GNU/Linux boot disk prepared. When (re)installing Windows (all versions), it rewrites the MBR with no
warning at all, and if you do not have a boot disk, you will not be able to boot GNU/Linux after you perform
the Windows upgrade.

21.6.2. Backing Up and Restoring the MBR

To make a backup copy of your hard disk’s Master Boot Record, insert a blank floppy in your floppy disk
drive and issue the following:

# dd if=/dev/hda of=/dev/fd0/mbr.bin bs=512 count=1

If you want to restore a backed up copy of your hard disk’s MBR, insert the floppy containing it into your
floppy disk drive and issue the following:

1. Unless you made a backup of your MBR.
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# dd if=/dev/fd0/mbr.bin of=/dev/hda bs=512

The above examples assume that the MBR of your first IDE hard
disk (/dev/hda) is backed up to a file named mbr.bin on your first
floppy diskette drive (/dev/fd0) and should be run as the root

user.

21.7. File System Issues

21.7.1. Repairing a Damaged Super-Block

The information below only applies to ext2 and ext3 file systems.
If you have another file system, please check its documentation.

The super-block is the first block of each ext2FS/ext3FS partition. It contains important data about the file
system, such as its size, free space, etc. (it is similar to the method used by FAT partitions). A partition with a
damaged super-block cannot be mounted. Fortunately, ext2FS/ext3FS keep several super-block backup copies
scattered over the partition.

Boot your system with a boot disk. The backup copies’ location depends on the block size of the file system.
For file systems with 1 KB block sizes it is at the beginning of each 8 KB (8192 bytes) block, for file systems
with 2 KB sizes it is at the beginning of each 16 KB (16384 bytes) block, and so on. You can use the mke2fs -n
[your_disk_device_name] command to find out at which byte positions the super-block copies are. Assuming
a 1 KB block size, the first backup copy is in byte number 8193. To restore the super-block from this copy,
execute e2fsck -b 8193 /dev/hda4; change hda4 accordingly to reflect the name of your damaged partition.
If that block also happens to be damaged, try the next one at byte number 16385, and so on until you find a
suitable one. Reboot your system to activate the changes.

21.7.2. Recovering Deleted Files

We will discuss some ways of recovering deleted files and directories. Please bear in mind that the recovery
tools are not magical, and they will work depending on how recently you deleted the file you are trying to
recover.

You might be wondering “Well, I accidentally deleted this file, how can I recover it?”. There are some utilities
designed for GNU/Linux’s ext2 file system which allow you to recover deleted files and directories. However
these utilities will not recover the files you deleted a few months ago because of disk usage, space marked as
“free” will be overwritten; so the best way to protect against accidental or not so accidental deletions is doing
backups.

Please bear in mind that there are not (as yet) tools to recover files
deleted on ReiserFS file systems. Keep in touch with the ReiserFS
home page (http://www.namesys.com) for the latest news about
ReiserFS.

Anyway, on to the tools for recovering your deleted files. One such tool is Recover. It is an interactive tool.
If you have a Mandrakelinux –– PowerPack Edition, you already have this tool in the “contribs” CD-ROM.
Otherwise, you can find it on the Rpmfind web site (http://www.rpmfind.net). Go there and download the
RPM. Once you have the RPM, install it. Then run it with recover [command_line_opts] and answer the
questions it asks you. The questions will help you to set a time span to look for deleted files and directories to
minimize the time it takes to do the search.2

2. You can search for all deleted files too, but it will take longer...
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Once the tool finishes its search, it will ask you where you want to save the recovered files and directories.
Pick a directory of your choice, and you will have all the files and directories recovered into it. Note that you
will not be able to recover the file names, just their contents, but you can inspect them or try to rename them
with different names until you get the right one. This is better than nothing.

There are also mini-HOWTOs related to “undeletion” for ext2,
look at Ext2fs-Undeletion (http://www.tldp.org/HOWTO/
mini/Ext2fs-Undeletion.html) and undeletion of who-
le directory structures (http://www.tldp.org/HOWTO/mini/
Ext2fs-Undeletion-Dir-Struct/index.html).

21.8. Recovering from a System Freeze

When stuck in a “freeze”, your computer does not respond to commands anymore and input devices like
keyboard and mouse seem to be blocked. This is a worst case scenario and could mean that you have a very
severe error in either your configuration, your software or your hardware. We will show you how to deal with
this annoying situation.

In the case of a system freeze, your top priority should be trying to shutdown your system properly. We
assume you are under X. Now try these steps consecutively:

1. Try to kill the X server by pressing the Ctrl-Alt-Backspace keys.

2. Try to switch to another console by pressing the Ctrl-Alt-Fn keys (where n is the console number, from 1
to 6). If you succeed, login as root and issue the command: kill -15 $(pidof X) or the command kill
-9 $(pidof X), if the first command shows no effect. (Check with top to see if X is still running).

3. If you are part of a local network, try to use ssh to connect into your machine from another box. It is
advisable to ssh into the remote machine as an unprivileged user and then use the su command to become
root.

4. If the system does not respond to any of these steps, you have to go through the SysRq (System Request)
sequence. The SysRq sequence involves pressing three keys at once: the left Alt key, the SysRq key (labeled
Print Screen on older keyboards) and a letter key.

a. Alt-SysRq-R puts the keyboard in “raw” mode. Now try pressing Alt-Ctrl-Backspace again to kill X.
If that doesn’t work, carry on.

b. Alt-SysRq-S attempts to write all unsaved data to disk (“sync” the disk).

c. Alt-SysRq-E sends a termination signal to all processes, except for init.

d. Alt-SysRq-I sends a kill signal to all processes, except for init.

e. Alt-SysRq-U attempts to re-mount all mounted file systems read-only. This removes the “dirty flag”
and will avoid a file system check upon reboot.

f. Alt-SysRq-B reboots the system. You might just as well press the “reset” button on your machine.

Remember that this is a sequence, i.e. you have to press one com-
bination after the other in the right order: Raw, Sync, tErm, kIll,
Umount, reBoot3. Read the kernel documentation for more infor-
mation on this feature.

5. If none of the above helps, cross your fingers and press the “reset” switch on your machine. If you are
lucky, GNU/Linux will just run a disk check upon reboot.
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By all means, try to find out what causes these lockups because they can do severe damage to the file system.
You might also want to consider using one of the journaling file systems included in Mandrakelinux: ext3,
ReiserFS, etc. which handle such failures more gracefully. However, replacing ext2FS with ext3 or ReiserFS
requires reformatting your partitions.

21.9. Killing Misbehaving Apps

Well, this one is not so hard after all. Actually, it is not likely that you will need it but just in case you do... You
have many ways to do it. You can do it by finding the PID of the program which stopped responding, and
then using the kill command to terminate it, or you can use the xkill tool or other graphical tools such as
the ones that show the process tree.

21.9.1. From the Console

The first thing to do to terminate a misbehaving program is to find its PID, or process ID. To do so, execute the
following from a console: ps aux | grep mozilla, supposing that Mozilla is the misbehaving program. You
will get something like the following:

peter 3505 7.7 23.1 24816 15076 pts/2 Z 21:29 0:02 /usr/lib/mozilla

This tells us, among other things, that Mozilla was started by user peter and that its PID is 3505.

Now that we have the PID of the misbehaving program, we can execute the kill command to terminate it.
So we execute the following: kill -9 3505, and that’s it! Mozilla will get killed. Note that this is only to be
used when the program doesn’t respond to your input anymore. Don’t use it as a standard means to exit from
applications.

Actually, what we have done was send the KILL signal to the process number 3505. The kill command accepts
other signals besides KILL, so you can have greater control over your processes. For more info, see kill(1).

21.9.2. Using Graphical Monitoring Tools

You can also use the graphical process’ status tools (like KPM, KSySGuard, and GTOP to name a few) which
allow you to point to the process name and with one click send that process a signal or just kill that process.

21.10. Miscellaneous

Some considerations on newer hardware like legacy-free systems, nVidia 3D graphics accelerator cards, and
other things that do not fit in the preceding sections...

Legacy-Free Systems. Hardware manufacturers have recently introduced what they call “legacy-free sys-
tems”, mainly on laptops4. This basically means that the BIOS has been considerably reduced to allow you
only to choose which media to boot from. In some cases, GNU/Linux will be able to configure everything
properly. In other cases, you will have to apply the kernel’s ACPI patch.

nVidia 3D Graphics Cards. Computers with nVidia graphics cards need a patched kernel to be able to use
OpenGL hardware 3D acceleration on OpenGL-compatible applications. If you own a Mandrakelinux –– Po-
werPack Edition, the kernel should have been installed by DrakX. However if this is not so in your case, please
get and install the corresponding packages, either from nVidia’s web site (http://www.nvidia.com) or the
RPM packages from Mandrakeclub (http://www.mandrakeclub.com), and run Mandrakelinux Control Center
and re-configure X from there.

4. Refer to the great Linux on Laptops (http://www.linux-laptop.net) web site for more information on your laptop
make/model.
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nVidia RPMs are experimental and, as such, are not supported by
Mandrakesoft. However, they do work very well on most systems.

My Computer is “slow”. If you notice your computer is really slow, or slower than with previous Mandrakeli-
nux versions, you might overcome this “problem” by disabling ACPI support. To do so, add the following to
your /etc/lilo.conf file:

append=" acpi=off"

If the file already has an append= line, only add acpi=off at its end. Running lilo -v as root and rebooting
your computer will make the changes effective.

21.11. Mandrake’s Specific Troubleshooting Tools

Each administration tool (the ones started from Mandrakelinux Control Center) is a potential trouble fixing tool.
You can use all these tools to revert configuration changes, to add or remove software, to update your system
with the latest fixes from Mandrakesoft, etc.

If you think you have found a bug in any of our tools, please feel free to submit a bug report using Drakbug,
our automated bug report tool.

21.12. Final Thoughts

As you have seen there are many more ways to recover from an emergency than by re-installing the whole
system again5. Sure, you need a little expertise in applying some of the techniques described in this chapter,
but with a little practice you will gain such expertise. However, we hope that you will never need to really
master these techniques ... although it does not hurt to know them. We hope that the instructions and examples
given will be useful when you are in need. Good luck recovering from an emergency!

5. The usual way to fix things in some other operating systems...

190



Appendix A. The GNU General Public License

The following text is the GPL license that applies to most programs found in Mandrakelinux distributions.

Version 2, June 1991 Copyright (C) 1989, 1991 Free Software Foundation, Inc. 59 Temple Place - Suite 330,
Boston, MA 02111-1307, USA

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not
allowed.

A.1. Preamble

The licenses for most software are designed to take away your freedom to share and change it. By contrast, the
GNU General Public License is intended to guarantee your freedom to share and change free software –– to
make sure the software is free for all its users. This General Public License applies to most of the Free Software
Foundation’s software and to any other program whose authors commit to using it. (Some other Free Software
Foundation software is covered by the GNU Library General Public License instead.) You can apply it to your
programs, too.

When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are
designed to make sure that you have the freedom to distribute copies of free software (and charge for this
service if you wish), that you receive source code or can get it if you want it, that you can change the software
or use pieces of it in new free programs; and that you know you can do these things.

To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to ask you
to surrender the rights. These restrictions translate to certain responsibilities for you if you distribute copies
of the software, or if you modify it.

For example, if you distribute copies of such a program, whether gratis or for a fee, you must give the recipients
all the rights that you have. You must make sure that they, too, receive or can get the source code. And you
must show them these terms so they know their rights.

We protect your rights with two steps:

1. copyright the software, and

2. offer you this license which gives you legal permission to copy, distribute and/or modify the software.

Also, for each author’s protection and ours, we want to make certain that everyone understands that there
is no warranty for this free software. If the software is modified by someone else and passed on, we want its
recipients to know that what they have is not the original, so that any problems introduced by others will not
reflect on the original authors’ reputations.

Finally, any free program is threatened constantly by software patents. We wish to avoid the danger that redis-
tributors of a free program will individually obtain patent licenses, in effect making the program proprietary.
To prevent this, we have made it clear that any patent must be licensed for everyone’s free use or not licensed
at all.

The precise terms and conditions for copying, distribution and modification follow.

A.2. Terms and conditions for copying, distribution and modification

• 0. This License applies to any program or other work which contains a notice placed by the copyright holder
saying it may be distributed under the terms of this General Public License. The “Program”, below, refers to
any such program or work, and a “work based on the Program” means either the Program or any derivative
work under copyright law: that is to say, a work containing the Program or a portion of it, either verbatim or
with modifications and/or translated into another language. (Hereinafter, translation is included without
limitation in the term “modification”.) Each licensee is addressed as “you”.

Activities other than copying, distribution and modification are not covered by this License; they are outside
its scope. The act of running the Program is not restricted, and the output from the Program is covered only
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if its contents constitute a work based on the Program (independent of having been made by running the
Program). Whether that is true depends on what the Program does.

• 1. You may copy and distribute verbatim copies of the Program’s source code as you receive it, in any me-
dium, provided that you conspicuously and appropriately publish on each copy an appropriate copyright
notice and disclaimer of warranty; keep intact all the notices that refer to this License and to the absence of
any warranty; and give any other recipients of the Program a copy of this License along with the Program.

You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty
protection in exchange for a fee.

• 2. You may modify your copy or copies of the Program or any portion of it, thus forming a work based
on the Program, and copy and distribute such modifications or work under the terms of Section 1 above,
provided that you also meet all of these conditions:

1. You must cause the modified files to carry prominent notices stating that you changed the files and the
date of any change.

2. You must cause any work that you distribute or publish, that in whole or in part contains or is derived
from the Program or any part thereof, to be licensed as a whole at no charge to all third parties under
the terms of this License.

3. If the modified program normally reads commands interactively when run, you must cause it, when
started running for such interactive use in the most ordinary way, to print or display an announcement
including an appropriate copyright notice and a notice that there is no warranty (or else, saying that you
provide a warranty) and that users may redistribute the program under these conditions, and telling
the user how to view a copy of this License. (Exception: if the Program itself is interactive but does not
normally print such an announcement, your work based on the Program is not required to print an
announcement.)

These requirements apply to the modified work as a whole. If identifiable sections of that work are not de-
rived from the Program, and can be reasonably considered independent and separate works in themselves,
then this License, and its terms, do not apply to those sections when you distribute them as separate works.
But when you distribute the same sections as part of a whole which is a work based on the Program, the
distribution of the whole must be on the terms of this License, whose permissions for other licensees extend
to the entire whole, and thus to each and every part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you;
rather, the intent is to exercise the right to control the distribution of derivative or collective works based on
the Program.

In addition, mere aggregation of another work not based on the Program with the Program (or with a work
based on the Program) on a volume of a storage or distribution medium does not bring the other work
under the scope of this License.

• 3. You may copy and distribute the Program (or a work based on it, under Section 2) in object code or
executable form under the terms of Sections 1 and 2 above provided that you also do one of the following:

1. Accompany it with the complete corresponding machine-readable source code, which must be distribu-
ted under the terms of Sections 1 and 2 above on a medium customarily used for software interchange;
or,

2. Accompany it with a written offer, valid for at least three years, to give any third party, for a charge no
more than your cost of physically performing source distribution, a complete machine-readable copy of
the corresponding source code, to be distributed under the terms of Sections 1 and 2 above on a medium
customarily used for software interchange; or,

3. Accompany it with the information you received as to the offer to distribute corresponding source code.
(This alternative is allowed only for noncommercial distribution and only if you received the program
in object code or executable form with such an offer, in accord with Subsection b above.)

The source code for a work means the preferred form of the work for making modifications to it. For an
executable work, complete source code means all the source code for all modules it contains, plus any asso-
ciated interface definition files, plus the scripts used to control compilation and installation of the executable.

192



Appendix A. The GNU General Public License

However, as a special exception, the source code distributed need not include anything that is normally dis-
tributed (in either source or binary form) with the major components (compiler, kernel, and so on) of the
operating system on which the executable runs, unless that component itself accompanies the executable.

If distribution of executable or object code is made by offering access to copy from a designated place, then
offering equivalent access to copy the source code from the same place counts as distribution of the source
code, even though third parties are not compelled to copy the source along with the object code.

• 4. You may not copy, modify, sublicense, or distribute the Program except as expressly provided under this
License. Any attempt otherwise to copy, modify, sublicense or distribute the Program is void, and will au-
tomatically terminate your rights under this License. However, parties who have received copies, or rights,
from you under this License will not have their licenses terminated so long as such parties remain in full
compliance.

• 5. You are not required to accept this License, since you have not signed it. However, nothing else grants you
permission to modify or distribute the Program or its derivative works. These actions are prohibited by law
if you do not accept this License. Therefore, by modifying or distributing the Program (or any work based
on the Program), you indicate your acceptance of this License to do so, and all its terms and conditions for
copying, distributing or modifying the Program or works based on it.

• 6. Each time you redistribute the Program (or any work based on the Program), the recipient automatically
receives a license from the original licensor to copy, distribute or modify the Program subject to these terms
and conditions. You may not impose any further restrictions on the recipients’ exercise of the rights granted
herein. You are not responsible for enforcing compliance by third parties to this License.

• 7. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not
limited to patent issues), conditions are imposed on you (whether by court order, agreement or otherwise)
that contradict the conditions of this License, they do not excuse you from the conditions of this License.
If you cannot distribute so as to satisfy simultaneously your obligations under this License and any other
pertinent obligations, then as a consequence you may not distribute the Program at all. For example, if a
patent license would not permit royalty-free redistribution of the Program by all those who receive copies
directly or indirectly through you, then the only way you could satisfy both it and this License would be to
refrain entirely from distribution of the Program.

If any portion of this section is held invalid or unenforceable under any particular circumstance, the balance
of the section is intended to apply and the section as a whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or other property right claims
or to contest validity of any such claims; this section has the sole purpose of protecting the integrity of
the free software distribution system, which is implemented by public license practices. Many people have
made generous contributions to the wide range of software distributed through that system in reliance on
consistent application of that system; it is up to the author/donor to decide if he or she is willing to distribute
software through any other system and a licensee cannot impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this
License.

• 8. If the distribution and/or use of the Program is restricted in certain countries either by patents or by
copyrighted interfaces, the original copyright holder who places the Program under this License may add
an explicit geographical distribution limitation excluding those countries, so that distribution is permitted
only in or among countries not thus excluded. In such case, this License incorporates the limitation as if
written in the body of this License.

• 9. The Free Software Foundation may publish revised and/or new versions of the General Public License
from time to time. Such new versions will be similar in spirit to the present version, but may differ in detail
to address new problems or concerns.

Each version is given a distinguishing version number. If the Program specifies a version number of this Li-
cense which applies to it and "any later version", you have the option of following the terms and conditions
either of that version or of any later version published by the Free Software Foundation. If the Program
does not specify a version number of this License, you may choose any version ever published by the Free
Software Foundation.
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• 10. If you wish to incorporate parts of the Program into other free programs whose distribution condi-
tions are different, write to the author to ask for permission. For software which is copyrighted by the Free
Software Foundation, write to the Free Software Foundation; we sometimes make exceptions for this. Our
decision will be guided by the two goals of preserving the free status of all derivatives of our free software
and of promoting the sharing and reuse of software generally.

NO WARRANTY

• 11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE
PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STA-
TED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM
“AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTI-
CULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM
IS WITH YOU. SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NE-
CESSARY SERVICING, REPAIR OR CORRECTION.

• 12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL
ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE
THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GE-
NERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR
INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA
BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILU-
RE OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER OR
OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS
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account
on a UNIX system, the combination of a name, a personal directory, a password and a shell which allows
a user to connect to this system.

alias
a mechanism used in a shell in order to make it substitute one string for another before executing the
command. You can see all aliases defined in the current session by typing alias at the prompt.

APM
Advanced Power Management. A feature used by some BIOSes in order to make the machine enter a
standby state after a given period of inactivity. On laptops, APM is also responsible for reporting the
battery status and (if supported) the estimated remaining battery life.

ARP
Address Resolution Protocol. The Internet protocol used to dynamically map an Internet address to a phy-
sical (hardware) address on a local area network. This is limited to networks that support hardware
broadcasting.

ASCII
American Standard Code for Information Interchange. The standard code used for storing characters, inclu-
ding control characters, on a computer. Many 8-bit codes (such as ISO 8859-1, the Linux default character
set) contain ASCII as their lower half.
See Also: ISO 8859.

assembly language
is the programming language that is closest to the computer, which is why it’s called a “low level” pro-
gramming language. Assembly has the advantage of speed since assembly programs are written in terms
of processor instructions so little or no translation is needed when generating executables. Its main di-
sadvantage is that it is processor (or architecture) dependent. Writing complex programs is very time-
consuming as well. So, assembly is the fastest programming language, but it isn’t portable between
architectures.

ATAPI
(“AT Attachment Packet Interface”) An extension to the ATA specification (“Advanced Technology At-
tachment”, more commonly known as IDE, Integrated Drive Electronics) which provides additional com-
mands to control CD-ROM drives and magnetic tape drives. IDE controllers equipped with this extension
are also referred to as EIDE (Enhanced IDE) controllers.

ATM
This is an acronym for Asynchronous Transfer Mode. An ATM network packages data into standard
size blocks (53 bytes: 48 for the data and 5 for the header) that it can be conveyed efficiently from point to
point. ATM is a circuit switched packet network technology oriented towards high speed (multi-megabit)
optical networks.

atomic
a set of operations is said to be atomic when they execute all at once and cannot be preempted.

background
in shell context, a process is running in the background if you can type commands that are captured by
the process while it is running.
See Also: job, foreground.

backup
is a means of saving your important data to a safe medium and location. Backups should be done regu-
larly, especially with more critical information and configuration files (the most important directories to
backup are /etc, /home and /usr/local). Traditionally, many people use tar with gzip or bzip2 to bac-
kup directories and files. You can use these tools or programs like dump and restore, along with many
other free or commercial backup solutions.

batch
is a processing mode where jobs which are submitted to the CPU are executed sequentially until all the
jobs have been processed.
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beep
is the little noise your computer’s speaker emits to warn you of some ambiguous situation when you’re
using command completion and, for example, there’s more than one possible choice for completion.
There might be other programs that make beeps to let you know of some particular situation.

beta testing
is the name given to the process of testing the beta version of a program. Programs usually get released
in alpha and beta states for testing prior to final release.

binary
in the context of programming, binaries are the compiled, executable code.

bit
stands for BInary digiT. A single digit which can take the values 0 or 1, because calculation is done in base
two.

block mode files
files whose contents are buffered. All read/write operations for such files go through buffers, which
allow for asynchronous writes on the underlying hardware, and for reads, which allows the system to
avoid disk access if the data is already in a buffer.
See Also: buffer, buffer cache, character mode files.

boot
the procedure taking place when a computer is switched on, where peripherals are recognized sequen-
tially and where the operating system is loaded into memory.

bootdisk
a bootable floppy disk containing the code necessary to load the operating system from the hard disk
(sometimes it is self-sufficient).

bootloader
is a program which starts the operating system. Many bootloaders give you the opportunity to load more
than one operating system by allowing you choose between them from a menu. Bootloaders like GRUB
and LILO are popular because of this feature and are very useful in dual- or multi-boot systems.

BSD
Berkeley Software Distribution. A UNIX variant developed at the Berkeley University computing depart-
ment. This version has always been considered more technically advanced than the others, and has
brought many innovations to the computing world in general and to UNIX in particular.

buffer
a small portion of memory with a fixed size, which can be associated with a block mode file, a system
table, a process and so on. The buffer cache maintains coherency of all buffers.
See Also: buffer cache.

buffer cache
a crucial part of an operating system kernel, it is in charge of keeping all buffers up-to-date, shrinking
the cache when needed, clearing unneeded buffers and more.
See Also: buffer.

bug
illogical or incoherent behavior of a program in a special case, or a behavior that does not follow the
documentation or accepted standards issued for the program. Often, new features introduce new bugs
in a program. Historically, this term comes from the old days of punch cards: a bug (the insect!) slipped
into a hole of a punch card and, as a consequence, the program misbehaved. Admiral Grace Hopper,
having discovered this, declared “It’s a bug!”, and since then the term has remained. Note that this is
only one of the many stories which attempt to explain the term bug.

byte
eight consecutive bits, which when interpreted in base ten result in a number between 0 and 255.
See Also: bit.

case
when taken in the context of strings, the case is the difference between lowercase letters and uppercase
(or capital) letters.
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CHAP
Challenge-Handshake Authentication Protocol: protocol used by ISPs to authenticate their clients. In this
scheme, a value is sent to the client (the machine making the connection), which it uses to calculate a hash
based on the value. The client sends the hash back to the server for comparison to the hash calculated by
the server. This authentication method is different to PAP in that it re- authenticates on a periodic basis
after the initial authentication.
See Also: PAP.

character mode files
files whose content is not buffered. When associated with physical devices, all input/output on these
devices is performed immediately. Some special character devices are created by the operating system
(/dev/zero, /dev/null and others). They correspond to data flows.
See Also: block mode files.

CIFS
Common Internet File System The successor to the SMB file system, used on DOS systems.

client
program or computer which periodically connects to another program or computer to give it orders or
ask for information. In the case of peer to peer systems such as SLIP or PPP the client is taken to be the
end that initiates the connection and the remote end receiving the call is designated as the server. It is
one of the components of a client/server system.

client/server system
system or protocol consisting of a server and one or several clients.

command line
provided by a shell and which allows the user to type commands directly. Also subject of an eternal
“flame war” between its supporters and its detractors.

command mode
under Vi or one of its clones, it is the state of the program in which pressing a key will not insert the
character in the file being edited, but instead performs an action specific to the key (unless the clone has
re-mappable commands and you have customized your configuration). You may get out of it typing one
of the “back to insertion mode” commands: i, I, a, A, s, S, o, O, c, C, ...

compilation
is the process of translating source code that is human readable (well, with some training) and that is
written in some programming language (C, for example) into a binary file that is machine readable.

completion
the ability of a shell to automatically expand a substring to a filename, user name or other item, as long
as there is a match.

compression
is a way to shrink files or decrease the number of characters sent over a communications connection.
Some file compression programs include compress, zip, gzip, and bzip2.

console
is the name given to what used to be called terminals. They were the machines (a screen plus a keyboard)
connected to one big central mainframe. On PC s, the physical terminal is the keyboard and screen.
See Also: virtual console.

cookies
temporary files written on the local hard disk by a remote web server. It allows for the server to be aware
of a user’s preferences when this user connects again.

datagram
A datagram is a discrete package of data and headers which contain addresses, which is the basic unit of
transmission across an IP network. You might also hear this called a “packet”.

dependencies
are the stages of compilation that need to be satisfied before going on to other compilation stages in order
to successfully compile a program. This term is also used where one set of programs you wish to install
are dependent on other programs which may or may not be installed on your system, in which case you
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may get a message telling you that the system needs to “satisfy dependencies” in order to continue the
installation.

desktop
If you’re using the X Window System, the desktop is the place on the screen where you work and upon
which your windows and icons are displayed. It is also called the background, and is usually filled with
a simple color, a gradient color or even an image.
See Also: virtual desktops.

DHCP
Dynamic Host Configuration Protocol. A protocol designed for machines on a local network to dynamically
get an IP address from a DHCP server.

directory
Part of the file system structure. Files or other directories can be stored within a directory. Sometimes
there are sub-directories (or branches) within a directory. This is often referred to as a directory tree. If
you want to see what’s inside another directory, you will either have to list it or change to it. Files inside a
directory are referred to as leaves while sub-directories are referred to as branches. Directories follow the
same restrictions as files although the permissions mean different things. The special directories . and
.. refer to the directory itself and to the parent directory respectively.

discrete values
are values that are non-continuous. That is, there’s some kind of “spacing” between two consecutive
values.

distribution
is a term used to distinguish one GNU/Linux manufacturers product from another. A distribution is made
up of the core Linux kernel and utilities, as well as installation programs, third-party programs, and
sometimes proprietary software.

DLCI
The DLCI is the Data Link Connection Identifier and is used to identify a unique virtual point to point
connection via a Frame Relay network. The DLCI’s are normally assigned by the Frame Relay network
provider.

DMA
Direct Memory Access. A facility used in the PC architecture which allows a peripheral to read or write
from main memory without the help of the CPU. PCI peripherals use bus mastering and do not need
DMA.

DNS
Domain Name System. The distributed name and address mechanism used in the Internet. This mechanism
allows you to map a domain name to an IP address, allowing you to look up a site by domain name
without knowing the IP address of the site. DNS also allows reverse lookup, allowing you to obtain
machine’s IP address from its name.

DPMS
Display Power Management System. Protocol used by all modern monitors to manage power saving featu-
res. Monitors supporting these features are commonly called “green” monitors.

echo
occurs when the characters you type in a user name entry field, for example, are shown “as is”, instead
of showing “*” for each one you type.

editor
is a term typically used for programs that edit text files (aka text editor). The most well-known GNU/Linux
editors are the GNU Emacs (Emacs) editor and the UNIX editor Vi.

ELF
Executable and Linking Format. This is the binary format used by most GNU/Linux distributions.

email
stands for Electronic Mail. This is a way to send messages electronically between people on the same
network. Similar to regular mail (aka snail mail), email needs a destination and sender address to be
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sent properly. The sender must have an address like “sender@senders.domain” and the recipient must
have an address like “recipient@recipients.domain.” Email is a very fast method of communication and
typically only takes a few minutes to reach anyone, regardless of where in the world they are located. In
order to write email, you need an email client such as pine or mutt which are text-mode clients, or GUI
clients such as KMail.

environment
is the execution context of a process. It includes all the information that the operating system needs to
manage the process and what the processor needs to execute the process properly.
See Also: process.

environment variables
a part of a process’ environment. Environment variables are directly viewable from the shell.
See Also: process.

escape
in the shell context, is the action of surrounding a string between quotes to prevent the shell from inter-
preting that string. For example, when you need to use spaces in a command line and pipe the results
to some other command you have to put the first command between quotes (“escape” the command)
otherwise the shell will interpret it incorrectly and it won’t work as expected.

ext2
short for the “Extended 2 file system”. This is GNU/Linux’s native file system and has the characteristics
of any UNIX file system: support for special files (character devices, symbolic links, etc), file permissions
and ownership, and other features.

FAQ
Frequently Asked Questions. A document containing a series of questions and answers about a specific
topic. Historically, FAQs appeared in newsgroups, but this sort of document now appears on various web
sites, and even commercial products have FAQs. Generally, they are very good sources of information.

FAT
File Allocation Table. File system used by DOS and Windows.

FDDI
Fiber Distributed Digital Interface. A high-speed network physical layer, which uses optical fiber for com-
munication. Mostly used on large networks, mainly because of its price. It is rarely seen as a means of
connection between a PC and a network switch.

FHS
File system Hierarchy Standard. A document containing guidelines for a coherent file tree organization on
UNIX systems. Mandrakelinux complies with this standard in most aspects.

FIFO
First In, First Out. A data structure or hardware buffer where items are taken out in the order they were
put in. UNIX pipes are the most common examples of FIFO s.

filesystem
scheme used to store files on a physical media (hard drive, floppy) in a consistent manner. Examples of
file systems are FAT, GNU/Linux’ ext2fs, ISO9660 (used by CD-ROMs) and so on. An example of a virtual
filesystem is the /proc filesystem.

firewall
a machine or a dedicated piece of hardware that in the topology of a local network is the single connection
point to the outside network, and which filters, controls the activity on some ports, or makes sure that
only some specific interfaces may have access to the outside world.

flag
is an indicator (usually a bit) that is used to signal some condition to a program. For example, a filesystem
has, among others, a flag indicating if it has to be dumped in a backup, so when the flag is active the
filesystem gets backed up, and when it’s inactive it doesn’t.

focus
the state for a window to receive keyboard events (such as key-presses, key-releases and mouse clicks)
unless they are trapped by the window manager.
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foreground
in shell context, the process in the foreground is the one that is currently running. You have to wait for
such a process to finish in order to be able to type commands again.
See Also: job, background.

Frame Relay
Frame Relay is a network technology ideally suited to carrying traffic which is of bursty or sporadic
nature. Network costs are reduced by having many Frame Relay customers sharing the same network
capacity and relying on them wanting to make use of the network at slightly different times.

framebuffer
projection of a video card’s RAM into the machine’s address space. This allows for applications to access
the video RAM without the chore of having to talk to the card. All high-end graphical workstations use
frame buffers.

FTP
File Transfer Protocol. This is the standard Internet protocol used to transfer files from one machine to
another.

full-screen
This term is used to refer to applications that take up the entire visible area of your display.

gateway
link connecting two IP networks.

GFDL
The GNU Free Documentation License. The license which applies to all Mandrakelinux documentation.

GIF
Graphics Interchange Format. An image file format, widely used on the web. GIF images may be compres-
sed or animated. Due to copyright problems it is a bad idea to use them, so the recommended solution is
to replace them as much as possible by the PNG format.

globbing
in the shell, the ability to group a certain set of filenames with a globbing pattern.
See Also: globbing pattern.

globbing pattern
a string made of normal characters and special characters. Special characters are interpreted and expan-
ded by the shell.

GNU
GNU’s Not Unix. The GNU project was initiated by Richard Stallman at the beginning of the 1980s, and
aimed at developing a free operating system (“free” as in “free speech”). Currently, all tools are there,
except... the kernel. The GNU project kernel, Hurd, is not rock solid yet. Linux borrows, among others,
two things from GNU: its C compiler, gcc, and its license, the GPL.
See Also: GPL.

GPL
General Public License. The license of the GNU/Linux kernel, it goes the opposite way of all proprietary
licenses in that it applies no restrictions as to copying, modifying and redistributing the software, as long
as the source code is made available. The only restriction is that the persons to whom you redistribute it
must also benefit from the same rights.

GUI
Graphical User Interface. Interface to a computer consisting of windows with menus, buttons, icons and so
on. A great majority of users prefer a GUI to a CLI (Command Line Interface) for ease of use, even though
the latter is far more versatile.

guru
An expert. Used to qualify someone particularly skilled, but also of valuable help for others.

hardware address
This is a number that uniquely identifies a host in a physical network at the media access layer. Examples
of this are Ethernet Addresses and AX.25 Addresses.
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hidden file
is a file which can’t be “seen” when doing a ls command with no options. Hidden files’ filenames be-
gin with a . and are used to store the user’s personal preferences and configurations for the different
programs (s)he uses. For example, bash’s command history is saved into .bash_history, a hidden file.

home directory
often abbreviated as “home”, this is the name for the personal directory of a given user.
See Also: account.

host
refers to a computer and is commonly used when talking about computers that are connected to a net-
work.

HTML
HyperText Markup Language. The language used to create web documents.

HTTP
HyperText Transfer Protocol. The protocol used to connect to web sites and retrieve HTML documents or
files.

icon
is a little drawing (normally sized 16x 16, 32x 32, 48x 48 and sometimes 64x 64 pixels) which in a graphical
environment represents a document, a file or a program.

IDE
Integrated Drive Electronics. The most widely used bus on today’s PC s for hard disks. An IDE bus may
contain up to two devices, and the speed of the bus is limited by the device on the bus with the slower
command queue (and not the slower transfer rate!).
See Also: ATAPI.

IP masquerading
This is a technique where a firewall is used to hide your computer’s true IP address from the outside.
Typically, any outside network connections you make through the firewall will inherit the firewall’s IP
address. This is useful in situations where you may have a fast Internet connection with only one IP
address but wish to use more than one computer on your internal network.

inode
entry point leading to the contents of a file on a UNIX-like filesystem. An inode is identified in a unique
way by a number, and contains meta-information about the file it refers to, such as its access times, its
type, its size, but not its name!

insert mode
under Vi or any of its clones, it is the state of the program in which pressing a key will insert that character
in the file being edited (except pathological cases like the completion of an abbreviation, right justify at
the end of the line, ...). One gets out of it pressing the key Esc (or Ctrl-[).

Internet
is a huge network that connects computers around the world.

IP address
is a numeric address consisting of four parts which identifies your computer on the Internet. IP addresses
are structured in a hierarchical manner, with top level and national domains, domains, sub-domains and
each machine’s personal address. An IP address will look something like 192.168.0.1. A machine’s
personal address can be one of two types: static or dynamic. Static IP addresses are addresses which
never change, they are permanently assigned.. Dynamic IP addresses mean that an IP address will change
with each new connection to the network. Dial-up and cable modem users typically have dynamic IP
addresses while some DSL and other high-speed connections provide static IP addresses.

IRC
Internet Relay Chat. One of the few Internet standards for live speech. It allows for channel creation,
private talks and file exchange. It also allows servers to connect to each other, which is why several IRC
networks exist today: Undernet, DALnet, EFnet to name a few.
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IRC channels
are the “places” inside IRC servers where you can chat with other people. Channels are created in IRC
servers and users join those channels so they can communicate with each other. Messages written on one
channel are only visible to the people connected to that channel. Two or more users can create a “private”
channel so they don’t get disturbed by other users. Channel names begin with a #.

ISA
Industry Standard Architecture. The very first bus used on PC s, it is slowly being abandoned in favor of
the PCI bus. ISA is still commonly found on SCSI cards supplied with scanners, CD writers and some
other older hardware.

ISDN
Integrated Services Digital Network. A set of communication standards for voice, digital network services
and video. It has been designed to eventually replace the current phone system, known as PSTN (Public
Switched Telephone Network) or POTS (Plain Ole Telephone Service). ISDN is known as a circuit switched
data network.

ISO
International Standards Organization. A group of companies, consultants, universities and other sources
which enumerates standards in various disciplines, including computing. The papers describing stan-
dards are numbered. The standard number iso9660, for example, describes the file system used on CD-
ROMs.

ISO 8859
The ISO 8859 standard includes several 8-bit extensions to the ASCII character set. Especially important
is ISO 8859-1, the “Latin Alphabet No. 1”, which has become widely implemented and may already be
seen as the de facto standard ASCII replacement.
ISO 8859-1 supports the following languages: Afrikaans, Basque, Catalan, Danish, Dutch, English, Faroe-
se, Finnish, French, Galician, German, Icelandic, Irish, Italian, Norwegian, Portuguese, Scottish, Spanish,
and Swedish.
Note that the ISO 8859-1 characters are also the first 256 characters of ISO 10646 (Unicode). However, it
lacks the EURO symbol and does not fully cover Finnish and French. ISO 8859-15 is a modification of
ISO 8859-1 to covers these needs.
See Also: ASCII.

ISP
Internet Service Provider. A company which sells Internet access to its customers, either over telephone
lines or high-bandwidth circuits such as dedicated T-1 circuits, DSL or cable.

JPEG
Joint Photographic Experts Group. Another very common image file format. JPEG is mostly suited for com-
pressing real-world scenes, and does not work very well on non-realistic images.

job
in a shell context, a job is a process running in the background. You can have several jobs in the same shell
and control these jobs independently.
See Also: foreground, background.

kernel
is the core of the operating system. The kernel is responsible for allocating resources and separating
processes from each other. It handles all of the low-level operations which allow programs to talk directly
to the hardware on your computer, manages the buffer cache and so on.

kill ring
under Emacs, it is the set of text areas cut or copied since the editor was started. The text areas may be
recalled to be inserted again, and the structure is ring-like.

LAN
Local Area Network. Generic name given to a network of machines connected to the same physical wire.

launch
is the action of invoking, or starting, a program.
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LDP
Linux Documentation Project. A nonprofit organization that maintains GNU/Linux documentation. It’s
mostly known for documents like HOWTOs, but it also maintains FAQ s, and even a few books.

library
is a collection of procedures and functions in binary form to be used by programmers in their programs
(as long as the library’s license allows them to do so). The program in charge of loading shared libraries
at run time is called the dynamic linker.

link
reference to an inode in a directory, therefore giving a (file) name to the inode. Examples of inodes which
don’t have a link (and hence have no name) are: anonymous pipes (as used by the shell), sockets (aka
network connections), network devices and so on.

linkage
last stage of the compile process, consisting of linking together all object files in order to produce an
executable file, and matching unresolved symbols with dynamic libraries (unless a static linkage has
been requested, in which case the code of these symbols will be included in the executable).

Linux
is a UNIX-like operating system which runs on a variety of different computers, and is free for anyone to
use and modify. Linux (the kernel) was written by Linus Torvalds.

login
connection name for a user on a UNIX system, and the action to connect.

lookup table
is a table that stores corresponding codes (or tags) and their meaning. It is often a data file used by a
program to get further information about a particular item.
For example, HardDrake uses such a table to know what a manufacturer’s product code means. This is
one line from the table, giving information about item CTL0001

CTL0001 sound sb Creative Labs SB16 \

HAS_OPL3|HAS_MPU401|HAS_DMA16|HAS_JOYSTICK

loopback
virtual network interface of a machine to itself, allowing the running programs not to have to take into
account the special case where two network entities are in fact the same machine.

major
number specific to the device class.

manual page
a small document containing the definitions of a command and its usage, to be consulted with the man
command. The first thing one should (learn how to) read when learning about a command you aren’t
familiar with.

MBR
Master Boot Record. Name given to the first sector of a bootable hard drive. The MBR contains the code
used to load the operating system into memory or a bootloader (such as LILO), and the partition table of
that hard drive.

MIME
Multipurpose Internet Mail Extensions. A string of the form type/subtype describing the contents of a file
attached in an e-mail. This allows MIME -aware mail clients to define actions depending on the type of
the file.

minor
number identifying the specific device we are talking about.

MPEG
Moving Pictures Experts Group. An ISO committee which generates standards for video and audio com-
pression. MPEG is also the name of their algorithms. Unfortunately, the license for this format is very
restrictive, and as a consequence there are still no Open Source MPEG players...
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mount point
is the directory where a partition or another device is attached to the GNU/Linux filesystem. For example,
your CD-ROM is mounted in the /mnt/cdrom directory, from where you can explore the contents of any
mounted CDs.

mounted
A device is mounted when it is attached to the GNU/Linux filesystem. When you mount a device you can
browse its contents. This term is partly obsolete due to the “supermount” feature, so users do not need
to manually mount removable media.
See Also: mount point.

MSS
The Maximum Segment Size (MSS) is the largest quantity of data which can be transmitted at one time.
If you want to prevent local fragmentation MSS would equal MTU-IP header.

MTU
The Maximum Transmission Unit (MTU) is a parameter which determines the largest datagram than
can be transmitted by an IP interface without it needing to be broken down into smaller units. The MTU
should be larger than the largest datagram you wish to transmit un-fragmented. Note, this only prevents
fragmentation locally, some other link in the path may have a smaller MTU and the datagram will be
fragmented there. Typical values are 1500 bytes for an Ethernet interface, or 576 bytes for a PPP interface.

multitasking
the ability of an operating system to share CPU time between several processes. At a low level, this is also
known as multiprogramming. Switching from one process to another requires that all the current process
context be saved and restored when this process runs again. This operation is called a context switch, and
on Intel, is done 100 times per second, thereby making it fast enough so that a user has the illusion that
the operating system runs several applications at the same time. There are two types of multitasking:
in preemptive multitasking the operating system is responsible for taking away the CPU and passing
it to another process; cooperative multitasking is where the process itself gives back the CPU. The first
variant is obviously the better choice because no program can consume the entire CPU time and block
other processes. GNU/Linux performs preemptive multitasking. The policy to select which process should
be run, depending on several parameters, is called scheduling.

multiuser
is used to describe an operating system which allows multiple users to log into and use the system at the
exact same time, each being able to do their own work independent of other users. A multitasking ope-
rating system is required to provide multiuser support. GNU/Linux is both a multitasking and multiuser
operating system, as is any UNIX system for that matter.

named pipe
a UNIX pipe which is linked, as opposed to pipes used in shells.
See Also: pipe, link.

naming
a word commonly used in computing for a method to identify objects. You will often hear of “naming
conventions” for files, functions in a program and so on.

NCP
NetWare Core Protocol. A protocol defined by Novell to access Novell NetWare file and print services.

NFS
Network File System. A network file system created by Sun Microsystems in order to share files across a
network in a transparent way.

newsgroups
discussion and news areas which can be accessed by a news or USENET client to read and write mes-
sages specific to the topic of the newsgroup. For example, the newsgroup alt.os.linux.mandrake is an
alternate newsgroup (alt) dealing with the Operating System (OS) GNU/Linux, and specifically, Mandrake-
linux (mandrake). Newsgroups are broken down in this fashion to make it easier to search for a particular
topic.
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NIC
Network Interface Controller. An adapter installed in a computer which provides a physical connection to
a network, such as an Ethernet card.

NIS
Network Information System. NIS was also known as “Yellow Pages”, but British Telecom holds a copy-
right on this name. NIS is a protocol designed by Sun Microsystems in order to share common informa-
tion across a NIS domain, which may consist of an entire LAN, or just a part of it. It can export password
databases, service databases, groups information and more.

null, character
the character or byte number 0. It is used to mark the end of a string.

object code
is the code generated by the compilation process to be linked with other object codes and libraries to
form an executable file. Object code is machine readable.
See Also: compilation, linkage.

on the fly
Something is said to be done “on the fly” when it’s done along with something else, without you noticing
it or explicitly asking for it.

open source
is the name given to free source code of a program that is made available to the development community
and public at large. The theory behind this is that allowing source code to be used and modified by
a broader group of programmers will ultimately produce a more useful product for everyone. Some
popular open source programs include Apache, sendmail and GNU/Linux.

operating system
is the interface between the applications and the underlying hardware. The tasks for any operating sys-
tem are primarily to manage all of the machine specific resources. On a GNU/Linux system, this is done
by the kernel and loadable modules. Other well-known operating systems include AmigaOS, MacOS,
FreeBSD, OS/2, UNIX, Windows NT, and Windows 9x.

owner
in the context of users and their files, the owner of a file is the user who created that file.

owner group
in the context of groups and their files, the owner group of a file is the group to which the user who
created that file belongs.

PAP
Password Authentication Protocol. A protocol used by many ISPs to authenticate their clients. In this sche-
me, the client (you) sends an identifier/password pair to the server, but none of the information is encryp-
ted. See CHAP for the description of a more secure system.
See Also: CHAP.

pager
program displaying a text file one screen at a time, and making it easy to move back and forth and search
for strings in this file. We suggest you to use less.

password
is a secret word or combination of words or letters which is used to secure something. Passwords are
used in conjunction with user logins to multi-user operating systems, web sites, FTP sites, and so forth.
Passwords should be hard-to-guess phrases or alphanumeric combinations, and should never be based
on common dictionary words. Passwords ensure that other people cannot log into a computer or site
with your account.

patch, to patch
file containing a list of corrections to issue to source code in order to add new features, to remove bugs,
or to modify it according to one’s wishes and needs. The action consisting of the application of these
corrections to the archive of source code (aka “patching”).
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path
is an assignment for files and directories to the filesystem. The different layers of a path are separated by
the "slash" or ’/’ character. There are two types of paths on GNU/Linux systems. The relative path is the
position of a file or directory in relation to the current directory. The absolute path is the position of a file
or directory in relation to the root directory.

PCI
Peripheral Components Interconnect. A bus created by Intel which today is the standard bus for PC and
other architectures. It is the successor to ISA, and it offers numerous services: device identification, con-
figuration information, IRQ sharing, bus mastering and more.

PCMCIA
Personal Computer Memory Card International Association. More and more commonly called “PC Card”
for simplicity reasons, this is the standard for external cards attached to a laptop: modems, hard disks,
memory cards, Ethernet cards, and more. The acronym is sometimes humorously expanded to People
Cannot Memorize Computer Industry Acronyms...

pipe
a special UNIX file type. One program writes data into the pipe, and another program reads the data at
the other end. UNIX pipes are FIFO s, so the data is read at the other end in the order it was sent. Very
widely used with the shell. See also named pipe.

pixmap
is an acronym for “pixel map”. It’s another way of referring to bitmap images.

plugin
add-on program used to display or play some multimedia content found on a web document. It can
usually be easily downloaded if your browser is not yet able to display or play that kind of information.

PNG
Portable Network Graphics. Image file format created mainly for web use, it has been designed as a patent-
free replacement for GIF and also has some additional features.

PnP
Plug’N’Play. First an add-on for ISA in order to add configuration information for devices, it has become
a more widespread term which groups all devices able to report their configuration parameters. All PCI
devices are Plug’N’Play.

POP
Post Office Protocol. One common protocol used for retrieving mail from an ISP. See IMAP for an example
of another remote-access mail protocol.

porting
one of two ways to run a program on a system it was not originally intended for. For example, to be able
to run a Windows-native program under GNU/Linux (natively), it must first be ported to GNU/Linux.

PPP
Point to Point Protocol. This is the protocol used to send data over serial lines. It is commonly used to send
IP packets to the Internet, but it can also be used with other protocols such as Novell’s IPX protocol.

precedence
dictates the order of evaluation of operands in an expression. For example: If you have 4 + 3 * 2 you get
10 as the result, since the multiplication has higher precedence than the addition. If you want to evaluate
the addition first, then you have to add parenthesis like this: (4 + 3) * 2. When you do this, you’ll get
14 as the result since the parenthesis have higher precedence than the addition and the multiplication, so
the operations in parenthesis get evaluated first.

preprocessors
are compilation directives which instruct the compiler to replace those directives for code in the pro-
gramming language used in the source file. Examples of C ’s preprocessors are #include, #define, etc.

process
in the operating system context, a process is an instance of a program being executed along with its
environment.
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prompt
in a shell, this is the string before the cursor. When you see it, you can type your commands.

protocol
Protocols organize the communications between different machines across a network, either using hard-
ware or software. They define the format of transferred data, whether one machine controls another, etc.
Many well-known protocols include HTTP, FTP, TCP, and UDP.

proxy
a machine which sits between a network and the Internet, whose role is to speed up data transfers for the
most widely used protocols (for example, HTTP and FTP). It maintains a cache of previous requests, so a
machine which makes a request for something which is already cached will receive it quickly, because it
will get the information from the local cache. Proxies are very useful on low bandwidth networks (such
as modem connections). Sometimes the proxy is the only machine able to access outside the network.

pull-down menu
is a menu that is “rolled” with a button in some of its corners. When you press that button, the menu
“unrolls” itself, showing you the full menu.

quota
is a method for restricting disk usage and limits for users. Administrators can restrict the size of home
directories for a user by setting quota limits on specific file systems.

RAID
Redundant Array of Independent Disks. A project initiated at the computing science department of Berkeley
University, in which the storage of data is spread across an array of disks using different schemes. At
first, this was implemented using floppy drives, which is why the acronym originally stood for Redundant
Array of Inexpensive Disks.

RAM
Random Access Memory. Term used to identify a computer’s main memory. The “Random” here means
that any part of the memory can be directly accessed.

read-only mode
for a file means that the file cannot be written to. You can read its contents but you can’t modify them.
See Also: read-write mode.

read-write mode
for a file, it means that the file can be written to. You can read its contents and modify them.
See Also: read-only mode.

regular expression
a powerful theoretical tool which is used to search and match text strings. It lets one specify patterns
these strings must obey. Many UNIX utilities use it: sed, awk, grep, perl and others.

RFC
Request For Comments. RFC s are the official Internet standard documents, published by the IETF (Internet
Engineering Task Force). They describe all protocols, their usage, their requirements and so on. When you
want to learn how a protocol works, pick up the corresponding RFC.

root
is the superuser of any UNIX system. Typically root (aka the system administrator) is the person responsi-
ble for maintaining and supervising the UNIX system. This person also has complete access to everything
on the system.

root directory
This is the top level directory of a filesystem. This directory has no parent directory, thus ’..’ for root
points back to itself. The root directory is written as ’/’.

root filesystem
This is the top level filesystem. This is the filesystem where GNU/Linux mounts its root directory tree. It is
necessary for the root filesystem to reside in a partition of its own, as it is the basis for the whole system.
It contains the root directory.
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route
Is the path that your datagrams take through the network to reach their destination. It is the path between
one machine and another in a network.

RPM
Red Hat Package Manager. A packaging format developed by Red Hat in order to create software packages,
it is used in many GNU/Linux distributions, including Mandrakelinux.

run level
is a configuration of the system software which only allows certain selected processes to exist. Allowed
processes are defined, for each runlevel, in the file /etc/inittab. There are eight defined runlevels: 0,
1, 2, 3, 4, 5, 6, S and switching between them can only be achieved by a privileged user by means of
executing the commands init and telinit.

script
shell scripts are sequences of commands to be executed as if they were sequentially entered in the console.
shell scripts are UNIX’s (somewhat) equivalent of DOS batch files.

SCSI
Small Computers System Interface. A bus with a high throughput designed to allow for several types of pe-
ripherals to be connected to it. Unlike IDE, a SCSI bus is not limited by the speed at which the peripherals
accept commands. Only high-end machines integrate a SCSI bus directly on the motherboard, therefore
most PC s need add-on cards.

security levels
Mandrakelinux’s unique feature which allows you to set different levels of restriction according to how
secure you want to make your system. There are 6 predefined levels ranging from 0 to 5, where 5 is the
tightest security. You can also define your own security level.

segmentation fault
A segmentation fault occurs when a program tries to access memory that is not allocated to it. This
generally causes the program to stop immediately.

server
program or computer that provides a feature or service and awaits the connections from clients to execute
their orders or give them the information they ask. In the case of peer to peer systems such as SLIP or
PPP, the server is taken to be the end of the link that is called and the end calling is taken to be the client.
It is one of the components of a client/ server system.

shadow passwords
a password management suite on UNIX systems in which the file containing the encrypted passwords
is not world-readable, unlike that usually found with a normal password system. It also offers other
features such as password aging.

shell
The shell is the basic interface to the operating system kernel and provides the command line where users
enter commands to run programs and system commands. All shells provide a scripting language which
can be used to automate tasks or simplify often-used complex tasks. These shell scripts are similar to
batch files from the DOS operating system, but are much more powerful. Some example shells are bash,
sh, and tcsh.

single user
is used to describe a state of an operating system, or even an operating system itself, that only allows a
single user to log into and use the system at any time.

site dependent
means that the information used by programs like imake and make to compile some source file depends
on the site, the computer architecture, the computer’s installed libraries, and so on.

SMB
Server Message Block. Protocol used by Windows machines (9x or NT ) for file and printer sharing across a
network.
See Also: CIFS.
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SMTP
Simple Mail Transfer Protocol. This is the common protocol for transferring email. Mail Transfer Agents
such as sendmail or postfix use SMTP. They are sometimes called SMTP servers.

socket
file type corresponding to any network connection.

soft links
See: symbolic links

standard error
the file descriptor number 2, opened by every process, used by convention to print error messages to the
terminal screen.
See Also: standard input, standard output.

standard input
the file descriptor number 0, opened by every process, used by convention as the file descriptor from
which the process receives data.
See Also: standard error, standard output.

standard output
the file descriptor number 1, opened by every process, used by convention as the file descriptor in which
the process prints its output.
See Also: standard error, standard input.

streamer
is a device which takes “streams” (not interrupted or divided in shorter chunks) of characters as its input.
A typical streamer is a tape drive.

SVGA
Super Video Graphics Array. The video display standard defined by VESA for the PC architecture. The
resolution is 800x 600 x 16 colors.

switch
Switches are used to change the behavior of programs, and are also called command-line options or
arguments. To determine if a program has optional switches which may be used, read the man pages or
try to pass the --help switch to the program (i.e.. program --help).

symbolic links
are special files, containing nothing but a string which references another file. Any access to them is the
same as accessing the file whose name is the referenced string, which may or may not exist, and the path
to which can be given in a relative or an absolute way.

target
is the object of compilation, i.e. the binary file to be generated by the compiler.

TCP
Transmission Control Protocol. This is the most common reliable protocol which uses IP to transfer network
packets. TCP adds the necessary checks on top of IP to make sure that packets are delivered. Unlike
UDP, TCP works in connected mode, which means that two machines must establish a connection before
exchanging data.

telnet
creates a connection to a remote host and allows you to log into the machine, provided you have an
account. Telnet is the most widely-used method of remote logins, however there are better and more
secure alternatives, such as ssh.

theme-able
a graphical application is theme-able if it is able to change its appearance in real time. Many window
managers are theme-able.

traverse
for a directory on a UNIX system, this means that the user is allowed to go through this directory, and
possibly to directories under it. This requires that the user has the execute permission on this directory.
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URL
Uniform Resource Locator. A string with a special format used to identify a resource on the Internet in a
unique way. The resource can be a file, a server or other item. The syntax for a URL is
protocol://server.name[:port]/path/to/resource.
When only a machine name is given and the protocol is http://, it defaults to retrieving the file index.
html on the server.

username
is a name (or more generally a word) which identifies a user on a system. Each username is attached to a
unique and single UID (user ID)
See Also: login.

variables
are strings which are used in Makefile files to be replaced by their value each time they appear. Usually
they are set at the beginning of the Makefile. They are used to simplify Makefile and source files tree
management.
More generally, variables in programming are words that refer to other entities (numbers, strings, tables,
etc.) that are likely to vary while the program is executing.

verbose
For commands, the verbose mode means that the command reports to standard (or possibly error) output
all the actions it performs and the results of those actions. Sometimes, commands have a way to define
the “verbosity level”, which means that the amount of information that the command will report can be
controlled.

VESA
Video Electronics Standards Association. An industry standards association aimed at the PC architecture.
For example, it is the author of the SVGA standard.

virtual console
is the name given to what used to be called terminals. On GNU/Linux systems, you have what are called
virtual consoles which enable you to use one screen or monitor for many independently running sessions.
By default, you have six virtual consoles that can be reached by pressing ALT-F1 through ALT-F6. There
is a seventh virtual console, ALT-F7, which will permit you to reach a running X Window System. In X,
you can reach the text console by pressing CTRL-ALT-F1 through CTRL-ALT-F6.
See Also: console.

virtual desktops
In the X Window System, the window manager may provide you several desktops. This handy feature
allows you to organize your windows, avoiding the problem of having dozens of them stacked on top of
each other. It works as if you had several screens. You can switch from one virtual desktop to another in
a manner which depends on the window manager you’re using.
See Also: window manager, desktop.

WAN
Wide Area Network. This network, although similar to a LAN, connects computers on a network which is
not physically connected to the same wires and are separated by a greater distance.

wildcard
The ’*’ and ’?’ characters are used as wildcard characters and can represent anything. The ’*’ represents
any number of characters, including no characters. The ’?’ represents exactly one character. Wildcards are
often used in regular expressions.

window
In networking, the window is the largest amount of data that the receiving end can accept at a given
point in time.

window manager
the program responsible for the “look and feel” of a graphical environment, dealing with window bars,
frames, buttons, root menus, and some keyboard shortcuts. Without it, it would be hard or impossible to
have virtual desktops, to resize windows on the fly, to move them around, ...

workspace switcher
a little applet that allows you to switch between the available virtual desktops.
See Also: virtual desktops.
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accessing, 41
Aumix, 100
DiskDrake, 135
DrakBackup, 166
Drakbug, 114
DrakPerm, 153
DrakSec, 151
HardDrake, 121
K3b, 103
kill misbehaving apps, 189
killing, 189
KMPlayer, 103
Konqueror, 86
KPrinter, 89
lpd, 133
Mandrakelinux Control Center, 145
Mandrakelinux Control Center, 173
Mandrakelinux Control Center, 113
MenuDrake, 157
Mozilla Navigator, 57
MPlayer, 102
MSEC, 151, 153
OpenOffice.org, 81, 82
PrinterDrake, 126
rawwrite, 8
Rpmdrake, 173
Totem, 103
troubleshooting tools, 190
UserDrake, 164
Xine, 102
XMMS, 95
XMovie, 103

background, 41
backup, 182

DrakBackup, 166
Master Boot Record, 186
restore, 171, 184
tar, 183, 184

bar
icons, 42
menu, 42
status, 42
task, 43
title, 42
tool, application, 42

BIOS, 7
Plug’n’Play, 7

bookmarks, 59
boot

different run level, 185
dual-boot, 5, 30
file-system, 185
services, 29
system hanging, 185

boot disk
creating, 7

boot loader
menu, 37

boot disk, 181
Master Boot Record, 186

boot loader
configuration, 118
dual-boot, 186
GRUB, 25
LILO, 25
reinstall, 186
uninstall, 31

boot up
configuration, 117

bugs
reports, 114

CD, 103, 138
cdrom.img, 7
clipboard, 87
commands

defrag, 5
DrakConf, 113
Kppp, 9
lilo, 31
minicom, 9
scandisk, 5
tar, 183
urpmi, 178

configuration, 26
console

switch to another, 188
country

configuration, 26
date

adjust, 162
defrag, 5
dependencies

automatic, 22
desktop, 41

environment, 51
virtual, 42

development, 2
devices

removable, 138
DHCP server, 148
DiskDrake

hda, 135
NFS, 141
removable devices, 138
Samba, 139

documentation, 2
Mandrakelinux, 2
manuals, 47
where to get, 47

drag’n’drop, 87
DrakBackup, 166
Drakbug, 114
DrakConf, 113
DrakPerm, 153
DrakSec, 151
DrakX, 11
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desktop, 51

fax, 93
file

deletion recovery, 187
permissions, 153
sharing, 141

file managers
Konqueror, 86

file system
repairing a damaged Super-Block, 187

firewall
basic configuration, 154
configuration, 27

floppy, 138
auto-install, 31
boot disk, 7
boot disk images, 7

fonts
management, 161

gateway
configuring, 148

GNU/Linux
floppy boot disk, 8

GPL, 191
graphical environment, 39
graphical environment, 38
graphical interface

configuration, 27
GRUB, 25

reinstall, 186
HardDrake, 121

other devices, 122
hardware

configuration, 121
supported, 9
troubleshooting, 122

hd_grub.img, 8
installation

automated, 31
class, 16
replay, 31
save package selection, 31
updates, 30

installation options
kernel, 12
noauto, 12
text, 12
vgalo, 12

internationalization, 2
Internet, 55

connection, 145
Konqueror, 88
Mozilla Navigator, 57
plugins, 60

IsaPnPTools, 122
ISDN card

configuration, 26
KDE, 39, 51

desktop, 41

keyboard, 17
changing layout, 125
configuration, 26

Konqueror, 86
file, copying, 87
file, deleting, 88
file, linking, 88
file, moving, 87
web, 88

language, 13
keyboard, 17, 125

laptops, 189
LDAP, 23
legal disclaimer, 9
license, 14
LILO, 25

reinstall, 186
Linux, 33
log files

searching through, 163
login, 37
login mode

autologin, 117
configuring, 117
graphical interface, 117

logout, 37, 44
KDE, 44

lpd, 133
man pages, 47
Mandrakeclub, 1, 40
Mandrakeexpert, 1
Mandrakefirsttime, 38, 39
Mandrakelinux, 49

documentation, 47
mailing lists, 1
uninstall, 31
upgrade, 16
upgrading, 176

Mandrakelinux Control Center, 113
Mandrakesecure, 1
Mandrakestore, 1
Master Boot Record, 31
MBR, 31
MenuDrake, 157

add entry, 158
advanced features, 160

modems
linmodems, 9
winmodem, 9

mount points, 18
mouse, 15

configuration, 26, 125
Wheel, ??

movie, 101, 103
Using MPlayer, 102
Using Xine, 102

MP3, 95
MSEC, 151, 153
multimedia, 95

movie, 101, 102, 102, 103
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multiuser system, 37
network

configuration, 27
proxy, 27

network.img, 7
network_drivers.img, 7
NFS

file sharing, 141
NIS, 23
nVidia 3D graphics cards

OpenGL, 189
office

OpenOffice.org, 81, 82
openGL

nVidia 3D Graphics CardsL, 189
operating system, 33
packages

development, 20
graphical environment, 20
individual selection, 21
installing, 20, 178
management, 173, 173, 178
server, 20
workstation, 20

packaging, 1
partition table, 135
partitions

bad blocks, 20
custom, 19
DrakX, 18
formatting, 19, 138
management, 135
NTFS, 5
pre-existing, 19

password
root, 23

pcmcia.img, 7
Peter Pingus, 4
Plug’n’Play

OS, 7
plugins, 61, 61, 61
PnP OS, 7
printer, 7, 89

add, 127
auto-configuration, 126
configuration, 26, 126
connection type, 133
default, 127, 131
edit, 127
Expert Mode, 127
local, 133
multi function, 94, 129
network, 133
options, 130
refresh, 127
remote lpd, 133
remote printers, 132
removal, 127
sharing, 127
SMB, 133

testing, 131
URI, 133

programming, 2
protocol

LDAP, 23
NIS, 23
PDC, 23

Queen Pingusa, 4
rescue mode, 181
resolution

changing display, 123
root, 37

password, 23
window, 41

Samba, 139
directories, importing, 139

scandisk, 5
security

basics, 40
choose, 151
configuration, 27
level, 17

services, 29
configuration, 27
startup, configuring, 160

session, 37
type, 38

shutdown, 40
sound card

configuration, 26
spreadsheet software

OpenOffice.org, 82
state

active, 42
inactive, 42

super-block
repairing damaged, 187

system request, 188
tabs, 60
time

adjust, 162
time zone

configuration, 26
time zone

settings, 162
troubleshooting, 181, 190

computer is slow, 190
file system, 187
hardware, 122
Mandrakelinux, 49

tv card
configuration, 26

uninstall, 31
updates, 30
upgrade

Mandrakelinux, 16
USB, 9
UserDrake, 164
users

adding, 24, 165
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generic, 4
management, 164
Peter Pingus, 165
Queen Pingusa, 165

WebDAV
mounting, 142

window
closing, 44
maximize, 43
minimize, 43
moving, 43
resize, 43

Windows, 33
file sharing, 139, 141
floppy boot disk, 8

wizard
Mandrakefirsttime, 38, 39

word processor
OpenOffice.org, 81

X, 185
configuration, 185

X graphical server
configuration, monitor, 123

X graphical server
on boot-up, 125

x server
kill, 188

X Window System , 28
XMMS, 95

equalizer, 96
playlist, 96
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